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Computer Fundamentals 
 

Part – 1 
 

 कम्प्यूटर 

A) आंकडो के भंडारण वाली एक सक्षम युक्ति ह।ै 
B) आंकडो के क्तवशे्लषण करने मे सक्षम ह।ै 
C) पूणण गोपनीयता बनाए रखने मे सक्षम ह।ै 
D) सभी 
 

 दशे का प्रथम कम्प्यूटर साक्षर क्तिला ह।ै 
A) अनाणकुलम                          B) क्तवल्लुपरुम 

C) थीरूवल्लूर                          D) मल्परुम (केरल) 
 

 भारत का पहला कम्प्यूटर कहा ंस्थाक्तपत ककया गया था। 
A) भारतीय प्रौधोक्तगकी संस्थान, कदल्ली 
B) भारतीय क्तवज्ञान संस्थान, बेंग्लुरू 

C) इंक्तडयन आयरन एंड स्टील कंपनी, बनणपरु 

D) भारतीय साकं्तययकी ससं्थान, कलकत्ता 
 

 कम्प्यूटर क्तनम्प नक्तलक्तखत मे से कौन सा कायण नही करता ह।ै 
A) इनपुटटंग      B) कंट्रोललगं     C) आउटपुटटंग   D) अडंर स्टैलडगं 
 

 वह इलैक्ट्ट्राक्तनक क्तडवाइस िो डाटा को स्वीकार कर सकता ह ैडाटा करता 
ह ैतथा आउटपुट उत्पन्न करता ह ैऔर पररणामो को भक्तवष्य मे प्रयोग के क्तलए 
स्टोर करता ह,ै कहलाता ह-ै 

A) इनपुट      B) कम्प्यटूर       C) साफ्टवेयर      D) हाडणवेयर 
 

 क्तनम्नक्तलक्तखत मे से कौन कम्प्यूटर के गुण ह।ै 
A) तीव्र गक्तत                     B) त्रुरट रक्तहत कायण 
C) गोपनीयता                   D) उपयुणि सभी 
 

 डाटा प्रोसेलसंग का अथण ह।ै 
A) डाटा संग्रहण                         B) डाटा को सिाना 
C) डाटा को उपयोगी बनाना      D) उपयुणि सभी 
 

 क्तिह्मत्मक डाटा मे प्रयोग ककया िाता ह।ै 
A) अंको का                             B) अंक्षरो का 
C) क्तिह्में का                            D) उपयुणि सभी 
 

 इनमे से कौन कम्प्यूटर का गुण नही ह।ै 
A) िल्द क्तनणणय लनेे की क्षमता    B) गोपनीयता 
C) बकु्तददहीन                                   D) क्तवक्तवधता 
 

 कम्प्यूटर साक्षरता कदवस मनाया िाता ह।ै 
A) 1 कदसम्पबर                            B) 2 कदसम्पबर 

C) 1 िनवरी                              D) 22 िनवरी 
 

 क्तवश्व मे सवाणक्तधक कम्प्यूटर वाला दशे ह।ै 
A) भारत                          B) रूस 

C) िापान                         D) सयंिु राज्य अमरेरका 
 

 कम्प्यूटर साक्षरता का अथण ह।ै 
A) कम्प्यूटर प्रोग्राम क्तलखना       B) कम्प्यूटर की त्रुरट सुधारना 
C) कम्प्यटूर के कायण सक्षता की िानकारी रखना 
D) कम्प्यूटर की कायण प्रणाली िानना 
 

 डाटा प्रोसेलसंग का अथण ह।ै 
A) डाटा का भण्डारण                               B) डाटा का संग्रहण 

C) उपयोग के क्तलए सिूना प्राप्त करना  D) सूिना का क्तवशे्लषण 
 

 बैककंग लने-दने मे ECS  का अथण ह।ै 
A) एक्ट्सेस कैश स्टेट्स             B) एक्ट्सिेंि  क्तक्ट्लयटरंग स्टैंडडण 
C) एक्ट्सेंस के्रक्तडट सुपरवाइिर  D) इलके्ट्ट्रॉक्तनक क्तक्ट्लयटरंग सर्वणस 
 

 कम्प्यूटर प्रोसेस द्वारा इन्फामशेन मे पररवर्तणत करता ह।ै 
A) नंबर को       B) डाटा को      C) इनपुट को     D) प्रोससेर को 
 

Part – 2 

 

1. क्तवश्व के प्रथम सपुर कम्प्यूटर का क्तनमाणण ककया 
A) आईबीएम        B) एससीएल      C) सीआरसी      D) सी-डकै 
 

2. क्तनम्नक्तलक्तखत मे से कौन सी भाभा परमाणु अनसुंधान केन्र द्वारा क्तवकक्तसत 
सुपर कम्प्यूटर ह।ै 
A) परम पदम         B) फ्लोसाल्वर       C) क्ति्स      D) अनपुम 
 

3. क्तडक्तिटल कम्प्यूटर क्तवकक्तसक ककया गया। 
A) रूस          B) क्तिटेन         C) यएूसए        D) िापान 

4. आईबीएम का पूरा नाम ह ै

A) इंक्तडयन क्तबिनसे मशीन          B) इंटरनशेनल क्तबिनसे मशीन 

C) इंटैक्तलयन क्तबिनेस मशीन       D) इन्टीग्रल क्तबिनसे मशीन 
 

5. कम्प्यूटर का िनक ककसे माना िाता ह।ै 
A) िाल्सण बबैिे             B) होलररप 

C) लेबक्तनि                   D) ब्लिे पास्कल 
 

6. भारत ने सुपर कम्प्यूटर परम का क्तनमाणण कहा ककया था? 

A) िेन्नई म े     B) बेग्लरुू म े      C) कदल्ली म े    D) पणु ेम े
 

7. कम्प्यूटर मे प्रयुि आईसी क्तिप बनी होती ह।ै 
A) क्तसक्तलकान         B) पणण        C) काा्रेक्तमयम         D) स्वणण 
 

8. संसार का पहला गणक यंत्र ह।ै 
A) अबकेस                      B) एक्तनयक 

C) माकण  I                       D) इनमे से कोई नही 
 

9. हाइक्तिड कम्प्यूटर मे प्रयोग होता ह।ै 
A) क्तडक्तिटल संकेतो का          B) एनालॉग सकेंतो का 
C) दोनो का                            D) ककसी का नही 
 

10. माइक्रो प्रोससेर का अक्तवष्कार ककया था। 
A) आईबीएम   B) ए्पल न े  C) इंटेल न े   D) एिसीएल न े
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11. आईबीएम ह ै

A) एक क्तिप                             B) एक कंपनी 
C) कम्प्यूटर का एक प्रकार     D) ममेोरी क्तडवाइस 
 

12. वतणमान पीढी के कम्प्यूटर म ेप्रयोग हाेते ह।ै 
A) SSIC       B) MSIC      C) VLSIC    D) ULSIC 
 

13. संसार का प्रथम प्रोग्रामर माना िाता ह।ै 
A) िाल्सण बैबिे                B) लडेी एडा आगस्टा 
C) ए्पल क                    D) आईबीएम कंपनी 
 

14. अगली पीढी के कम्पपयूटर मे प्रयोग ककया गया। 
A) AI               B) BI           C) CI              D) DI 
 

15. घरो और व्यक्तिगत उपयोग मे आने वाला P C वास्तव मे ह।ै 
A) माइक्रो कम्प्यटूर            B) क्तमनी कम्प्यूटर 

C) मनेफे्रम कम्प्यूटर           D) सुपर कम्प्यूटर 
 

Part – 3 

1. क्तद्वआधारी पददक्तत का प्रयोग करने वाले कम्प्यूटर को कहते ह।ै 
A) एनालॉग  कम्प्यूटर         B) क्तडक्तिटल कम्प्यटूर 

C) हाइक्तिड कम्प्यूटर           D) इनमे से कोई नही 
 

2. मक्तस्तष्क की कायणप्रणाली की नकल करने वाला सबसे छोटा और सबसे 
तीव्र गक्तत वाला कम्प्यूटर कौन सा हैं। 
A) सुपर कम्प्यूटर                   B) क्ाटंम कम्प्यटूर 

C) परम – 10000                    D) आईबीएम क्तिप 
 

3. कम्प्यूटर की पािंवी पीढी का प्रतीक ह।ै 
A) माइक्रो प्रोससेर          B) क्तमक्तन कम्प्यूटर 

C) माइक्रो कम्प्यूटर        D) सपुर कम्प्यटूर 
 

4. क्तवश्व का प्रथम इलेक्ट्ट्राक्तनक कम्प्यूटर ह।ै 
A) एक्तनएक       B) यूनीवैक     C) माकण -1      D) इनमे स ेकोई नही 
 

5. इंटीगे्रटेड सर्कण ट क्तिप के क्तवकास का श्रेय िाता ह।ै 
A) िाल्सण  बैबेि को           B) िे एस 

C) राबटण नोयी को               D) a व b दोनो को 
 

6. क्तनम्नक्तलक्तखत मे कौन भारत मे क्तवकक्तसत सपुर कम्प्यूटर नही ह-ै 

A) परम       B) अनपुम          C) पेस         D) क्तवप्रो 
 

7. भारत मे क्तसक्तलकन वलैी क्तस्थत ह।ै 
A) िेन्नई       B) कदल्ली        C) बैंगलौर      D) मुम्पबई 
 

8. सी-डकै का सबंंध ह ै

A) कम्प्यटूर        B) टीवी        C) टेलीमैरटक्ट्स       D) कोई नही 
 

9. आधुक्तनक कम्प्यूटरो का लघरुूपण सभंव हो सका ह,ै क्तनम्न के प्रयोग स-े 

A) ट्रांक्तिस्टर              B) समकक्तलत पररपथ क्तिप 

C) ननैो पदाथण           D) अक्तत सिंालक 
 

10. पहला कम्प्यूटर बनाया था। 
A) क्तबल गेट्स न े           B) क्तबल लक्ट्लंटन न े

C) िाल्सण बबैिे न े        D) माकोनी न े
 

11. आईसी क्तिपो का क्तनमाणण ककया िाता ह।ै 
A) फाइबर स े              B) समेी कण्डक्ट्टर स े

C) ्लाक्तस्टक स े          D) इनमे से कोई नही 
 

12. इलेक्ट्ट्राक्तनक कम्प्यूटर का अक्तवष्कार ककया था। 
A) माकोनी                   B) डॉ. अलान एम. टूटरंग 

C) िाल्सण बैबिे            D) इनम ेसे कोई नही 
 

13. भारत मे क्तवकक्तसत परम सुपर कम्प्यूटर का क्तवकास ककस संस्था ने ककया 
ह।ै 
A) सी डकै           B) आई आईटी कानपुर 

C) बाकण                D) आई आईटी कदल्ली 
 

14. भारत मे बना सपुर कम्प्यूटर फ्लोसाल्वर क्तवकक्तसत व क्तडिाइन ककया 
गया था। 
A) नाल, बेंगलरुू              B) सी-डकै, पुण े

C) बाकण , मुम्पबई               D) इनमे से कोई नही 
 

15. वाक्तणक्तज्यक उपयोग के क्तलए उपलब्ध कराया गया पहला कम्प्यूटर था। 
A) मक्तनआक     B) एक्तनक      C) यनूीवकै       D) इडवैक 
 

Part – 4 

 

1. भारतीय सुपर कम्प्यूटर का नाम ह-ै 

A) शुभम        B) परम        C) एस एक्ट्स-2       D) बीबीसी माइक्रो 
 

2. पहले इलैक्ट्ट्राक्तनक अंकीय कम्पपयूटर मे क्ट्या था। 
A) ट्रांक्तिस्टर        B) वाल्व    C) कोड स्मृक्तत    D) अधणिालक स्मकृ्तत 
 

3. क्तवशेष रूप से क्तडिाइन ककए गये कम्प्यूटर क्तिप, िो ककसी अन्य क्तडवाइस 
के अंदर रहते ह,ै कहलाते ह।ै 
A) सवणर                                            B) क्तिप 

C) रोबोट कम्प्यटूर                           D) एम्पबडेडे कम्प्यटूर 

 

4. क्तनम्नक्तलक्तखत मे कौन सबसे बडा, सबसे तिे और सबसे महगां कम्प्यूटर ह।ै 
A) पसणनल कम्प्यूटर                  B) सपुर कम्प्यटूर 

C) लैपटॉप                                  D) नोटबुक 
 

5. एक छोटे क्तसक्तलकॉन क्तिप पर ट्रांक्तिस्टर और अन्य इलेक्ट्ट्राक्तनक उपकरणो 
द्वारा बने पूणण इलेक्ट्ट्राक्तनक सर्कण ट को कहते ह।ै 
A) वकण  स्टेशन                           B) सीपीय ू

C) इंटेग्रटेेड  सर्कण ट                   D) इनमे से कोई नही 
 

6. कम्प्यूटर के कायण करने का क्तसददांत ह।ै 
A) इनपुट         B) आउटपुट        C) प्रोसेस       D) उपयुणि तीनो 
 

7. सेंट्रल प्रोसेलसंग यकू्तनट का मुयय घटक ह।ै 
A) कंट्रोल यूक्तनट               B) अररथमेरटक लॉक्तिक यूक्तनट 

C) प्राइमरी मेमोरी            D) उपयुणि सभी 
 

8. कम्प्यूटर का मक्तस्तष्क कहलाता ह।ै 
A) मेमोरी           B) हाडणक्तडस्क            C) सीपीय ू         D) मॉक्तनटर 
 

9 सीपीयू के कायण ह।ै 
A) इनपुट व आउटपुट क्तडवाइस को क्तनयंक्तत्रत करना 
B) डाटा को तात्काक्तलक रूप से स्टोर करना 
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C) क्तनदशेो को पढना और आदशे दनेा 
D) उपयुणि सभी 
 

10. क्तनम्नक्तलक्तखत मे से कौन सा उत्पात पेंरटयम िांड नाम से बिेा िाता ह।ै 
A) मोबाइल क्तिप                            B) कम्प्यूटर क्तिप 

C) कम्प्यूटर                                   D) माइक्रोप्रोससेर 
 

11. कम्प्यूटर के संदभण मे एएलय ूका तात्पयण ह।ै 
A) एलिेक्तिक लॉक्तिक यूक्तनट      B) अररथमटेटंक लॉक्तिक यकू्तनट 

C) एलिेक्तिक लोकल यूक्तनट        D) अररथमेटटंक लोकल यूक्तनट 
 

12. इनपुट का आउटपुट मे रूपातंरण ककया िाता ह।ै 
A) पेरीफेरल्स      B) मेमोरी       C) स्टोरेि        D) सीपीय ू
 

13. कम्प्यूटर मे िाने वाले डाटा को कहते ह।ै 
A) आउटपुट    B) इनपटु     C) एल्गोररथम     D) कैलक्ट्यलूेशन 
 

14. CPU का कौन सा भाग आकलन करता ह ैव क्तनणणय लतेा ह।ै 
A) अररथमेटटंक लॉक्तिक यूक्तनट     B) अल्टरनटेटंग लॉक्तिक यकू्तनट 

C) अल्टरनेट लोकल यूक्तनट           D) अमेररकन लॉक्तिक यूक्तनट 
 

15. एक इलेक्ट्ट्राक्तनक क्तडवाइस िो डटेा को इन्फामशेन मे बदलते हुए प्रोसेस 
करता ह ैकहलाता ह।ै 
A) प्रोससेर       B) कम्प्यूटर       C) केस       D) सीपीय ू

 

Part – 5 

1. कम्प्यूटर का सबसे महत्वपूणण भाग ह।ै 
A) सीपीय ू              B) की-बोडण             C) क्तडस्क          D) लप्रंटर 
 

2. सीपीयू का परूा रूप ह।ै 
A) सेंट्रल ्लसे यूक्तनट                   B) सेंट्रल प्रोक्तवनस यूक्तनट 

C) सेंट्रल प्रोसलेसगं यकू्तनट             D) सेंट्रल पुक्तलस यूक्तनट 
 

3. कमांड्स को ले िाने की प्रकक्रया ह।ै 
A) फेलिगं     B) स्टोटरंग     C) क्तडकोलडगं    D) एक्ट्िीक्ट्यूटटंग 
 

4. सीपीयू का वह भाग िो कम्प्यटूर के अन्य सभी उपकरणो की गक्ततक्तवक्तधयो 
का क्तनयंक्तत्रत करता ह,ै कहलाता ह।ै 
A) मदरबोडण                    B) कोआर्डणनेशन बोडण 
C) कंट्रोल यकू्तनट            D) अररथमैरटक लॉक्तिक  यूक्तनट 
 

5. कम्प्यूटर द्वारा कदया गया पररणाम ह।ै 
A) डाटा      B) ममेोरी ककल्वी को      C) आउटपटु    D) इनपुट 
 

6. सीपीयू का प्रमुख कायण ह।ै 
A) प्रोग्राम अनदुशेो पर अमल करना 
B) डाटा/िानकारी भावी प्रयोग हतेु स्टोर करना 
C) डाटा और िानकारी प्रोससे करना        D) दोनो b और c 
 

7. कम्प्यूटर मे सभी तार्कण क तथा अंकगक्तणतीय पररकलन ककए िाते ह।ै 
A) प्रणाली बोडण द्वारा           B) कें रीय क्तनयंत्रक यूक्तनट द्वारा 
C) सेंट्रल प्रोसलेसगं यकू्तनट द्वारा     D)  मदरबोडण द्वारा 
 

8. बुक्तनयादी कम्प्यूटर प्रोसेलसंग िक्र मे शाक्तमल ह।ै 
A) इनपटु, प्रोसलेसगं और आउटपटु    B) क्तसस्टम और ए्लीकेशन 

C) डाटा, सूिना और एक्त्लकेशन       D) इनमे से कोई नही 
 

9. मदरबोडण पर सीपीयू तथा मदरबोडण पर लगे दसूरे पिुो को िोडता ह।ै 
A) इनपुट यूक्तनट   B) क्तसस्टम बस   C)  ए एल य ू D) कोई नही 
 

10. मदरबोडण ह ै– 

A)  कम्प्यूटर के ऑन  करने पर एक्ट्सेस ककया िाने वाला पहला क्तिप को 
कहते ह ै। 
B)  सर्कण ट बोडण क्तिसमे पेररफेरल क्तडवाइस होती ह।ै 
C) वही िो सीपीयू क्तिप ह।ै 
D) सर्कण ट बोडण क्तिसम ेसीपीय ूऔर अन्य क्तिप लग ेहोत ेह।ै 
 

11. कम्प्यूटर क्तसस्टम की घडी ह ै– 

A) एक साफ्टवेयर िो टास्क बार पर समय कदखाती ह ैऔर पररवर्तणत नही 
की िा सकती ह।ै 
B) एक टाइक्तमग क्तडवाइस िो कम्प्यूटर मे सभी इन्सट्रक्ट्शन इनपुट को प्रोससे 
करती ह।ै 
C) एक टाइक्तमग क्तडवाइस िो कम्प्यटूर के आपरेशन को लसकं्रोनाइि करन ेके 
क्तलए इलके्तक्ट्ट्रकल पल्स पदैा करती ह।ै 
D)  एक क्तडवाइस िो कम्प्यूटर क्तसस्टम मे सबसे नई और आधुक्तनक ह ै
 

12. कम्प्यूटर घडी के स्पीड की गणना की िाती ह।ै 
A) गीगा बाइट म े         B) क्तबट म े

C)  मगेा हटणि म े         D)  सेकेण्ड म े
 

13. पसणनल कम्प्यूटर के मदरबोडण पर क्तवक्तभन्न घटक इलेक्तक्ट्ट्रकल कंडलक्ट्टंग 
लाइनो के सेट से आपस मे िुड ेरहते ह,ै इन लाइनो को कहते ह।ै 
A) कंडक्ट्टसण       B) बसेस      C) कनके्ट्टसण    D) इनमे से कोई नही 
 

14. BIOS  का परूा रूप ह।ै 
A) बेक्तसक  इंट्रा आपरेटटंग क्तसस्टम 

B) बेक्तसक  इंटरनल आगणन क्तसस्टम 

C) बके्तसक इनपटु आउटपटु क्तसस्टम 

D) इनमे से कोई नही 
 

15. मदरबोडण के कम्पपोनेन्ट्स के बीि सिूना के मादयम से टे्रवेल करता ह।ै 
A) फ्लैश मेमोरी         B) सी मॉस       C) विे      D) बसिे 

 

Part – 6 

1. कम्प्यूटर का मुयय पटल कहलाता ह।ै 
A) फादर बोडण     B) मदर बोडण     C) की-बोडण    D) इनमे से कोई नही 
 

2. यूपीएस का कायण ह।ै 
A) कम्प्यूटर की बैटरी को िािण करना 
B) कम्प्यूटर को असुरक्षा से बिाना 
C) कम्प्यटूर को क्तनबाणध क्तवद्यतु आपरू्तण सकु्तनक्तित करना 
D) इनमे से कोई नही 
 

3. पसणनल कम्प्यूटर के क्तवकास का श्रेय िाता ह।ै 
A) IBM को    B) HCL को   C) DEC को    D) HP को 
 

4. क्तसस्टम यूक्तनट मे रीसेट बटन का प्रयोग ककया िाता ह।ै 
A) कम्प्यूटर को बंद करने के क्तलए 
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B) कम्प्यूटर को िालू करने के क्तलए 

C) कम्प्यटूर की स्लाई को बदं ककय ेक्तबना पनुः िाल ूकरन ेके क्तलए 

D) इनमे से कोई नही 

 

5. पेन ड्राइव को कम्प्यूटर से िोडने के क्तलए प्रयोग होता ह।ै 
A) यूएसबी पोटण                                B) पैरेलल पोटण 
C) क्तसरीयल पोटण                               D) नेटवकण  पोटण 
 

6. लप्रंटर को क्तसस्टम यूक्तनट के साथ िोडने के क्तलए प्रयोग ककया िाता ह।ै 
A) यूएसबी पोटण                                B) परेैलल पोटण 
C) क्तसरीयल पोटण                               D) नेटवकण  पोटण 
 

7. कम्प्यूटर के यूएसबी पोटण से ककसे नही िोडा िा सकता ह।ै 
A) माउस           B) लप्रंटर          C) पने ड्राइव        D) हाडणक्तडस्क 
 

8. कम्प्यूटर मे पावर स्लाई क्तसस्टम मे प्रयुि एसएमपीएस का अथण ह।ै 
A) क्तस्वि मोड पॉवर स्लाई       B) सर्वणस मोड पॉवर स्लाई 

C) श्योर मोड पॉवर स्लाई         D) क्तसक्ट्योर माडयलू पॉवर स्लाई 
 

9. कम्प्यूटर के प्रोससेर की गक्तत को क्तनम्नक्तलक्तखत मे से ककसमे मापा िाता ह।ै 
A) बीपी               B) एमआई             C) बॉड         D) हटणि 
 

10. ककसी क्तवशेष प्रकार के संगीत उपकरणो को साउंड काडण से कौन सा पोटण 
िोडता ह।ै 
A) बस           B) सीपीय ू           C) यूएसबी            D) मीडी 
 

11. कम्प्यूटर प्रणाली के क्तलए क्तवस्तार क्षमता प्रदान करते ह।ै 
A) साकेट्स                            B) स्लॉट्स  

C) बाइट                                D) इनमे से कोई नही 
 

12. एक बॉक्ट्स क्तिसमे कम्प्यूटर क्तसस्टम के सवाणक्तधक महत्वपूणण भाग होते ह,ै 

कहलाता ह।ै 
A) सॉफ्टवेयर                               B) हाडणवेयर   

C) इनपुट क्तडवाइस                       D) क्तसस्टम यकू्तनट 
 

13. सवाणक्तधक उत्पाद कूट का अगंीकरण ककसके क्तलए ककया गया ह।ै 
A) भवनो म ेअक्ति सरुक्षा  
B) भूकम्पप प्रक्ततरोधी भवनो के क्तलए कूट 

C) बारकूट  

D) खाद्य पदाथो मे क्तमलावट की रोकथाम के क्तलए 
 

 

14. क्तनम्नक्तलक्तखत मे से ककसने लिेर का अक्तवष्कार ककया। 
A) क्तथयोडर ममेनै                                       B) डके्तनस पेलपनं 

C) थ्वक्तलयम कोटणन                                    D) फ्रांक्तसस कक्रक 
 

15. दवक्तन के पुनरूस्थान के क्तलए एक सीडी आक्तडयो ्लयेर मे प्रयिु होता ह।ै 
A) क्ारटस कक्रस्टल             B) टाइरेक्तनयम क्तनडाल 

C) लिेर बीम                        D) वेररयम टाइटेक्तनक क्तसरेक्तमक 
 

 

 

 

Part – 7 

1. डीटीपी दशाणता ह।ै 
A) डॉट पर इंि 

B) क्तडक्तिट पर इंि 

C) डॉट्स क्तपक्ट्सल इंक 

D) डायगाा्रम पर इंि 

Answer- (a) डॉट पर इंि 

2. कम्प्यूटर स्क्रीन पर लब्लकं करने वाले प्रतीक को कहते ह।ै 
A) माउस 

B) हाडणड्राइव 

C) ्वांइटर 

D) कसणर 

Answer- (d) कसणर 

3. डसे्कटॉप छपाई मे आमतौर पर ककस लप्रंटर का प्रयोग ककया िाता ह।ै 
A) डिेी ब्हील लप्रटंर 

B) डाट मैरट्रक्ट्स लप्रंटर 

C) लिेर लप्रंटर 

D) इनमे से कोई नही 
Answer- (c) लिेर लप्रंटर 

4. इनमे से कौन सा इनपुट क्तडवाइस नही ह।ै 
A) की-बोडण 
B) माउस 

C) बार कोड 

D) काडण रीडर 

Answer- (d) काडण रीडर 

5. VGA का फुल फामण क्ट् या ह-ै 

A) Video Graphics Array 

B) Visual Graphics Array 

C) Volatile Graphics Array 

D) Video Graphics Adapter 

Answer- (a) Video Graphics Array 

6. टैब बटन का प्रयोग ककया िाता ह।ै 
A) कसणर को एक क्तनक्तित दरूी तक लाने के क्तलए 

B) टेबल या एक्ट्सेल मे एक खाने से दसूरे खाने मे िाने के क्तलए 

C) डायलॉग बॉक्ट्स  मे क्तवकल्पो के ियन म े

D) उपरोक्ट् त सभी 
Answer- (d) उपरोक्ट् त सभी 
7. कंट्रोल आल्ट और डले (Ctrl+Alt+Del) बटन का एक साथ प्रयोग ककया 
िाता ह।ै 
A) कम्प्यूटर को रीसेट करने के क्तलए 

B) कम्प्यूटर की सिूना को समाप्त करने के क्तलए 

C) स्क्रीन की सिूना को नष्ट करन ेके क्तलए 

D) कोई नही 
Answer- (a) कम्प्यूटर को रीसटे करने के क्तलए 

8. इनमे से कौन एक ्वांइंटटंग क्तडवाइस नही ह।ै 
A) माउस 

B) ज्वाक्तस्टक 

C) प्रकासीय पेन 

D) स्कैनर 

Answer- (d) स्कैनर 

9. बैंको मे िेक व ड्राफ्ट मे इसका प्रयोग ककया िा रहा ह।ै 
A) बार कोड 

B) एम आई सी आर 
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C) ओएमआर 

D) यूपीसी 
Answer- (b) एम आई सी आर 

10. वस्तुक्तनष्ठ उत्तर पुक्तस्तकाओ को िािने के क्तलए प्रयोग ककया िाता ह।ै 
A) ओएमआर 

B) बार कोड 

C) माइकर 

D) प्रकाशीय पने 

Answer- (a) ओएमआर 

11. क्तडिीटल कैमरा मे प्रयोग होता ह।ै 
A) एल ई डी 
B) फोटो डायोड 

C) प्रकाशीय कफल्म 

D) प्रकाशीय पने 

Answer- (b) फोटो डायोड 

12. मॉक्तनटर की गुणवत्ता की पहिान की िाती ह।ै 
A) डॉट क्तपि स े

B) ररिोल्यूशन स े

C) ररफे्रश रेट स े

D) उपयुणि सभी 
Answer- (d) उपयुणि सभी 
13. इंक िेट लप्रंटर के रंगीन स्याही के बॉटल मे मूल रंगो की सयंया होती ह।ै 
A) 2 

B) 3 

C) 4 

D) रंगो की प्रकृक्तत पर क्तनभणर 

Answer- (b) 3 

14. लेिर लप्रंटर मे प्रयोग होता ह।ै 
A) लेिर बीम 

B) प्रकाशीय ड्रम 

C) आवेक्तशत स्याही टोनर 

D) उपयुणि सभी 
Answer- (d) उपयुणि सभी 
15. क्तनम्न मे से कौन सी एक यतं्र सामाग्री नही ह।ै 
A) लप्रंटर 

B) की-बोडण 
C) माउस 

D) प्रिालन यंत्र 

Answer- (d) प्रिालन यतं्र 

 Part – 8 

rt 

1. दो प्रिक्तलत आउटपुट क्तडवाइस ह।ै 
A) मॉक्तनटर व लप्रंटर 

B) की-बोडण व माउस 

C) सीडी व फ्लापी 
D) स्कैनर व लप्रंटर 

Answer- (a) मॉक्तनटर व लप्रंटर 

2. आब्िेक्ट्ट की प्रोपटीि मे िाने के क्तलए प्रयुि माउस टेकिक ह।ै 
A) ड्रलैगंग 

B) ड्रालपंग 

C) राइट क्तक्ट्लक 

D) लेफ्ट क्तक्ट्लक 

Answer- (c) राइट क्तक्ट्लक 

3. कम्प्यूटर की समस्त सिूनाए या आउटपुट दखेने के क्तलए ककस क्तडवाइस 
का प्रयोग ककया िाता ह।ै 
A) मॉक्तनटर 

B) की-बोडण 
C) एएलय ू

D) सीपीय ू

Answer- (a) मॉक्तनटर 

4. क्तनम्नक्तलक्तखत मे से कौन सा आउटपुट का एक मादयम ह।ै 
A) स्कैनर 

B) की-बोडण 
C) लप्रंटर 

D) एएलय ू

Answer- (c) लप्रंटर 

5. कम्प्यूटर क्तसस्टम मे टेक्ट्स्ट और न्यूमेररकल डाटा प्रवेश कराने की सवाणक्तधक 
सामान्य पददक्तत ह।ै 
A) की-बोडण 
B) लप्रंटर 

C) स्कैनर 

D) ्लॉटर 

Answer- (a) की-बोडण 
6. आउटपुट क्तडवाइसिे सभंव बनाते ह।ै 
A) डाटा दखेना या लप्रटं करना 
B) डाटा स्कैन करना 
C) डाटा इनपुट करना 
D) डाटा भेिना 
Answer- (a) डाटा दखेना या लप्रंट करना 
7. डाक्ट्यूमेंट की हाडण कॉपी तयैार की िाती ह।ै 
A) लप्रंटर द्वारा 
B) फ्लॉपी द्वारा 
C) हाडण क्तडस्क द्वारा 
D) सीडी द्वारा 
Answer- (a) लप्रंटर द्वारा 
8. क्तनम्नक्तलक्तखत मे से ककस समूह मे केवल इनपुट क्तडवाइस ह।ै 
A) माउस, की-बोडण, मॉक्तनटर 

B) माउस, की-बोडण, लप्रंटर 

C) माउस, लप्रंटर, मॉक्तनटर 

D) माउस, की-बोडण, स्कैनर 

Answer- (d) माउस, की-बोडण, स्कैनर 

9. स्कैनर स्कैन करता ह।ै 
A) क्तपक्ट्िर 

B) टेक्ट्स्ट 

C) क्तपक्ट्िर व टेक्ट्स्ट दोनो 
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D) इनमे से कोई नही 
Answer- (c) क्तपक्ट्िर व टेक्ट्स्ट दोनो 
10. कम्प्यूटर पर गेम खेलना आसान बनाता ह।ै 
A) माउस 

B) ज्वाक्तस्टक 

C) की-बोडण 
D) पेन ड्राइव 

Answer- (b) ज्वाक्तस्टक 

11. सॉफ्ट कॉपी एक आउटपुट ह ैतो हाडण कॉपी ह।ै 
A) भौक्ततक पिुाण 
B) लप्रंटेड पुिाण 
C) क्तप्रन्टेड आउटपुट 

D) आउटपुट क्तडवाइस 

Answer- (c) क्तप्रन्टेड आउटपुट 

12. Ctrl, Shift तथा Alt को कहते ह।ै 
A) मोक्तडफायर की 
B) फंक्ट्शन की 
C) अल्फान्यमूेररक की 
D) इनमे से कोई नही 
Answer- (a) मोक्तडफायर की 
13. ककसी उत्पाद पर लप्रंटेड लाइनो के पैटनण को कहते ह।ै 
A) ओएमआर 

B) बार कोड्स 

C) ओसीआर 

D) स्कैनर 

Answer- (b) बार कोड्स 

14. ककसी क्तवक्तशष्ट कायण को करन ेके क्तलए कौन सा बटन ककसी दसूरे बटन के 
साथ काक्तम्पबनेशन मे प्रयोग ककया िाता ह।ै 
A) फंक्ट्शन 

B) कंट्रोल 

C) स्पेस बार 

D) एरो 
Answer- (b) कंट्रोल 

15. इनमे से कौन उद्योग िुंबकीय स्याही गुण पहिान का प्राथक्तमक 
उपयोगकताण ह।ै 
A) बैंक 

B) फुटक्तवयर क्तडिाइन 

C) ककताब छपाई 

D) इनमे से कोई नही 
Answer- (a) बैंक 

Part – 9 

1. आिकल सबसे अक्तधक प्रयुि होने वाली इनपुट क्तडवाइस ह।ै 
A) मदरबोडण 
B) सेंट्रल प्रोसेलसंग यूक्तनट 

C) की-बोडण 
D) सेमीकंडक्ट्टर 

Answer- (c) की-बोडण 

2. क्तनम्नक्तलक्तखत मे से कौन सा लिेर लप्रंटर मे प्रयुि होता ह।ै 
A) डाई लेिर 

B) सेमी कण्डक्ट्टर लिेर 

C) एक्ट्साइयर लिेर 

D) गैस लेिर 

Answer- (b) सेमी कण्डक्ट्टर लिेर 

3. क्तनम्नक्तलक्तखत मे से कौन सबसे अक्तधक प्रयोग होने वाली इनपुट क्तडवाइस ह।ै 
A) टै्रक बाल 

B) स्कैनर 

C) माउस 

D) इनमे से कोई नह 

Answer- (c) माउस 

4. क्तनम्नक्तलक्तखत मे से कौन सा आउटपुट युक्ति नही ह।ै 
A) ड्रमे पने ्लॉटर 

B) सीआरटी मॉक्तनटर 

C) इयर फोन्स 

D) क्तडिीटल कैमरा 
Answer- (d) क्तडिीटल कैमरा 
5. एक इन्टेक्तलिेन्ट टर्मणनल की क्ट्या क्तवशेषता होती ह।ै 
A) इसमे माइक्रोप्रोसेसर होता ह ैककंतु यूिर द्वारा इसका प्रोग्राम नही ककया 
िा सकता। 
B) यह एक बड ेसीपीयू का प्रयोग करके छोटे डाटा प्रोसेलसंग कायण को 
प्रोसेसर कर सकता ह।ै 
C) यूिर को अगं्रेिी मे िानकारी दतेा ह।ै 
D) यूिर से डाटा प्राप्त नही कर सकता । 
Answer- (a) इसमे माइक्रोप्रोससेर होता ह ैककंतु यिूर द्वारा इसका प्रोग्राम 
नही ककया िा सकता। 
6. एक समानान्तर पोटण अक्तधकतर ककसमे इस्तेमाल होता ह।ै 
A) मुरक या लप्रंटर 

B) मॉक्तनटर 

C) माउस 

D) भंडारण शक्ति 

Answer- (a) मुरक या लप्रंटर 

7. स्क्रीन पर क्तडस््ले ककए गए क्तपक्ट्सल्स की सयंया को कहते ह।ै 
A) ररिोल्यशून 

B) कलर डे् थ 

C) ररफे्रश रेट 

D) मॉक्तनटर 

Answer- (a) ररिोल्यूशन 

8. एक प्रकार के कैमरे िो कम्प्यटूर के साथ लगे रहते ह,ै क्तिनका उपयोग 
वीक्तडयो कान्फरेंलसंग, वीक्तडयो िैटटंग और लाइव बेव िाडकास्ड के क्तलए होता 
ह,ै कहलाते ह।ै 
A) वेब कैम्पस 

B) वेब क्तपक्ट्स 

C) िाउिर कैम्पस 

D) िाउिर क्तपक्ट्स 

Answer- (a) वेब कैम्पस 
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9. OCR का पूरा रूप ह।ै 
A) Optical Character Recognition 

B) Optical CPU Recognition 

C) Optimal Character Recognition 

D) इनमे से कोई नही 
Answer- (a) Optical Character Recognition 

10. ग्राकफकल यिूर इंटरफेस मे स्टैंडडण ्वांइंरटग क्तडवाइस के रूप मे प्रयोग मे 
लायी िाती ह।ै 
A) की-बोडण 
B) माउस 

C) ज्वाक्तस्टक 

D) टै्रकबाल 

Answer- (b) माउस 

11. कसणर की मौिूदा क्तस्थक्तत के बायीं ओर के एक कैरेक्ट्टर को क्तडलीट करने 
के क्तलए ककस बटन का प्रयोग ककया िाता ह।ै 
A) बैकस्पसे 

B) क्तडलीट 

C) इन्सटण 
D) इस्केप 

Answer- (a) बैकस्पेस 

12. की-बोडण पर क्तस्थत ककन कुलिंयो से नंबर िल्दी टाइप ककए िा सकते ह।ै 
A) कंट्रोल, क्तशफ्ट व अल्ट 

B) फंक्ट्शन 

C) न्यूमररक की पैड 

D) टि पैड 

Answer- (c) फंक्ट्शन 

13. कम्प्यूटर मॉक्तनटर के क्तडस््ले का आकार मापा िाता ह।ै 
A) क्तिग िैग 

B) होररिेन्टली 
C) वर्टणकली 
D) डायगोनली 
Answer- (d) डायगोनली 
14. ……………. का प्रयोग हाथ से क्तलखे या मुकरत टेक्ट्स्ट तथा ग्राकफकल 
इमिे को क्तडक्तिटल रूप मे बदलन ेके क्तलए ककया िाता ह ैताकक इस ेमेमोरी मे 
स्टोर ककया िा सके। 
A) लप्रंटर 

B) लेिर बीम 

C) स्कैनर 

D) टिपैड 

Answer- (c) स्कैनर 

15. …………. वॉयस डाटा को शब्दो मे बदलकर उसे क्तडक्तिटल टेक्ट्स्ट मे 
रूपातंररत करता ह ैताकक उसे कम्प्यूटर समझ सके। 
A) स्पीि इनपुट हाडणवयेर 

B) टोककन सॉफ्टवेयर 

C) वडण ररकोक्तगनीशन सॉफ्टवेयर 

D) स्पीि ररकोक्तगनीशन सॉफ्टवेयर 

Answer- (d) स्पीि ररकोक्तगनीशन सॉफ्टवेयर 

Part – 10 

 

1. क्तनम्नक्तलक्तखत मे से कौन सा आउटपुट और इनपुट क्तडवाइस दोनो ही ह।ै 
A) स्पीकर 

B) माडमे 

C) लप्रंटर 

D) मॉक्तनटर 

Answer- (c) माडमे 

2. पहला कम्प्यूटर माउस ककसन ेबनाया था। 
A) डगलस एन्िलबटण 
B) क्तवक्तलयम इंक्तग्लश 

C) ओएक्तनयल कपूर 

D) राबटण िवाकी 
Answer- (a) डगलस एन्िलबटण 
3. इनमे से कौन सा ् वाइंंरटगऔर ड्रा क्तडवाइस ह।ै 
A) माउस 

B) स्कैनर 

C) लप्रंटर 

D) की-बोडण 
Answer- (a) माउस 

4. क्तनम्नक्तलक्तखत मे से ककस समूह मे केवल आउटपुट क्तडवाइस ह।ै 
A) स्कैनर, लप्रंटर, मॉक्तनटर 

B) की-बोडण, लप्रंटर, मॉक्तनटर 

C) माउस, लप्रंटर, मॉक्तनटर 

D) ्लाटर, लप्रंटर, मॉक्तनटर 

Answer- (d) ्लाटर, लप्रंटर, मॉक्तनटर 

5. उस कुिीं को क्ट्या कहते ह ैिो कम्प्यटूर की मेमोरी से सिूना और स्क्रीन 
कैरेक्ट्टर को क्तमटा या इरेि कर दतेी ह।ै 
A) एक्तडट 

B) क्तडलीट 

C) आउट 

D) ट्रस्ट 

Answer- (b) क्तडलीट 

6. टै्रक बाल उदाहरण ह।ै 
A) प्रोग्रालमगं क्तडवाइस 

B) ्वांइटटंग क्तडवाइस 

C) आउटपुट क्तडवाइस 

D) साफ्टवेयर क्तडवाइस 

Answer- (b) ्वांइटटंग क्तडवाइस 

7. माउस के दाएं बटन पर क्तक्ट्लक करने से कदखाई दतेा ह।ै 
A) वही िो बायां बटन क्तक्ट्लक करने से होता ह।ै 
B) एक क्तवशेष मेन्य ू

C) कुछ नही होता 
D) कम्प्यूटर स्लीप मोड मे िला िाता ह ै

Answer- (b) एक क्तवशेष मेन्य ू

8. माउस के दो मानक बटनो के बीि क्तस्थत व्हील का प्रयोग ककया िाता ह।ै 
A) वेब पिे पर क्तक्ट्लक करने के क्तलए 

B) शट डाउन के क्तलए 

C) सेलेक्ट्ट आइटम को क्तक्ट्लक करने के क्तलए 
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D) इनमे से कोई नह 

Answer- (d) इनमे से कोई नही 
9. सामान्यतः पेररफेरल इकक्मेंट शब्द का प्रयोग ककया िाता ह।ै 
A) कम्प्यूटर क्तसस्टम के साथ िोड ेगए ककसी क्तडवाइस के क्तलए 

B) बड ेपैमाने के कम्प्यूटर क्तसस्टम के क्तलए 

C) प्रोग्राम कलके्ट्शन के क्तलए 

D) इनमे से कोई नही 
Answer- (a) कम्प्यूटर क्तसस्टम के साथ िोड ेगए ककसी क्तडवाइस के क्तलए 

10. डबं टर्मणनल ह।ै 
A) माइक्रो कम्प्यूटर 

B) नग्ण्य इंटेक्तलिेंस वाला टर्मणनल 

C) सेंट्रल कम्प्यूटर 

D) इनमे से कोई नही 
Answer- (b) नग्ण्य इंटेक्तलिेंस वाला टर्मणनल 

11. सीडी रॉम का पूणण रूप ह ै

A) कोर क्तडस्क रीड ओनली मेमोरी 
B) काम्पपके्ट्ट क्तडस्क रीड ओनली मेमोरी 
C) सकुणलर क्तडस्क रीड ओनली ममेोरी 
D) इनमे से कोई नही 
Answer- (b) काम्पपेक्ट्ट क्तडस्क रीड ओनली मेमोरी 
12. कम्प्यूटर मे स्मृक्तत का प्रकार नही ह।ै 
A) सेमी कण्डक्ट्टर 

B) मैिेरटक 

C) सवणर 

D) ऑक्त्टकल 

Answer- (c) सवणर 

13. ऐसे एक्त्लकेशन के क्तलए मेिेरटक टेप पैा्रक्तक्ट्टकल नही ह ैक्तिनमे डाटा 
शीघ्र ररकाल ककया िाना ह ैक्ट्योकक टेप ह।ै 
A) रैण्डम एक्ट्ससे मीक्तडयम 

B) क्तसक्ें क्तशयल एक्ट्सेस मीक्तडयम 

C) रीड ओनली मीक्तडयम 

D) आसानी से डमेिे 

Answer- (b) क्तसक्ें क्तशयल एक्ट्ससे मीक्तडयम 

14. िब आप पीसी पर ककसी डाक्ट्यूमेंट पर कायण करते ह ैतो डाक्ट्यूमेंट 
अस्थायी रूप से कहां स्टोर ककया िाता ह।ै 
A) रैम 

B) रॉम 

C) सी डी रॉम 

D) इनमे से कोई नही 
Answer- (a) रैम 

15. कम्प्यूटर मे रैम का तात्पयण क्ट्या ह।ै 
A) रीसेन्ट एण्ड एक्तन्सयेंट मेमोरी 
B) रैण्डम एक्ट्सेस मेमोरी 
C) रीड एण्ड मेमोराइि 

D) ररकाल ऑल ममेोरी 
Answer- (b) रैण्डम एक्ट्सेस ममेोरी 

Part – 11 

1. कम्प्यूटर हाडणवयेर िो आकंडो के बहुत अक्तधक मात्रा का भण्डारण कर 
सकता ह,ै कहलाता ह।ै 
A) िुम्पबकीय टेप 

B) क्तडस्क 

C) दोनो 
D) इनमे से कोई नही 
Answer- (c) a और  b दोनो 
2. कम्प्यूटर हाडणवयेर िो क्तसक्तलकन का बना होता ह,ै आंकडो को बहुत 
अक्तधक मात्रा मे भण्डारण मे रख सकता ह,ै कहलाता ह।ै 
A) क्तडस्क 

B) क्तिप 

C) मैिेरटक टेप 

D) फाइल्स 

Answer- (b) क्तिप 

3. पेन ड्राइव ह।ै 
A) इलेक्ट्ट्राक्तनक ममेोरी 
B) कम्प्यूटर मे क्तलखने की युक्ति 

C) क्तित्र बनाने की यकु्ति 

D) इनमे से कोई नही 
Answer- (a) इलेक्ट्ट्राक्तनक ममेोरी 
4. कैश ममेोरी का प्रयोग ककया िाता ह।ै 
A) स्थायी भंडारण के क्तलए 

B) मेमोरी व प्रोससेर के बीि गक्तत अवरोध को दरू करने के क्तलए 

C) महत्वपूणण डाटा के क्तलए 

D) इनमे से कोई नही 
Answer- (b) ममेोरी व प्रोसेसर के बीि गक्तत अवरोध को दरू करने के क्तलए 

5. कम्प्यूटर मे एक अनपु्रयोग से दसूरे अनपु्रयेाग मे सामाग्री का अतंरण 
कहलाता ह।ै 
A) डायनेक्तमक डाटा एक्ट्सिेंि 

B) डायनेक्तमक क्तडस्क एक्ट्सिेंि 

C) डािी डाटा एक्ट्सिेंि 

D) डागमैरटक डाटा एक्ट्सिेंि 

Answer- (a) डायनेक्तमक डाटा एक्ट्सिेंि 

6. पेन ड्राइव ह।ै 
A) एक क्तस्थर क्तद्वतीय भंडारक इकाई 

B) एक िमु्पबकीय क्तद्वतीय भंडारक इकाई 

C) एक हटाई िाने वाली क्तद्वतीय भंडारक इकाई 

D) इनमे से कोई नही 
Answer- (c) एक हटाई िाने वाली क्तद्वतीय भंडारक इकाई 

7. रक्तिस्टर उच्च गक्तत स्मृक्तत तत्व ह,ै िो क्तस्थत होते ह।ै 
A) स्मृक्तत म े

B) सीपीयू म े

C) इनपुट-आउटपुट यूक्तनट म े

D) रॉम या ईपीरॉम म े

Answer- (d) रॉम या ईपीरॉम म े

8. ररयिूेबल ऑक्त्टकल स्टोरेि का एकाा्रेक्तनम ह।ै 
A) CD 

B) CD-RW 
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C) DVD 

D) ROM 

Answer- (b) CD-RW 

9. कम्प्यूटर का इनक्तबल्ट मेमोरी ह।ै 
A) ROM 

B) PROM 

C) EPROM 

D) RAM 

Answer- (a) ROM 

10. CD पर आप कर सकते ह।ै 
A) पढना 
B) क्तलखना 
C) पढना और क्तलखना 
D) इनमे से कोई नह 

Answer- (c) पढना और क्तलखना 
11. फाइल को सेव कर कम्प्यूटर बंद कर दनेे पर डाटा यथावत रहता ह।ै 
A) रैम म े

B) सेकेण्डरी स्टोरेि म े

C) मदरबोडण म े

D) प्राइमरी स्टोरेि म े

Answer- (b) सेकेण्डरी स्टोरेि म े

12. क्तनम्नक्तलक्तखत मे से कौन सी मेमोरी का सबसे कम एक्ट्सेस समय ह।ै 
A) कैश ममेोरी 
B) मैिेरटक बबल ममेोरी 
C) मैिेरटक कोर मेमोरी 
D) रैंडम एक्ट्सेस ममेोरी 
Answer- (a) कैश ममेोरी 
13. विुणअल ममेोरी का आकार क्तनभणर करता ह।ै 
A) ऐड्रसे लाइन्स पर 

B) डाटा बेस पर 

C) क्तडस्क स्पेश पर 

D) ये सभी 
Answer- (c) क्तडस्क स्पेश पर 

14. एक क्तडवाइस को डाटा और इंसट्रक्ट्शन लोेेकेट करने और उन्ह ेसीपीयू 
को उपलब्ध कराने मे लगा समय कहलाता ह।ै 
A) क्ट्लॉक स्पीड 

B) प्रोसेलसंग टाइम 

C) सीपीयू स्पीड 

D) एक्ट्सेस टाइम 

Answer- (d) एक्ट्ससे टाइम 

15. इनमे से सबसे तिे ममेोरी ह।ै 
A) सीडी रॉम 

B) रक्तिस्टर 

C) कैश 

D) इनमे से कोई नही 
Answer- (c) कैश 

Part – 12 

 

1. ककसी स्टोरेि मीक्तडयम मे स्टोर की िा सकने वाली डाटा की अक्तधकतम 
मात्रा को कहते ह।ै 
A) मैिेरटक स्टोरेि 

B) ऑक्त्टकल स्टोरेि 

C) सॉक्तलड स्टेट स्टोरेि 

D) स्टोरेि क्षमता 
Answer- (d) स्टोरेि क्षमता 
2. CD-RW का पूरा रूप ह।ै 
A) Compact Drum-Read-Write 

B) Compact Diskette-Read-Write 

C) Compact Disc-Read only then write 

D) Compact Disc-Re Writable 

Answer- (d) Compact Disc-Re Writable 

3. िब पॉवर ऑफ या बंद कर दी िाती ह ैतो यह मेमोरी अपने डाटा या 
कंटेन्ट खो दतेी ह ैइसे कहते ह।ै 
A) डायनक्तमक ममेोरी 
B) स्टैरटक मेमोरी 
C) वोलटाइल/अस्थायी ममेोरी 
D) दोषपणूण ममेोरी 
Answer- (c) वोलटाइल/अस्थायी मेमोरी 
4. वह डाटा िो ममेोरी मे क्तनमाणण के समय ही ररकाडण ककया गया हो और 
उसे प्रयोिा पररवर्तणत या क्तमटा नही सकता, कहलाता ह।ै 
A) केवल मेमोरी 
B) केवल राइट 

C) केवल रन 

D) केवल रीड 

Answer- (d) केवल रीड 

5. रैम अस्थायी ममेोरी ह ैक्ट्योककं 

A) इसे रीड और राइट दोनो के क्तलए प्रयोग ककया िाता ह।ै 
B) इसमे ककसी भी लोकेशन को सीधे पढा िा सकता ह।ै 
C) इसमे डाटा बनाए रखने के क्तलए लगातार पॉवर स्लाई की िरूरत होती 
ह।ै 
D) इनमे से कोई नही 
Answer- (c) इसमे डाटा बनाए रखने के क्तलए लगातार पॉवर स्लाई की 
िरूरत होती ह।ै 
6. िब इसमे क्तबिली बदं िो िाती ह ैतो भी ममेोरी के डाटा या कान्टेन्ट्स 
नष्ट नही होत-े 

A) रोम 

B) ईपी रोम 

C) ईईपी रोम 

D) उपयुक्र्त सभी 
Answer- (d) उपयुक्र्त सभी 
7. कम्प्यूटर की स्मृक्तत सामान्य तौर पर ककलोबाइट या मगेाबाइट के रूप मे 
व्यि की िाती ह ैएक बाइट बना होता ह।ै 
A) आठ क्तद्वआधारी अकंो का 
B) आठ दशमलव अकंो का 
C) दो आधारी अकंो का 
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D) दो दशमलव अंको का 
Answer- (a) आठ क्तद्वआधारी अंको का 
8. एक ककलोबाइट बराबर होता ह।ै 
A) 1000 बाइट्स 

B) 1024 बाइट्स 

C) 1042 बाइट्स 

D) 1 ककलोग्राम बाइट्स 

Answer- (b) 1024 बाइट्स 

9. कम्प्यूटर भाषा मे एक मेगाबाइट मे ककतने बाइट होते ह।ै 
A) 1000000 

B) 1000000 

C) 1024000 

D) 1048576 

Answer- (d)  1000000 

10. आठ क्तबटो के समूह को कहत ेह।ै 
A) क्तनबल 

B) बाइट 

C) वडण (शब्द) 
D) ककलोबाइट 

Answer- (b) बाइट 

11. 1 बाइट में ककतने क्तबट्स होते ह।ै 
A) 8 

B) 16 

C) 64 

D) 256 

Answer- (a) 8 

12. इनमे से कौन कम्प्यूटर मे प्रयुि अंक पददक्तत ह।ै 
A) क्तद्वआधारी 
B) ऑक्ट्टल 

C) हके्ट्साडके्तसमल 

D) उपयुणि तीनो 
Answer- (d) उपयुणि तीनो 
13. क्तबट क्ट्या ह।ै 
A) एक अकं पददक्तत 

B) कम्प्यूटर ममेोरी की सबसे छोटी इकाई 

C) एक इनपुट क्तडवाइस 

D) इनमे से कोई नही 
Answer- (b) कम्प्यूटर ममेोरी की सबसे छोटी इकाई 

14. कम्प्यूटर मे शब्द की लंबाई को मापा िाता ह।ै 
A) बाइट 

B) ककलोग्राम 

C) मीटर 

D) इनमे से कोई नही 
Answer- (a) बाइट 

15. कम्प्यूटर मेमोरी की क्षमता को मापते ह।ै 
A) क्तबट 

B) बाइट 

C) मीटर 

D) ककलोग्राम 

Answer- (b) बाइट 

Part – 13 

1. क्तबट का मतलब ह।ै 
A) बाइनरी क्तडक्तिट 

B) बाइनरी नंबर 

C) कम्प्यूटर एक भाग 

D) इनमे से कोई नही 
Answer- (a) बाइनरी क्तडक्तिट 

2. प्रत्यके कम्प्यूटर के की बोडण के प्रत्येक की ASCII होती ह ैक्तिसका पूणण रूप 
ह।ै 
A) अमेररकन स्टॉक कोड फॉर  इन्फामेशन इंटरिेंि 

B) अमेररकन स्टैण्डडण कोड फॉर इन्फामेशन इंटरिेंि 

C) अफ्रीकन स्टैण्डडण कोड फॉर इन्फामेशन इंटरिेंि 

D) एडा्टेबल स्टैण्डडण कोड फॉर इन्फामेशन इंटरिेंि 

Answer- (b) अमेररकन स्टैण्डडण कोड फॉर  इन्फामशेन इंटरिेंि 

3. सुपर कम्प्यूटर के क्तलए शब्द लंबाई की परास होती ह।ै 
A) 16 क्तबट तक 

B) 32 क्तबट तक 

C) 64 क्तबट तक 

D) 128 क्तबट तक 

Answer- (c) 64 क्तबट तक 

4. कम्प्यूटर मे डाटा स्टोर करने तथा गणना के क्तलए ककस नबंर क्तसस्टम का 
प्रयोग होता ह।ै 
A) दशमलव 

B) ऑक्ट्टल 

C) बाइनरी 
D) हके्ट्सा डके्तसमल 

Answer- (c) बाइनरी 
5. पद एमबी प्रयोग ककया िाता ह।ै 
A) मैिेरटक क्तबट्स के क्तलए 

B) मेगा बाइट्स के क्तलए 

C) मेगा क्तबट्स के क्तलए 

D) इनमे से कोई नही 
Answer- (b) मेगा बाइट्स के क्तलए 

186. दस लाख बाइटस लगभग होती ह।ै 
A) गीगा बाइट 

B) ककलो बाइट 

C) मेगा बाइट 

D) टेरा बाइट 

Answer- (c) मेगा बाइट 

7. क्तनम्नक्तलक्तखत मे से स्टोरेि का सबसे बडा यूक्तनट कौन सा ह।ै 
A) GB 

B) KB 

C) MB 

D) इनमे से कोई नही 
Answer- (a) GB 
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8. बड ेसे छोटे के क्रम मे क्तनम्नक्तलक्तखत मे से कौन सा सही ह।ै 
A) TB-MB-GB-KB 

B) TB- KB-GB-KB 

C) GB -MB- TB -KB 

D) TB- GB -MB -KB 

Answer- (d) TB- GB -MB -KB 

9. कम्प्यूटर संक्तक्षप्ताक्षर KB का सामान्यतः अथण होता ह।ै 
A) की ब्लॉक 

B) कनणल बूट 

C) ककलो बाइट 

D) ककट क्तबट 

Answer- (c) ककलोबाइट 

10. सबसे ज्यादा प्रयोग मे आने वाला कोड कौन सा ह ैप्रत्यके कैरेक्ट्टर को 
क्तवक्तशष्ट 8 क्तबट कोड के रूप मे क्तनरूक्तपत करता ह।ै 
A) आस्की 
B) यूक्तनकोड 

C) बाइनरी नंबर 

D) इनमे से कोई नही 
Answer- (b) यूक्तनकोड 

11. कम्प्यूटर मे एक क्तनबल ककतने क्तबट को क्तनरूक्तपत करता ह।ै 
A) 4 

B) 8 

C) 16 

D) 32 

Answer- (a) 4 

12. एक हल्का संवदेनशील क्तडवाइस िो क्तित्रकारी, मुकरत पाठ या अन्य 
छक्तवयों को क्तडक्तिटल रूप में पररवर्तणत करता ह।ै 
A) Keyboard 

B) Plotter 

C) Scanner 

D) OMR 

Answer- (c) Scanner 

13. ककतनी पीक़ियों में कं्यूटर को वगीकृत ककया िा सकता ह?ै 

A) 1 

B) 2 

C) 5 

D) 4 

Answer- (c) 5 

14. कं्यूटर में क्तनम्न सर्कण ट का ‘मेमोरी क्तडवाइस’ के रूप में प्रयोग ककया 
िाता ह।ै 
A) Rectifier 

B) Flip Flop 

C) Comparator 

D) Attenuator 

Answer- (b) Flip Flop 

15. क्तनम्नक्तलक्तखत में से कौन सा िुंबकीय क्तडस्क भंडारण का लाभ नहीं ह।ै 
A) The access time of magnetic disk is much less than that 

of magnetic tape 

B) Disk storage is less expensive than tape storage 

C) Comparator 

D) None of the above 

Answer- (d) None of the above 

Part – 14 

1. क्तलक्तनक्ट्स एक- 

A) आपरेटटंग क्तसस्टम का नाम ह ै

B) केक्तमकल का नाम ह ै

C) बीमारी का नाम ह ै

D) कम्प्यूटर वायरस ह ै

Answer- (a) आपरेटटंग क्तसस्टम का नाम ह ै

2. सीएडी (CAD) का तात्पयण ह।ै 
A) कम्प्यूटर एल्गोररथम फॉर क्तडिाइन 

B) कम्प्यूटर एडडे क्तडिाइन 

C) कम्प्यूटर एक्त्लकेशन इन क्तडिाइन 

D) इनमे से कोई नही 
Answer- (b) कम्प्यूटर एडडे क्तडिाइन 

3. माइक्रोसाफ्ट ऑकफस ह।ै 
A) शेयर वेयर 

B) एक्त्लकेशन साफ्टवेयर 

C) ओपन सोसण साफ्टवेयर 

D) पक्तब्लक डोमेन साफ्टवेयर 

Answer- (b) एक्त्लकेशन साफ्टवेयर 

4. कौन सा साफ्टवेयर शब्द संसाधन मे प्रयुि ककया िाता ह।ै 
A) पेि मेकर 

B) वडण स्टार 

C) एमएस वडण 
D) उपणयुि सभी 
Answer- (d) उपणयुि सभी 
5. पक्तब्लक डोमने साफ्टवेयर ह।ै 
A) पक्तब्लक द्वारा बनाया गया साफ्टवेयर 

B) इंटरनेट पर मुफ्त मे उपलब्ध साफ्टवेयर 

C) सरकारी साफ्टवेयर 

D) माइक्रोसाफ्ट साफ्टवेयर 

Answer- (b) इंटरनेट पर मुफ्त मे उपलब्ध साफ्टवेयर 

6. कम्प्यूटर आंकडो मे अशुक्तदद को कहा िाता ह।ै 
A) क्तिप 

B) बाइट 

C) बग 

D) क्तबट 

Answer- (c) बग 

7. असेम्पबलर का कायण ह।ै 
A) बेक्तसक भाषा को यंत्र भाषा म ेपररवर्तणत करना 
B) उच्च स्तरीय भाषा को यतं्र भाषा मे पररवर्तणत करना 
C) असेम्पबली भाषा को यंत्र भाषा मे पररवर्तणत करना 
D) असेम्पबली भाषा को उच्च स्तरीय भाषा मे पररवर्तणत करना 
Answer- (c) असेम्पबली भाषा को यंत्र भाषा मे पररवर्तणत करना 
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8. एक कम्प्यूटर प्रोग्राम क्तिससे कम्प्यूटर का प्रयोग करना आसान हो िाता 
ह।ै 
A) आपरेंरटग क्तसस्टम 

B) एक्त्लकेशन प्रोग्राम 

C) नेटवकण  
D) यूरटक्तलटी साफ्टवेयर 

Answer- (d) यूरटक्तलटी साफ्टवेयर 

9. सॉफ्टवेयर बग को ठीक करने के क्तलए प्रयुि प्रोगाम कहलाता ह।ै 
A) पैि 

B) युरटक्तलटी 
C) रेक्तक्ट्टकफकेशन 

D) इनमे से कोई नही 
Answer- (a) पिै 

10. बैक अप कहलाता ह।ै 
A) डाटा को पीछे रखना 
B) मूल स्त्रोत से अलग डाटा को कापी कर सरुक्तक्षत रखना 
C) प्रोग्राम को सेव करना 
D) इनमे से कोई नही 
Answer- (b) मूल स्त्रोत से अलग डाटा को कापी कर सरुक्तक्षत रखना 
11. अनुदशेो का समूह िो कम्प्यटूर को क्ट्या करना ह ैयह बतलाता है, 
कहलाता ह।ै 
A) कंपाइलर 

B) डी बगर 

C) प्रोग्राम 

D) इंटरप्रीटर 

Answer- (c) प्रोग्राम 

12. उपयोगकताण यह कैसे क्तनधाणररत कर सकता ह ैकक कम्प्यूटर पर कौन सा 
प्रोग्राम उपलब्ध ह।ै 
A) हाडण क्तडस्क की प्रॉपटी दखेकर 

B) बूटटंग के दौरान प्रोग्राम की सिूी दखेकर 

C) क्तडस्क की फाइले दखेकर 

D) इनमे से कोई नही 
Answer- (b) बूटटंग के दौरान प्रोग्राम की सिूी दखेकर 

13. कम्प्यूटर के सभी भाग ठीक कायण कर रह ेह ैतथा क्तसस्टम मे लगे हुए ह,ै 

यह सुक्तनक्तित ककया िाता ह।ै 
A) बूटटंग द्वारा 
B) प्रोसेलसंग द्वारा 
C) डसे्कटाप द्वारा 
D) इंक्तडटटंग द्वारा 
Answer- (a) बूटटंग द्वारा 
14. दो या अक्तधक प्रोग्राम के एक साथ प्रोसेलसंग की प्रकक्रया कहलाती ह।ै 
A) मल्टी प्रोग्रालमंग 

B) मल्टी टालस्कंग 

C) मल्टी प्रोसेलसंग 

D) टाइम शेयटरंग 

Answer- (c) मल्टी प्रोसेलसंग 

15. एमएस वडण उदाहरण ह।ै 
A) आपरेटटंग क्तसस्टम का 

B) प्रोसेलसंग साफ्टवेयर का 
C) एक्त्लकेशन साफ्टवेयर का 
D) हाडणवेयर का 
Answer- (c) एक्त्लकेशन साफ्टवेयर का 

Part – 15 

1. ग्रुपवेयर होता ह।ै 
A) हाडणवेयर 

B) नेटवकण  
C) सॉफ्टवेयर 

D) फमणवयेर 

Answer- (c) सॉफ्टवेयर 

2. भारत की सबसे बडी साफ्टवेयर कंपनी ह।ै 
A) इम्पफोक्तसस 

B) टीसीएस 

C) क्तवप्रो 
D) एिसीएल टेक 

Answer- (b) टीसीएस 

3. िीआई एफ 

A) क्तियोग्राकफकल इमिे फामेट 

B) ग्लोबल इंटरिेंि फामेट 

C) ग्राकफकल इंटरिेंि फामेट 

D) इनमे से कोइ नही 
Answer- (c) ग्राकफकल इंटरिेंि फामेट 

4. C भाषा ह।ै 
A) क्तनम्न स्तरीय भाषा 
B) उच्च स्तरीय भाषा 
C) मशीन स्तर की भाषा 
D) संयोिन स्तर की भाषा 
Answer- (b) उच्च स्तरीय भाषा 
5. क्तनम्नक्तलक्तखत मे से ककस क्षेत्र म ेस्प्रडशीट साफ्टवेयर अक्तधक उपयोगी होता 
ह।ै 
A) मनोक्तवज्ञान 

B) प्रकाशन 

C) सांक्तययकी 
D) संदशे प्रषेण 

Answer- (c) सांक्तययकी 
6. इसका प्रयोग स्क्रीन पर प्रदर्शणत हुए क्तित्रो के द्वारा कम्प्यूटर क्तसस्टम को 
कमांड भिेने के क्तलए ककया िाता ह।ै 
A) ग्राकफकल यिूर इंटरफेस 

B) एक्त्लकेशन प्रोग्राम इंटरफेस 

C) कमांड इंटरफेस 

D) इनमे से कोई नही 
Answer- (a) ग्राकफकल यूिर इंटरफेस 

7. कौन सा प्रोग्राम सभी स्टेटमेंट्स को एक लसंगल बिै मे कनवटण करता ह ै
और इंस्ट्रक्ट्शन्स के ररिलल्टंग कलके्ट्शन को एक नई फाइल मे रखता है। 
A) कम्पपाइलर 

B) इंटरप्रेटर 

C) कनवटणर 
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D) इनमे से कोई नही 
Answer- (a) कम्पपाइलर 

8. कम्प्यूटर क्तसस्टम का भाग क्तिसमे प्रोग्राम या अनदुशे शाक्तमल होेेते ह,ै 

कहलाता ह।ै 
A) हाडणवयर 

B) साफ्टवेयर 

C) आइकन 

D) इनमे से कोई नही 
Answer- (b) साफ्टवेयर 

9. िो अनुदशे आसानी से समझा िा सकता ह,ै उसे कहते ह।ै 
A) यूिर फे्रडली 
B) इन्फामेशन 

C) वडण प्रोसेलसंग 

D) आइकन 

Answer- (a) यिूर फे्रडली 
10. वह साफ्टवेयर िो उस तरीके को क्तनयंक्तत्रत करता ह,ै क्तिससे कम्प्यूटर 
क्तसस्टम काम करता ह ैऔर ऐसे साधन उपलब्ध कराता ह,ै क्तिसके द्वारा 
प्रयोिा कम्प्यूटर के साथ इंटरैक्ट्ट कर सकता ह,ै कहलाता ह।ै 
A) ्लेटफामण 
B) आपरेटटंग क्तसस्टम 

C) एक्त्लकेशन साफ्टवेयर 

D) मदरबोडण 
Answer- (b) आपरेटटंग क्तसस्टम 

11. िब कम्प्यूटर आन करते ह ैतो बूट रूटीन यह टेस्ट करता ह।ै 
A) रैम टेस्ट 

B) क्तडस्ट ड्राइव टेस्ट 

C) मेमोरी टेस्ट 

D) पावर ऑन सेल्फ टेस्ट 

Answer- (d) पावर ऑन सेल्फ टेस्ट 

12. दो या अक्तधक प्रोसेसर द्वारा दो या अक्तधक प्रोग्रामो का साथ-साथ 
प्रोसेलसंग कहलाता ह।ै 
A) मल्टी प्रोग्रालमंग 

B) मल्टी टालस्कंग 

C) मल्टी प्रोसेलसंग 

D) टाइम शेयटरंग 

Answer- (d) टाइम शयेटरंग 

13. ककसी प्रोग्राम के मानव द्वारा पठनीय दशणन को कहते ह।ै 
A) सोसण कोड 

B) प्रोग्राम कोड 

C) क्तसस्टम कोड 

D) इनमे से कोई नही 
Answer- (b) प्रोग्राम कोड 

14. प्रोग्राम के कम्पपाइललंग से बनता ह।ै 
A) प्रोग्राम स्पेक्तसकफकेशन 

B) एल्गोररथम 

C) एक्ट्िीक्ट्यूटेबल प्रोग्राम 

D) सब रूटीन 

Answer- (c) एक्ट्िीक्ट्यूटेबल प्रोग्राम 

15. एक समय मे एक कथन को कन्वटण और एक्ट्िके्ट्यूट करता ह।ै 
A) कन्वटणर 

B) कंपाइलर 

C) इंटस्ट्रक्ट्टर 

D) इंटरक्तप्रटर 

Answer- (d) इंटरक्तप्रटर 

Part – 16 

1. पोस्ट का परूा रूप ह।ै 
A) Power of Self Test 

B) Program on Self test 

C) Power on System test 

D) Power off System test 

Answer- (a) Power of Self Test 

2. क्तलक्तनक्ट्स ककस ककस्म का सॉफ्टवेयर ह।ै 
A) शेयर वेयर 

B) कमर्शणयल 

C) प्रायराइटरी 
D) ओपन सोसण 
Answer- (d) ओपन सोसण 
3. िब एक कम्प्यूटर मे दो प्रोससेर लगाए िाते ह ैतो उसे कहते ह।ै 
A) डबल प्रोसलेसंग 

B) सीक्ें क्तशयल प्रोसेलसंग 

C) डुक्त्लकेट प्रोसेलसंग 

D) पैरालले प्रोसलेसंग 

Answer- (d) पैरालेल प्रोसेलसंग 

4. िब आप कम्प्यूटर बूट करते ह ैतो 
A) आपरेटटंग क्तसस्टम क्तडस्क से रैम मे काे पी ककया िाता ह।ै 
B) आपरेटटंग क्तसस्टम  मेमोरी से क्तडस्क मे काे पी ककया िाता ह।ै 
C) आपरेटटंग क्तसस्टम  के अंश कंपाइल ककये िाते ह।ै 
D) कम्प्यूटर बंद हो िाते ह।ै 
Answer- (a) आपरेटटंग क्तसस्टम क्तडस्क से रैम मे काे पी ककया िाता ह।ै 
5. कम्पपाइलर ह।ै 
A) एक ऐसा प्रोग्राम िो असमे्पबली भाषा मे क्तलक्तखत प्रोग्राम को मशीनी भाषा 
मे पररवर्तणत करता ह।ै 
B) एक ऐसा प्रोग्राम िो उच्च स्तरीय भाषा मे क्तलक्तखत प्रोग्राम क्तलक्तखत प्रोग्राम 
को मशीनी भाषा मे पररवर्तणत करता ह।ै 
C) मशीनी भाषा से क्तलक्तखत प्रोग्राम 

D) इनमे से कोई नही 
Answer- (b) एक ऐसा प्रोग्राम िो उच्च स्तरीय भाषा मे क्तलक्तखत प्रोग्राम 
क्तलक्तखत प्रोग्राम को मशीनी भाषा मे पररवर्तणत करता ह।ै 
6. कम्प्यूटर के संदभण मे सॉफ्टवेयर का अथण ह।ै 
A) फ्लॉफी क्तडस्क 

B) कम्प्यूटर प्रोग्राम्पस 

C) कम्प्यूटर सर्कण ट 

D) इनमे से कोई नही 
Answer- (b) कम्प्यूटर प्रोग्राम्पस 

7. एक यूरटक्तलटी सॉफ्टवेयर प्रोग्राम िो मेमोरी के अनावश्यक फे्रगमेंट स्पेश 
को पनुव्यणवस्था करता ह ैताकक आपरेशन इष्टतम ढंग से हो सके, कहलाता ह।ै 
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A) बैकअप 

B) क्तडस्क क्ट्लीनअप 

C) क्तडस्क क्तडफ्रें ग्मेंट 

D) इनमे से कोई नही 
Answer- (c) क्तडस्क क्तडफ्रें ग्मेंट 

8. वह भाषा क्तिसे कम्प्यूटर क्तबना लैंग्विे ट्रांसलेटर प्रोग्राम के समझता है, 
कहलाती ह।ै 
A) अमेररकन भाषा 
B) मशीनी भाषा 
C) असेम्पबली भाषा 
D) इनमे से कोई नही 
Answer- (b) मशीनी भाषा 
9. इनमे से कौन कम्प्यूटर नही ह।ै 
A) BASIC 

B) FORTRAN 

C) COBOL 

D) IBM 

Answer- (d) IBM 

10. प्रोग्राम के क्तलए क्तवकक्तसत पहली उच्च स्तरीय भाषा ह।ै 
A) BASIC 

B) FORTRAN 

C) COBOL 

D) LOGO 

Answer- (c) COBOL 

11. LOGO भाषा का प्रयोग ककया िाता ह।ै 
A) व्यवसाय म े

B) गक्तणत म े

C) बच्चो की क्तशक्षा म े

D) सरल भाषा क्तलखने म े

Answer- (c) बच्चो की क्तशक्षा म े

12. BASIC भाषा का प्रयोग ककया िाता ह।ै 
A) व्यवसाय म े

B) गक्तणत म े

C) बच्चो की क्तशक्षा म े

D) सरल भाषा को क्तसखाने म े

Answer- (d) सरल भाषा को क्तसखाने म े

13. COBOL भाषा का प्रयोग ककया िाता ह।ै 
A) व्यवसाय म े

B) गक्तणत म े

C) बच्चो की क्तशक्षा म े

D) सरल भाषा क्तलखने म े

Answer- (a) व्यवसाय म े

14. उच्च स्तरीय भाषा को मशीन भाषा मे बदलता ह।ै 
A) कम्पपाइलर 

B) इंटरप्रेटर 

C) दोनो 
D) इनमे से कोई नही 
Answer- (c) (a) और (b)दोनो 

15. असेम्पबलर का कायण ह।ै 
A) बेक्तसक भाषा को यंत्र भाषा म ेपररवर्तणत करना 
B) उच्च स्तरीय भाषा को यतं्र भाषा मे पररवर्तणत करना 
C) असेम्पबली भाषा को यंत्र भाषा मे पररवर्तणत करना 
D) असेम्पबली भाषा को उच्च स्तरीय भाषा पररवर्तणत करना 
Answer- (c) असेम्पबली भाषा को यंत्र भाषा मे पररवर्तणत करना 

Part – 17 

 

1. इनम ेस ेकौन सी वजै्ञाक्तनक कम्प्यटूर भाषा ह।ै 
A) बके्तसक 

B) कोबोल 

C) फोरट्रान 

D) पास्कल 

Answer- (c) फोरट्रान 

2. भाषा क्तिसे कम्प्यूटर समझता और क्तनष्पाकदत करता ह,ै कहलाती ह।ै 
A) अमेररकन भाषा 
B) मशीन भाषा 
C) गुप्त प्रच्छल भाषा 
D) इनमे से कोई नही 
Answer- (b) मशीन भाषा 
3. फोरट्रान, एल्गोल, पास्कल आकद भाषाओ को क्तसखाने के क्तलए नीव का 
पत्थर कहा िाता ह।ै 
A) सी++ 

B) बेक्तसक 

C) कोबोल 

D) फ्रें ि 

Answer- (b) बेक्तसक 

4. इंटरनेट पर प्रयुि कम्प्यूटर लैंग्विे ह।ै 
A) िावा 
B) बेक्तसक 

C) कोबोल 

D) पास्कल 

Answer- (a) िावा 
5. प्रोलॉग भाषा क्तवकक्तसक हुई। 
A) 1972 ई. म े

B) 1970 ई. मे 
C) 1975 ई. म े

D) 1973 ई. मे 
Answer- (a) 1972 ई. म े

6. वडण प्रोसेसर तथा स्प्रैडशीट उदाहरण ह।ै 
A) क्तसस्टम साफ्टवेयर का 
B) ए्लीकेशन साफ्टवेयर का 
C) ्लेटफामण साफ्टवेयर का 
D) इनमे से कोई नही 
Answer- (b) ए्लीकेशन साफ्टवेयर का 
7. वे शब्द क्तिन्ह ेप्रोग्राक्तमग के लैंग्वेि ने अपने प्रयोग के क्तलए अलग रखा है, 
कहलाते ह।ै 
A) कंट्रोल वडणस 
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B) ररिवण वडणस 

C) कंट्रोल स्ट्रक्ट्िसण 
D) इनमे से कोई नही 
Answer- (b) ररिवण वडणस 

8. C, BASIC, COBOL और JAVA उदाहरण ह।ै 
A) लो लेवल लैंग्विे के 

B) कम्प्यूटर के 

C) क्तसस्टम प्रोग्राम के 

D) हाई लेक्तवल लगै्विे के 

Answer- (d) हाई लेक्तवल लगै्विे के 

9. क्तनम्नक्तलखत मे से कौन सा मशीन इंक्तडलपंडेंट प्रोग्राम ह।ै 
A) हाई लेक्तवल लैंग्वेि 

B) लो लेवल लैंग्विे 

C) एसेंमबली लैंग्विे 

D) मशीन लैंग्विे 

Answer- (a) हाई लेक्तवल लैंग्विे 

10. एसेंबली लैंग्वेि ह।ै 
A) हाई लेक्तवल लैंग्वेि 

B) एसेंमबली लैंग्विे 

C) लो लेवल लैंग्वेि 

D) मशीन लैंग्विे 

Answer- (c) लो लेवल लैंग्वेि 

11. ककसी कम्प्यूटर प्रोग्राम मे बच्चो द्वारा प्रयुि भाषा प्रायः कौन सी होती 
ह।ै 
A) िावा 
B) लोगो 
C) पायलट 

D) बेक्तसक 

Answer- (b) लोगो 
12. ऑरेकल ह।ै 
A) एक प्रिालन तंत्र 

B) पेिमेकर साफ्टवेयर 

C) एक हाडणवेयर 

D) एक डाटाबेस साफ्टवेयर 

Answer- (d) एक डाटाबसे साफ्टवेयर 

13. एक डाटाबसे मे फील्ड होती ह।ै 
A) लेवल 

B) सूिना की ताक्तलका 
C) संबंक्तधत ररकाड्सण का समूह 

D) िानकारी की श्रेणी 
Answer- (d) िानकारी की श्रेणी 
14. एक ही डाटा को कई िगहो पर सेव करना कहलाता ह।ै 
A) इंटरैक्ट्शन 

B) कंकरेंसी 
C) ररडन्डसेी 
D) इनमे से कोई नही 
Answer- (c) ररडन्डसेी 

15.कम्प्यूटर एक्त्लकेशन बनाने के क्तलए प्रयुि डीबीएमएस ह।ै 
A) डाटाबेस मशीन क्तसस्टम 

B) डाटाबेस मेक्तन्टनेंस क्तसस्टम 

C) डाटाबेस मनैिेमेंट क्तसस्टम 

D) डाटाबेस माइक्रो क्तसस्टम 

Answer- (c) डाटाबेस मनैिेमेंट क्तसस्टम 

Part – 18 

1. क्तनम्न मे से कौन डाटा को छोटे से बड ेके क्तहसाब से प्रदर्शणत करता ह।ै 
A) क्तबट, बाइट, कैरेक्ट्टर, फील्ड, ररकाडण, फाइल, डटेाबेस 

B) कैरेक्ट्टर, फाइल, ररकाडण, फील्ड, डटेाबेस 

C) ररकाडण, फील्ड, कैरेक्ट्टर, डटेाबेस, फाइल 

D) कैरेक्ट्टर, फील्ड, फाइल, ररकाडण, डटेाबेस 

Answer- (a) क्तबट,बाइट, कैरेक्ट्टर, फील्ड, ररकाडण, फाइल, डटेाबेस 

2. डाटाबेस मे प्राइमरी की का उदे्यश्य ह।ै 
A) डटेाबेस को अनलॉक करना 
B) डटेाबेस को मपै उपलब्ध कराना 
C) डटेाबेस ऑपरेशन पर बाधाए लगाना 
D) ररकाडण का यूक्तनक ढंग से पहिान करना 
Answer- (d) ररकाडण का यूक्तनक ढंग से पहिान करना 
3. क्तनम्नक्तलक्तखत मे से ककसमे व्यक्ति, स्थान, घटना या िीि िैसी लसंगल 
एंरटटी संबंधी िानकारी डाटाबेस मे होती ह।ै 
A) के्री 
B) फामण 
C) ररकाडण 
D) टेबल 

Answer- (c) ररकाडण 
4…………… का अथण ह ैकक डाटाबेस मे रखा डाटा एक्ट्यूरेट और ररलायबल 
ह।ै 
A) डाटा ररडन्डने्सी 
B) डाटा इंटीक्तग्रटी 
C) डाटा ररयालबक्तलटी 
D) इनमे से कोई नही 
Answer- (b) डाटा इंटीक्तग्रटी 
5. डाटाबेस मनैिेमेंट क्तसस्टम होता ह।ै 
A) डाटाबेस को कक्रएट, मेंटेन और कंट्रोल्ड एक्ट्सेस उपलब्ध कराने के क्तलए 
प्रयुि हाडणवयेर 

B) डाटाबेस को कक्रएट, मेंटेन और अकंट्रोल्ड एक्ट्सेस उपलब्ध कराने के क्तलए 
प्रयुि हाडणवयेर 

C) डाटाबेस को कक्रएट, मेंटेन और कंट्रोल्ड एक्ट्सेस उपलब्ध कराने के क्तलए 
प्रयुि साफ्टवेयर 

D) डाटाबेस को कक्रएट, मेंटेन और अकंट्रोल्ड एक्ट्सेस उपलब्ध कराने के क्तलए 
प्रयुि साफ्टवेयर 

Answer- (a) डाटाबेस को कक्रएट, मेंटेन और कंट्रोल्ड एक्ट्सेस उपलब्ध कराने 
के क्तलए प्रयुि साफ्टवेयर 

6. कच्छे तथ्य…………….कहलाते ह ैिबकक अथणपूणण डाटा……….. बन िाता 
ह।ै 
A) सूिना, ररपोर्टिंग 

B) डाटा, सूिना 
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C) सूिना, क्तबट्स 

D) ररकाडण, बाइट 

Answer- (b) डाटा, सूिना 
7. इनफामेशन क्तसस्टम मे अल्फा न्यूमेररक डाटा ह।ै 
A) वाक्ट्य व परैाग्राफ 

B) नंबर और अल्फाबेरटक कैरेक्ट्टर 

C) ग्राकफक और कफगर 

D) इनमे से कोई नही 
Answer- (b) नंबर और अल्फाबेरटक कैरेक्ट्टर 

8. टपल क्ट्या होता ह।ै 
A) टेबल का कालम 

B) दो आयामी टेबल 

C) टेबल की एक रो 
D) टेबल की एक कंुिी 
Answer- (c) टेबल की एक रो 
9. परस्पर संबकं्तधत ररकाडण के समूह को कहते ह।ै 
A) यूरटक्तलटी फाइल 

B) मैनिेमेंट क्तसस्टम 

C) डाटाब े

D) इनमे से कोई नही 
Answer- (c) डाटाबेस 

10. क्तनकनेट ह।ै 
A) एक अतंराष्ट्रीय नेटवकण  
B) क्तवशेष तार का बनुा िाल 

C) इंटरनेट का दसूरा नाम 

D) भारत के प्रत्येक क्तिलो को िोडने वाला नेटवकण  
Answer- (d) भारत के प्रत्यके क्तिलो को िोडने वाला नेटवकण  
11. लॉग हॉल नेटवकण  कहा िाता ह।ै 
A) लैन को 
B) मैन को 
C) वैन को 
D) इनमे से कोई नही 
Answer- (c) वैन को 
12. अपाणनेट ह।ै 
A) क्तवश्व का पहला वनै 

B) एक्तशया का पहला वनै 

C) भारत का पहला वैन 

D) क्तवश्व का पहला लनै 

Answer- (b) क्तवश्व का पहला वैन 

13. आईएसडीएन सेवा मे मॉडमे की िरूरत नही पडती क्ट्योंकक 

A) इससे कम्प्यूटर को िोडा नही िा सकता 
B) यह छोटी दरूी के क्तलए प्रयोग ककया िाता ह ै

C) इसमे डटेा हस्तातंरण सभंव नही ह।ै 
D) इसमे डटेा हस्तांतरण क्तडिीटल रूप मे होता ह।ै 
Answer- (d) इसमे डटेा हस्तातंरण क्तडिीटल रूप मे होता ह।ै 
14. माइक्रो कम्प्यूटर को टेलीफोन से कौन सी व्यवस्था िोडती ह।ै 
A) वीडीय ू

B) मॉडमे 

C) यूक्तनक्ट्स 

D) सीपीय ू

Answer- (b) मॉडमे 

15. संिार नेटवकण  क्तिसका प्रयोग बडी संस्थाओ द्वारा प्रोदके्तशक राष्ट्रीय और 
वैक्तश्वक क्षते्र मे ककया िाता ह,ै कहलाता ह।ै 
A) LAN 

B) WAN 

C) MAN 

D) VAN 

Answer- (b) WAN 

Part – 19 

1. पसणनल कम्प्यूटर आपस मे कनके्ट्ट ककए िा सकते ह।ै 
A) सवणर म े

B) सुपर कम्प्यूटर म े

C) नेटवकण  म े

D) नोड म े

Answer- (c) नेटवकण  म े

2. क्तसम का पूरा स्वरूप ह।ै 
A) सब्सक्राइबसण आइडेंरटटी माडयूल 

B) सब्सक्राइबसण आइडेंरटटी मशीन 

C) सेल्फ आइडेंरटटी मशीन 

D) सेल्फ आइडेंरटटी माडयूल 

Answer- (a) सब्सक्राइबसण आइडेंरटटी माडयलू 

3. दरूदशणन प्रसारण मे क्तित्र संदशेो का सिंरण होता ह।ै 
A) आयाम माडुलशेन द्वारा 
B) आवृक्तत्त माडुलेशन द्वारा 
C) कला माडुलेशन द्वारा 
D) कोण माडुलेशन द्वारा 
Answer- (a) आयाम माडुलेशन द्वारा 
4. Wi Max क्तनम्नक्तलक्तखत मे से ककससे संबंक्तधत ह।ै 
A) िैव प्रौद्योक्तगकी 
B) अंतररक्ष प्रौद्योक्तगकी 
C) क्तमसाइल प्रौद्योक्तगकी 
D) संिार प्रौद्योक्तगकी 
Answer- (d) सिंार प्रौद्योक्तगकी 
5. आभासी क्तनिी पररपथ क्ट्या ह।ै 
A) यह ककसी संस्था का क्तनिी कम्प्यूटर पररपथ ह ैक्तिसमे सदुरु बैठे प्रयोिा 
संस्था के सवणर के मादयम से सिूना प्रेक्तषत कर सकते ह।ै 
B) ककसी क्तनिी इंटरनेट पर बना कम्प्यूटर पररपथ ह,ै िो प्रयोिाओ को 
अपनी संस्था के पररपथ मे प्रवेश करने की सुक्तवधा दतेा है और प्रेक्तषत की िा 
रही सिूना को सरुक्तक्षत रखता ह।ै 
C) यह ककसी संस्था का क्तनिी कम्प्यूटर पररपथ ह ैक्तिसमे सदुरु बैठे प्रयोिा 
संस्था के सवणर के मादयम से सिूना प्रेक्तषत कर नही सकते ह।ै 
D) इनमे से कोई नही 
Answer- (b) ककसी क्तनिी इंटरनेट पर बना कम्प्यूटर पररपथ ह,ै िो 
प्रयोिाओ को अपनी ससं्था के पररपथ मे प्रवेश करने की सुक्तवधा दतेा ह ैऔर 
प्रेक्तषत की िा रही सिूना को सुरक्तक्षत रखता ह।ै 
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6. कम्प्यूटर का िाल क्रक्तमत करना 
A) खतरो के अवसरो मे बढोत्तरी करता ह ै

B) कम्प्यूटर की उपयोक्तगता बढाता ह ै

C) सूिना अक्तभगमन की सभंावनाओ को बढाता ह ै

D) उपरोि सभी 
Answer- (d) उपरोि सभी 
7. बैकबोन संबंक्तधत ह।ै 
A) हाडणवेयर स े

B) साफ्टवेयर स े

C) साइबर क्राइम स े

D) इंटरनेटर स े

Answer- (d) इंटरनेटर स े

8. सी-बैंड प्रषेण मे प्रयोग की आवश्यकता होती ह।ै 
A) 3GHz 

B) 4GHz 

C) 5GHz 

D) 6GHz 

Answer- (d) 6GHz 

9. क्तसिल की शक्ति कम हुए क्तबना नेटवकण  की लंबाई बढाने क क्तलए उपयोग 
करते ह।ै 
A) ररपीटर 

B) राउटर 

C) गेटव े

D) क्तस्वि 

Answer- (a) ररपीटर 

10. नेशनल ई-गवनसे ्लान के अंतगणत एसडब्ल्यएूएन ह।ै 
A) स्टेट वाइड एररया नेटवकण  
B) क्तसस्टम वाइड एररया नेटवकण  
C) स्टेट वाइि एररया नेटवकण  
D) क्तसस्टम वाइि एररया नेटवरा् 
Answer- (a) स्टेट वाइड एररया नेटवकण  
11. ककसी कंपनी के कमणिाररयो द्वारा एक ही स्थान मे उपयोग ककया िाने 
वाला अनन्य रूप से क्तनिी नेटवकण  होगा। 
A) इंटरनेट 

B) लोकल एररया नेटवकण  
C) वाइड एररया नेटवकण  
D) आपाणनेट 

Answer- (b) लोकल एररया नटेवकण  
12. 2G स्पेक्ट्ट्रम मे अक्षर G ककस शब्द के क्तलए प्रयुि ह।ै 
A) ग्लोबल गवनणमेंट 

B) िेनरेेशन 

C) गूगल 

D) उपरोि सभी 
Answer- (c) गूगल 

13. संिार नेटवकण , क्तिसका प्रयोग बडी संस्थाओ द्वारा प्रोदके्तशक राष्ट्रीय व 
वैक्तश्वक क्षते्र मे ककया िाता ह,ै कहलाता ह।ै 
A) लैन 

B) वैन 

C) मनै 

D) वान 

Answer- (b) वैन 

14. डाटा प्रेषण की गक्तत को मापने के क्तलए सामान्यतः प्रयुि इकाई ह।ै 
A) मेगा हट्िण 
B) संप्रतीक प्रक्तत सकेें ड 

C) क्तबट प्रक्तत सेकें ड 

D) नैनो सकेें ड 

Answer- (c) क्तबट प्रक्तत सेकें ड 

15. मोबाइल फोन मे प्रयुि सीडीएमए प्रौद्योक्तगकी ह।ै 
A) कम्प्यूटर डवेल्ड मनैिेमेंट एक्त्लकेशन 

B) कोड क्तडवीिन मक्तल्टपल एक्त्लकेशन 

C) कोड क्तडवीिन मक्तल्टपल एक्ट्ससे 

D) इनमे से कोई नही 
Answer- (c) कोड क्तडवीिन मक्तल्टपल एक्ट्ससे 

Part – 20 

 
1. मोशन क्तपक्ट्िर क्तक्ट्लप मे बदलाव करने के क्तलए ककस प्रकार का साफ्टवेयर 
प्रयोग ककया िाता ह।ै 
A) ड्रांइग 

B) वीक्तडयो एक्तडटटंग 

C) पेटटंग 

D) इनमे से कोई नही 
Answer- (b) वीक्तडयो एक्तडटटंग 

2. ग्राकफकल यिूर इंटरफेस का प्रारंभ ककया था। 
A) माइक्रोसाफ्ट न े

B) ए्पल कम्प्यूटर न े

C) िेरोक्ट्स कारपोरेशन ने 
D) इनमे से कोई नही 
Answer- (c) िरेोक्ट्स कारपोरेशन न े

3. क्तवण्डोि 3.0 संस्करण िारी ककया गया था। 
A) 1990 म े

B) 1991 मे 
C) 1992 म े

D) 1993 मे 
Answer- (a) 1990 म े

4. ग्राकफकल यिूर इंटरफेस मे प्रोग्रामो को दशाणने के क्तलए छोटे छोटे तस्वीरो 
का प्रयोग ककया िाता ह ैये कहलाते ह।ै 
A) फीगर 

B) आइकन 

C) फाइल 

D) फोल्डर 

Answer- (b) आइकन 

5. क्तवण्डोि मे फाइल नाम के सबंंध मे क्ट्या सही ह।ै 
A) खाली स्थान का प्रयोग ककया िा सकता ह ै

B) क्तवशेष क्तिन्हो का प्रयोग ककया िा सकता ह ै

C) अक्तधकतम 255 कैरेक्ट्टर का प्रयोग ककया सकता ह ै
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D) उपयुक्र्त सभी 
Answer- (d) उपयुक्र्त सभी 
6. क्तवण्डोि मे Delete की गई फाइले िली िाती ह।ै 
A) रीसाइककल क्तबन म े

B) टास्क बार पर 

C) स्टाटण मेन्यू म े

D) नेटवकण  नेबरहुड म े

Answer- (a) रीसाइककल क्तबन म े

7. कम्प्यूटर को बंद करने के क्तलए 

A) स्लाई बंद कर दतेे ह ै

B) शट डाउन डायलॉग बॉक्ट्स का प्रयोग करते ह ै

C) कम्प्यूटर को बंद नही ककया िाता 
D) इनमे से कोई नही 
Answer- (b) शट डाउन डायलॉग बॉक्ट्स का प्रयोग करते ह ै

8. क्तवण्डोि मे कट या कॉपी की गई वस्तु को प्रयोग से पूवण रखा िाता ह।ै 
A) क्तक्ट्लप बोडण 
B) कैरेक्ट्टर मैप 

C) फॉमेट पेंटर 

D) नोटपैड 

Answer- (a) क्तक्ट्लप बोडण 
9. साफ्टवेयर मे कमांड और ऑ्शन्स की सिूी होती ह।ै 
A) टाइटल बार म े

B) मेन्यू बार म े

C) टूल बार म े

D) इनमे से कोई नही 
Answer- (c) टूल बार म े

10. लप्रंट के क्तलए कौन सा मेन्यु िनुा िाता ह।ै 
A) एक्तडट 

B) फाइल 

C) टूल्स 

D) इनमे से कोई नही 
Answer- (b) फाइल 

11. उपयोगकताण दस्ताविे को िो नाम दतेा ह,ै उसे कहते ह।ै 
A) फाइल नमे 

B) यूिर नमे 

C) डाटा 
D) इनमे से कोई नही 
Answer- (a) फाइल नमे 

12. नया डॉक्ट्यूमेंट बनाने के क्तलए फाइल मेन्यू पर कमांड होता ह।ै 
A) ओपन 

B) सेव 

C) न्यू 
D) इनमे से कोई नही 
Answer- (c) न्यू 
13. फाइल एक्ट्सटेंशन इस्तमेाल ककया िाता ह।ै 
A) फाइल को नाम दनेे के क्तलए 

B) फाइल के प्रकार को पहिानन ेके क्तलए 

C) फाइल को पहिानने के क्तलए 

D) इनमे से कोई नही 
Answer- (b) फाइल के प्रकार को पहिानने के क्तलए 

14. वडण डाक्ट्यूमेंट का फाइल एक्ट्सटेंशन नाम होता ह।ै 
A) DOC 

B) TXT 

C) WRD 

D) इनमे से कोई नही 
Answer- (a) DOC 

15. िब आप अपने कम्प्यटूर मे कोई नया प्रोग्राम इंस्टाल करते ह ैतो यह 
ककस मेन्यू मे िुडता ह।ै 
A) ऑल प्रोग्राम मेन्य ू

B) स्टाटण प्रोग्राम मेन्य ू

C) क्तसलेक्ट्ट प्रोग्राम मेन्य ू

D) इनमे से कोई नही 
Answer- (a) ऑल प्रोग्राम मेन्य ू

Part – 21 

1. Microsoft Access ह ै: 
(a) RDBMS 

(b) OODBMS 

(c) ORDBMS 

(d) Network Database Model 

Correct Answer : (a) RDBMS 

2. क्तनम्न में से कौनसा Microsoft Access Database Object 

का प्रकार नहीं ह?ै 

(a) Table 

(b) Form 

(c) Worksheets 

(d) Modules 

Correct Answer : (c) Worksheets 

3. एक table में एक column में एक field को कहते हैं & 

(a) Database 

(b) Attribute 

(c) Tuple 

(d) Data 

Correct Answer : (b) Attribute 

4. Record होता ह ै– 

(a) Row 

(b) Column 
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(c) Row and column का समूह 

(d) इनमें से कोई नहीं 

Correct Answer : (a) Row 

5. एक ररलेशन में कॉलम क्तिसकी डाटा वैल्यू दसुरे ररलेशन में एक 
key column की तरह प्रयोग की िाती ह,ै क्तिसे कहते हैं – 

(a) Primary key 

(b) Composite Key 

(c) Foreign key 

(d) Candidate key 

Correct Answer : (c) Foreign key 

6. फील्ड के collection को क्ट्या कहत ेहैं 
(a) Record 

(b) Column 

(c) File 

(d) Table 

Correct Answer : (a) Record 

7. फील्ड को यूक्तनक बनाने के क्तलए ककस Key का उपयोग ककया 
िाता ह ै– 

(a) प्राइमरी की 
(b) फॉरेन की 
(c) इंडके्ट्स की 
(d) कम्पपोक्तिट की 

Correct Answer : (a) प्राइमरी की 

8. MS access में बनाये गए डटेाबेस का एक्ट्सटेंशन नेम क्ट्या 
होता ह ै

(a) .mdb 

(b) .mad 

(c) .doc 

(d) इनमे से कोई नहीं 

Correct Answer : (a) .mdb 

9. एक Tree Structure …………………-Relationship के 
रूप में स्थाक्तपत हो सकता ह ै

(a) One to one 

(b) Many to many 

(c) One to many 

(d) Many to one 

Correct Answer : (c) One to many 

10. D.B.M.S क्ट्या ह ै

(a) डटेाबेस मैनेिमेंट क्तसस्टम 

(b) डटेाबेस मेनेिर क्तसस्टम 

(c) डाटा मैनेि क्तसस्टम 

(d) इनमे से कोई नहीं 

Correct Answer : (a) डटेाबेस मैनेिमेंट क्तसस्टम 

11. ररलेशन मॉडल सम्पबंक्तधत होता ह ै

(a) डाटा स्ट्रक्ट्िर तथा डाटा इंटीक्तग्रटी 
(b) डाटा मैनीपुलेशन 

(c) दोनों 
(d) इनमें से कोई नहीं 

Correct Answer : (c) दोनों 

12. क्तनम्न में से कौनसा नेटवकण  डटेाबेस का उदाहरण ह ै

(a) Oracle 

(b) Ingress 

(c) IDMS 

(d) इनमे से कोई नहीं 

Correct Answer : (a) Oracle 

13. Hierarchical Data Model होता ह ै

(a) Partially ordered 

(b) Totally ordered 

(c) not ordered 

(d) इनमे से कोई नहीं 

Correct Answer : (a) Partially ordered 

14. डटेाबेस के ओवरआल क्तडिाईन को कहते हैं 
(a) डटेाबेस स्क्रीन 

(b) डटेाबेस स्ट्रक्ट्िर 

(c) डटेाबेस व्यू 
(d) इनमे से कोई नहीं 

Correct Answer : (b) डेटाबेस स्ट्रक्ट्िर 
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15. Boyce-codd Normal Form होता ह ै

(a) 1NF 

(b) 2NF 

(c) 3NF 

(d) 4NF 

Correct Answer : (d) 4NF 

16. Normalization का प्रथम Form ह ै

(a) First Normal Form 

(b) Second Normal Form 

(c) Fifth Normal Form 

(d) इनमे से कोई नहीं 

Correct Answer : (a) First Normal Form 

17. Functional Dependency होती ह ै

(a) First Normal Form 

(b) Second Normal Form 

(c) Third Normal Form 

(d) Fourth Normal Form 

Correct Answer : (c) Third Normal Form 

18. एक डटेाबेस टेबल में सूिना की श्रेणी को_______ कहा िाता 
ह ै

(a) Field 

(b) Tuple 

(c) File 

(d) Record 

Correct Answer : (a) Field 

19. MS Access में टेक्ट्स्ट फील्ड का क्तडफ़ॉल्ट और अक्तधकतम 
आकर ह ै

(a) 50 और 255 Characters 

(b) 8 और 1 Gb 

(c) 266 Characters और 64000 Characters 

(d) इनमे से कोई नहीं 

Correct Answer : (a) 50 और 255 Characters 

20. इनमे से कौनसा DBMS पैकेि नहीं ह ै

(a) Database 

(b) Records 

(c) Fields 

(d) File 

Correct Answer : (d) File 

21. Referential Integrity होती ह ै

(a) Table 

(b) Database 

(c) Query 

(d) उपरोि सभी 

Correct Answer : (d) उपरोि सभी 

22. एक table को कौनसी property follow करना िाक्तहए | 

(a) प्रत्येक कॉलम में अलग heading होना िाक्तहए 

(b) Duplicate Rows की entry नहीं होनी िाक्तहए 

(c) दोनों 
(d) कोई भी नहीं 

Correct Answer : (c) दोनों 

23. सभी डाटा आइटम्पस तथा ररलेशनक्तशप के मदय उनको two 

dimensional table में प्रस्तुत करना कहलाता ह ै

(a) Database 

(b) Relation 

(c) Normalization 

(d) Anomaly 

Correct Answer : (b) Relation 

24. ररलेशनक्तशप को simplify करने की प्रकक्रया को कहते हैं – 

(a) Database 

(b) Relation 

(c) Normalization 

(d) Anomaly 

Correct Answer : (c) Normalization 

25. इनमे से कौनसा Anomaly check का प्रकार नहीं ह ै

(a) Update 

(b) Delete 

(c) Select 

(d) Insert 
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Correct Answer : (c) Select 

Part – 22 

 
 

1. MS-Access में CTRL+O ककसकी शॉटणकट की ह ै

a) Open a new database 

b) Open an existing database 

c) Exit MS-Access 

d) None of these 

Correct Answer : b) Open an existing database 

2. MS Access में table को ककतने तरीके से create कर सकते 
हैं 
a) 1 

b) 2 

c) 3 

d) 4 

Correct Answer : c) 3 

3. MS Access में डाटा टाइप ककतने प्रकार का होता ह ै

a) 6 

b) 4 

c) 8 

d) 10 

Correct Answer : d) 10 

4. यह data type alphanumeric characters और 
special symbols की अनमुक्तत दतेा ह ै

a) text 

b) memo 

c) auto number 

d) None of the above 

Correct Answer : a) text 

5. एक नई table बनाने के क्तलए ककस method में आपको field 

type और size specify करने की आवश्यकता नहीं ह ै

a) Create table in Design View 

b) Create Table using wizard 

c) Create Table by Entering data 

d) All of above 

Correct Answer : c) Create Table by Entering data 

6. Number data type वाले field का आकार नहीं हो सकता 
ह ै

a)2 

b)4 

c)8 

d)16 

Correct Answer : d)16 

7. Text data type की default field size ककतनी होती ह ै

a)20 Characters 

b)25 Characters 

c)50 Characters 

d)30 Characters 

Correct Answer : c)50 Characters 

8. Yes /No field की size होती ह ै

a)1 bit 

b)1 byte 

c)1 character 

d)1 GB 

Correct Answer : a)1 bit 

9. िब एक नई table बनायीं िाती ह ैिो standard 

database और tables से fields िुनने के क्तलए इस्तेमाल ककया 
िा सकता ह ै

a) Create table in Design View 

b) Create Table using wizard 

c) Create Table by Entering data 

d) None of above 

Correct Answer : b) Create Table using wizard 

10. िब हम एक नई table बना रह ेहैं और यकद हमें ककसी फील्ड 
में long text enter करन ेकी िरुरत होगी तो ककस डाटा टाइप 
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का ियन करना होगा 
a) Text 

b) Memo 

c) Currency 

d) Hyperlink 

Correct Answer : b) Memo 

11. Text data type की maximum size ककतनी होती ह ै

a) 200 Characters 

b) 500 Characters 

c) 255 Characters 

d) 300 Characters 

Correct Answer : c) 255 Characters 

12. ककस फील्ड की width 8 bytes होती ह ै

a) Memo 

b) Number 

c) Date/Time 

d) Hyperlink 

Correct Answer : c) Date/Time 

13. Access में table को प्रदर्शणत करने का कौनसा view नहीं 
होता ह ै

a) Datasheet View 

b) Design View 

c) Pivot Table & Pivot Chart View 

d) None of above 

Correct Answer : d) None of above 

14. 255 Characters से ज्यादा डाटा स्टोर करने के क्तलए ककस 
डाटा टाइप का उपयोग ककया िाता ह ै

a) Text 

b) Memo 

c) Alphanumeric 

d) Number 

Correct Answer : b) Memo 

15. क्तनम्न में से कौनसा डाटा टाइप का उपयोग करके एक 
Dropdown list बना सकते हैं 

a) OLE Object 

b) Hyperlink 

c) Memo 

d) Lookup Wizard 

Correct Answer : d) Lookup Wizard 

16. ककसी फील्ड को Sort करने के क्तलए ककस menu का प्रयोग 
ककया िाता ह ै

a) View 

b) Records 

c) Tools 

d) Format 

Correct Answer : b) Records 

17. Microsoft Access Table में columns को क्ट्या कहा 
िाता ह ै

a) Rows 

b) Records 

c) Fields 

d) Columns 

Correct Answer : c) Fields 

18. इनमे से कौनसा filter का option ह ै

a) Filter by form 

b) Excluding Selection 

c) Filter by selection 

d) सभी 

Correct Answer : d) सभी 

19. ककसी भी column को freeze करन ेका option ककस 
menu में उपक्तस्थत होता ह ै

a) View 

b) Records 

c) Tools 

d) Format 

Correct Answer : d) Format 

20. Table में paste option होते हैं 
a) Structure Only 
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b) Structure and data 

c) Append Data to Existing 

d)उपरोि सभी 

Correct Answer : d)उपरोि सभी 

 

 

 

 

 

 

 

Part – 23 

1. MS-Access में CTRL+O ककसकी शॉटणकट की ह ै

a) Open a new database 

b) Open an existing database 

c) Exit MS-Access 

d) None of these 

Correct Answer : b) Open an existing database 

 

2. MS Access में table को ककतने तरीके से create कर सकते 
हैं 
a) 1 

b) 2 

c) 3 

d) 4 

Correct Answer : c) 3 

3. MS Access में डाटा टाइप ककतने प्रकार का होता ह ै

a) 6 

b) 4 

c) 8 

d) 10 

Correct Answer : d) 10 

4. यह data type alphanumeric characters और 
special symbols की अनमुक्तत दतेा ह ै

a) text 

b) memo 

c) auto number 

d) None of the above 

Correct Answer : a) text 

5. एक नई table बनाने के क्तलए ककस method में आपको field 

type और size specify करने की आवश्यकता नहीं ह ै

a) Create table in Design View 

b) Create Table using wizard 

c) Create Table by Entering data 

d) All of above 

Correct Answer : c) Create Table by Entering data 

6. Number data type वाले field का आकार नहीं हो सकता 
ह ै

a)2 

b)4 

c)8 

d)16 

Correct Answer : d)16 

7. Text data type की default field size ककतनी होती ह ै

a)20 Characters 

b)25 Characters 

c)50 Characters 

d)30 Characters 

Correct Answer : c)50 Characters 

8. Yes /No field की size होती ह ै

a)1 bit 

b)1 byte 
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c)1 character 

d)1 GB 

Correct Answer : a)1 bit 

9. िब एक नई table बनायीं िाती ह ैिो standard 

database और tables से fields िुनने के क्तलए इस्तेमाल ककया 
िा सकता ह ै

a) Create table in Design View 

b) Create Table using wizard 

c) Create Table by Entering data 

d) None of above 

Correct Answer : b) Create Table using wizard 

10. िब हम एक नई table बना रह ेहैं और यकद हमें ककसी फील्ड 
में long text enter करन ेकी िरुरत होगी तो ककस डाटा टाइप 
का ियन करना होगा 
a) Text 

b) Memo 

c) Currency 

d) Hyperlink 

Correct Answer : b) Memo 

11. Text data type की maximum size ककतनी होती ह ै

a) 200 Characters 

b) 500 Characters 

c) 255 Characters 

d) 300 Characters 

Correct Answer : c) 255 Characters 

12. ककस फील्ड की width 8 bytes होती ह ै

a) Memo 

b) Number 

c) Date/Time 

d) Hyperlink 

Correct Answer : c) Date/Time 

13. Access में table को प्रदर्शणत करने का कौनसा view नहीं 
होता ह ै

a) Datasheet View 

b) Design View 

c) Pivot Table & Pivot Chart View 

d) None of above 

Correct Answer : d) None of above 

14. 255 Characters से ज्यादा डाटा स्टोर करने के क्तलए ककस 
डाटा टाइप का उपयोग ककया िाता ह ै

a) Text 

b) Memo 

c) Alphanumeric 

d) Number 

Correct Answer : b) Memo 

15. क्तनम्न में से कौनसा डाटा टाइप का उपयोग करके एक 
Dropdown list बना सकते हैं 
a) OLE Object 

b) Hyperlink 

c) Memo 

d) Lookup Wizard 

Correct Answer : d) Lookup Wizard 

16. ककसी फील्ड को Sort करने के क्तलए ककस menu का प्रयोग 
ककया िाता ह ै

a) View 

b) Records 

c) Tools 

d) Format 

Correct Answer : b) Records 

17. Microsoft Access Table में columns को क्ट्या कहा 
िाता ह ै

a) Rows 

b) Records 

c) Fields 

d) Columns 

Correct Answer : c) Fields 

18. इनमे से कौनसा filter का option ह ै

a) Filter by form 
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b) Excluding Selection 

c) Filter by selection 

d) सभी 

Correct Answer : d) सभी 

19. ककसी भी column को freeze करन ेका option ककस 
menu में उपक्तस्थत होता ह ै

a) View 

b) Records 

c) Tools 

d) Format 

Correct Answer : d) Format 

20. Table में paste option होते हैं 
a) Structure Only 

b) Structure and data 

c) Append Data to Existing 

d)उपरोि सभी 

Correct Answer : d)उपरोि सभी 

 

 

 

 

 

 

 

 

Part – 24 

1- Access में Queries का उपयोग कर सकते हैं – 

a) डाटा को अलग – अलग तरीकों स ेदखेन,े बदलाव करन ेतथा 
क्तवशे्लषण करने के क्तलए 

b) Form और Reports के क्तलए ररकॉडण का एक source 

c) क्तसफण  a 

d) a और b दोनों 

Correct Answer : d) a और b दोनों 

2- Access में query create करने के क्तलए – 

a) आप फील्ड को query builders पर drag and drop कर 
सकते हैं 
b) आप SQL view में SQL command type कर सकते हैं 
c) आप query wizard या design view का उपयोग कर सकते 
हैं 
d) सभी 

Correct Answer : d) सभी 

3- Query design window के दो क्तहस्से होते हैं – ऊपर वाले 
क्तहस्से में होते हैं | 

a) फील्ड का नाम, फील्ड का प्रकार और आकार 

b) Tables के बीि फील्ड और Relationship के साथ Tables 

c) Criteria 

d) Sorting check boxes 

Correct Answer : b) Tables के बीि फील्ड और 
Relationship के साथ Tables 

4- Query design window में कदखने वाला check box क्ट्या 
indicate करता ह ै

a) यह indicate करता ह ैकक क्ट्या इस फील्ड का प्रयोग ककया 
िाना ह ैया नहीं 
b) यह indicate करता ह ैकक क्ट्या फील्ड को query result को 
प्रदर्शणत करना ह ैया नहीं 
c) यह indicate करता ह ैकक क्ट्या फील्ड नामों को query 

result में प्रदर्शणत ककया िाये या नहीं 
d) इनमे से कोई नहीं 

Correct Answer : b) यह indicate करता ह ैकक क्ट्या फील्ड 
को query result को प्रदर्शणत करना ह ैया नहीं 

5- आप के्री क्तडिाईन लवंडो में एक टेबल कैसे िोड़ सकत ेहैं 
a) Select Edit>Add Table from the menu 

b) Select Tools>Add table from the menu 

c) Click the Show Table button on the toolbar 
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d) Select the table from the Table list on the 

toolbar 

Correct Answer : d) Select the table from the Table 

list on the toolbar 

6- इनमे से कौनसा ररलेशनक्तशप Access database में apply 

नहीं कर सकते हैं 
a) One to One 

b) One to Many 

c) Many to Many 

d) उपयुणि में से कोई नहीं 

Correct Answer : d) उपयुणि में से कोई नहीं 

7- दो table के बीि ररलेशनक्तशप create करन ेके क्तलए – 

a) ककसी table की primary key को दसूरी table के foreign 

key में drag करें 
b) ककसी table की foreign key को दसूरी table के primary 

key में drag करें 
c) Parent table में ककसी टेबल को drag करें और child 

table पर drop करें 
d) Relationship बनाने के क्तलए उपयुणि कोई भी ककया िा 
सकता ह ै

Correct Answer : a) ककसी table की primary key को 
दसूरी table के foreign key में drag करें 

8- Student और Class table के बीि one to many 

relationship का क्ट्या अथण होता ह ै– 

a) एक student की कई सारी classes 

b) एक class में कई student हो सकते हैं 
c) कई classes में कई student हो सकते हैं 
d) कई students की कई सारी classes हो सकती ह ै

Correct Answer : a) एक student की कई सारी classes 

9- One-to-many relationship में table में ‘one’ side 

___ कहलाता ह ैऔर ‘many’ side __ कहलाता ह ै| 

a) Child , Parent 

b)Parent , Child 

c) Brother , Sister 

d) Father , Son 

Correct Answer : b)Parent , Child 

10- हम दो टेबल के बीि बनाये गए ररलेशनक्तशप को हटा सकत ेहैं 
– 

a) Edit menu से Delete Relationship िुनना 
b) relationship line का ियन करें और Delete दबाए ँ

c) Relationship menu से Delete option का ियन करें 
d) All of above 

Correct Answer : b) relationship line का ियन करें और 
Delete दबाए ँ

11- यकद आप ररलेशनक्तशप को edit करना िाहते हैं तो – 

a) relationship line पर राईट क्तक्ट्लक करें और edit 

relationship िुन े

b) relationship line पर Double click करें 
c) Both of above 

d) None of above 

Correct Answer : c) Both of above 

12- Filter में आ्शन होते हैं 
a) Filter by form 

b) Filter by selection 

c) Filter excluding selection 

d) उपरोि सभी 

Correct Answer : d) उपरोि सभी 

13- Relationship संभव होती ह ै– 

a) एक टेबल के अन्दर Field में 
b) दो table के मदय 

c) A तथा B दोनों 
d) इनमे से कोई नहीं 

Correct Answer : b) दो table के मदय 

14- Queries create होती ह ै

a) Filter स े

b) Table से 
c) A तथा B दोनों 
d) इनमे से कोई नहीं 

Correct Answer : b) Table से 
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15- AND OR operation specify होत ेहैं 
a) Field में 
b) Criteria में 
c) sort में 
d) इनमे से कोई नहीं 

Correct Answer : b) Criteria में 

1- Access में Queries का उपयोग कर सकते हैं – 

a) डाटा को अलग – अलग तरीकों स ेदखेन,े बदलाव करन ेतथा 
क्तवशे्लषण करने के क्तलए 

b) Form और Reports के क्तलए ररकॉडण का एक source 

c) क्तसफण  a 

d) a और b दोनों 

Correct Answer : d) a और b दोनों 

2- Access में query create करने के क्तलए – 

a) आप फील्ड को query builders पर drag and drop कर 
सकते हैं 
b) आप SQL view में SQL command type कर सकते हैं 
c) आप query wizard या design view का उपयोग कर सकते 
हैं 
d) सभी 

Correct Answer : d) सभी 

3- Query design window के दो क्तहस्से होते हैं – ऊपर वाले 
क्तहस्से में होते हैं | 

a) फील्ड का नाम, फील्ड का प्रकार और आकार 

b) Tables के बीि फील्ड और Relationship के साथ Tables 

c) Criteria 

d) Sorting check boxes 

Correct Answer : b) Tables के बीि फील्ड और 
Relationship के साथ Tables 

4- Query design window में कदखने वाला check box क्ट्या 
indicate करता ह ै

a) यह indicate करता ह ैकक क्ट्या इस फील्ड का प्रयोग ककया 
िाना ह ैया नहीं 
b) यह indicate करता ह ैकक क्ट्या फील्ड को query result को 
प्रदर्शणत करना ह ैया नहीं 

c) यह indicate करता ह ैकक क्ट्या फील्ड नामों को query 

result में प्रदर्शणत ककया िाये या नहीं 
d) इनमे से कोई नहीं 

Correct Answer : b) यह indicate करता ह ैकक क्ट्या फील्ड 
को query result को प्रदर्शणत करना ह ैया नहीं 

5- आप के्री क्तडिाईन लवंडो में एक टेबल कैसे िोड़ सकत ेहैं 
a) Select Edit>Add Table from the menu 

b) Select Tools>Add table from the menu 

c) Click the Show Table button on the toolbar 

d) Select the table from the Table list on the 

toolbar 

Correct Answer : d) Select the table from the Table 

list on the toolbar 

6- इनमे से कौनसा ररलेशनक्तशप Access database में apply 

नहीं कर सकते हैं 
a) One to One 

b) One to Many 

c) Many to Many 

d) उपयुणि में से कोई नहीं 

Correct Answer : d) उपयुणि में से कोई नहीं 

7- दो table के बीि ररलेशनक्तशप create करन ेके क्तलए – 

a) ककसी table की primary key को दसूरी table के foreign 

key में drag करें 
b) ककसी table की foreign key को दसूरी table के primary 

key में drag करें 
c) Parent table में ककसी टेबल को drag करें और child 

table पर drop करें 
d) Relationship बनाने के क्तलए उपयुणि कोई भी ककया िा 
सकता ह ै

Correct Answer : a) ककसी table की primary key को 
दसूरी table के foreign key में drag करें 

8- Student और Class table के बीि one to many 

relationship का क्ट्या अथण होता ह ै– 

a) एक student की कई सारी classes 

b) एक class में कई student हो सकते हैं 
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c) कई classes में कई student हो सकते हैं 
d) कई students की कई सारी classes हो सकती ह ै

Correct Answer : a) एक student की कई सारी classes 

9- One-to-many relationship में table में ‘one’ side 

___ कहलाता ह ैऔर ‘many’ side __ कहलाता ह ै| 

a) Child , Parent 

b)Parent , Child 

c) Brother , Sister 

d) Father , Son 

Correct Answer : b)Parent , Child 

10- हम दो टेबल के बीि बनाये गए ररलेशनक्तशप को हटा सकत ेहैं 
– 

a) Edit menu से Delete Relationship िुनना 
b) relationship line का ियन करें और Delete दबाए ँ

c) Relationship menu से Delete option का ियन करें 
d) All of above 

Correct Answer : b) relationship line का ियन करें और 
Delete दबाए ँ

11- यकद आप ररलेशनक्तशप को edit करना िाहते हैं तो – 

a) relationship line पर राईट क्तक्ट्लक करें और edit 

relationship िुन े

b) relationship line पर Double click करें 
c) Both of above 

d) None of above 

Correct Answer : c) Both of above 

12- Filter में आ्शन होते हैं 
a) Filter by form 

b) Filter by selection 

c) Filter excluding selection 

d) उपरोि सभी 

Correct Answer : d) उपरोि सभी 

13- Relationship संभव होती ह ै– 

a) एक टेबल के अन्दर Field में 
b) दो table के मदय 

c) A तथा B दोनों 
d) इनमे से कोई नहीं 

Correct Answer : b) दो table के मदय 

14- Queries create होती ह ै

a) Filter स े

b) Table से 
c) A तथा B दोनों 
d) इनमे से कोई नहीं 

Correct Answer : b) Table से 

15- AND OR operation specify होत ेहैं 
a) Field में 
b) Criteria में 
c) sort में 
d) इनमे से कोई नहीं 

Correct Answer : b) Criteria में 

Part – 25 

1- Tabular और ___ form layout के ऐसे प्रकार हैं िो एक ही 
समय में एक से ज्यादा ररकॉडण प्रदर्शणत करते हैं | 

a) Columnar 

b) justified 

c) date sheet 

d) pivot table 

Correct Answer : b) justified 

2- Form ककतने प्रकार के होते हैं 
a) 2 

b) 6 

c) 3 

d) 4 

Correct Answer : d) 4 

3- इनमे से कौनसा कथन सत्य ह ै| 

a) फॉमण इनपुट के क्तलए प्रयोग ककये िाते हैं 
b) फॉमण Program even drives होते हैं 
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c) फॉमण में multiple fields की गणना कर सकते हैं 
d) सभी 

Correct Answer : d) सभी 

4- इनमे से कौनसा Form Layout नहीं ह ै| 

a) Tabular 

b) Datasheet 

c) Web Layout 

d) Justified 

Correct Answer : c) Web Layout 

5- MS Access में Form को create करने के ककतने mode 

होते हैं 
a) 2 

b) 1 

c) 3 

d) 4 

Correct Answer : a) 2 

6. Form में first record प्रदर्शणत करने की शॉटणकट की क्ट्या 
होती ह ै

a) Shift + Home 

b) Ctrl + Home 

c) Alt + Home 

d) Alt + Shift + Home 

Correct Answer : b) Ctrl + Home 

7- ………… Property Object के तरीके को प्रदर्शणत करने के 
क्तलए set की िाती ह ै

a) Data 

b) Format 

c) Event 

d) Other 

Correct Answer : b) Format 

8- Combo box क्तडिाईन होता ह ै

a)Table में 
b) Query में 

c) Formमें 
d) उपयुणि सभी में 

Correct Answer : c) Formमें 

9- Sub Form होता ह ै– 

a) Current form के साथ दसूरा फॉमण 
b) अलग से एक फॉमण 
c) Table Form 

d) उपयुणि में से कोई नहीं 

Correct Answer : a) Current form के साथ दसूरा फॉमण 

1- Tabular और ___ form layout के ऐसे प्रकार हैं िो एक ही 
समय में एक से ज्यादा ररकॉडण प्रदर्शणत करते हैं | 

a) Columnar 

b) justified 

c) date sheet 

d) pivot table 

Correct Answer : b) justified 

2- Form ककतने प्रकार के होते हैं 
a) 2 

b) 6 

c) 3 

d) 4 

Correct Answer : d) 4 

3- इनमे से कौनसा कथन सत्य ह ै| 

a) फॉमण इनपुट के क्तलए प्रयोग ककये िाते हैं 
b) फॉमण Program even drives होते हैं 
c) फॉमण में multiple fields की गणना कर सकते हैं 
d) सभी 

Correct Answer : d) सभी 

4- इनमे से कौनसा Form Layout नहीं ह ै| 

a) Tabular 

b) Datasheet 

c) Web Layout 

d) Justified 
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Correct Answer : c) Web Layout 

5- MS Access में Form को create करने के ककतने mode 

होते हैं 
a) 2 

b) 1 

c) 3 

d) 4 

Correct Answer : a) 2 

6. Form में first record प्रदर्शणत करने की शॉटणकट की क्ट्या 
होती ह ै

a) Shift + Home 

b) Ctrl + Home 

c) Alt + Home 

d) Alt + Shift + Home 

Correct Answer : b) Ctrl + Home 

7- ………… Property Object के तरीके को प्रदर्शणत करने के 
क्तलए set की िाती ह ै

a) Data 

b) Format 

c) Event 

d) Other 

Correct Answer : b) Format 

8- Combo box क्तडिाईन होता ह ै

a)Table में 
b) Query में 
c) Formमें 
d) उपयुणि सभी में 

Correct Answer : c) Formमें 

9- Sub Form होता ह ै– 

a) Current form के साथ दसूरा फॉमण 
b) अलग से एक फॉमण 
c) Table Form 

d) उपयुणि में से कोई नहीं 

Correct Answer : a) Current form के साथ दसूरा फॉमण 

10- List box control प्रयोग होता ह ै

a) Single selection के क्तलए 

b) Multiple list के क्तलए 

c) Editing के क्तलए 

d) इनमे स एकोई नहीं 

Correct Answer : a) Single selection के क्तलए 

11- क्तनम्नक्तलक्तखत में Form type ह ै

a) Data Sheet 

b) Justify 

c) Tabular 

d) सभी 

Correct Answer : d) सभी 

12- इनमे से ककस control का उपयोग करके Dropdown list 

बना सकते ह ै

a) List Box 

b) Command Button 

c) Combo Box 

d) इनमे से कोई नहीं 

Correct Answer : c) Combo Box 

13- डाटा एटं्री करन ेके क्तलए ककस कण्ट्रोल का उपयोग होता ह ै

a) Toggle Button 

b) Option Group 

c) Text box 

d) Label 

Correct Answer : c) Text box 

14- Multiple pages को प्रदर्शणत करने के क्तलए ककस कण्ट्रोल 
का उपयोग ककया िाता ह ै

a) Bound Object Frame 

b) Combo box 

c) Tab 

d) Rectangle 

Correct Answer : c) Tab 

15- इनमे से कौनसा लेआउट डाटा को फील्ड के रूप में प्रदर्शणत 
करता ह ै
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a) Tabular 

b) Columns 

c) Justified 

d) Datasheet 

Correct Answer : a) Tabular 

16- सूिना को टेबल में प्रदर्शणत करन ेके क्तलए ककस लेआउट का 
उपयोग ककया िाता ह ै

a) Tabular 

b) Columns 

c) Justified 

d) Datasheet 

Correct Answer : a) Tabular 

17- First Record प्रदर्शणत करन ेकी shortcut key क्ट्या होती 
ह ै

a) shift+Home 

b) ctrl+Home 

c) ctrl+shift+Home 

d) Window+ Home 

Correct Answer : b) ctrl+Home 

18- इनमे से ककस कण्ट्रोल का प्रयोग Bitmap image को 
प्रदर्शणत करने के क्तलए ककया िाता ह ै

a) Image 

b) Bound Object Frame 

c) Picture box 

d) Unbound object 

Correct Answer : a) Image 

19- …………– कण्ट्रोल message को प्रदर्शणत करन ेके क्तलए 
ककया िाता ह ै

a) Text box 

b) List box 

c) Label 

d) Checkbox 

Correct Answer : c) Label 

20- Multiple Toggle Buttons] Option Buttons या 
Check boxes का combination एक —————— होता 
ह ै

a) Option Group 

b) Command Button 

c) Subform 

d) Unbound object 

Correct Answer : a) Option Group 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. ककसी Function के अन्दर लग ेहुए फंक्ट्शन को कहत ेह ै| 

a) Nested Function 

b) Round Function 

c) Sum Function 

d) Text Function 

Answer – (a) Nested Function 

2. एक्ट्सले में Formula स्टाटण करत ेह ै 

a) % 
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b) = 

c) + 

d) <> 

Answer – (b) = 

3. यकद आप worksheet में Title के बाद एक खाली लाइन 
िाहत ेह ैतो इनम ेस ेकौनसा तरीका सबस ेअच्छा रहगेा | 

a) Re-Format the spreadsheet 

b) Insert the Row 

c) Increase the column Width 

d) Use the Space bar 

Answer – (b) Insert the Row 

 

 

 

 

 

 

 

 

 

 

 

 

Part – 26 

 

 

4. इनम ेस ेसही Syntex ह ै| 

a) =IF(LogicalTest, TrueResult, FalseResult) 

b) =IF(LogicalTest, (TrueResult, FalseResult)) 

c) =IF(LogicalTest, TrueResult) (LogicalTest, 

FalseResult) 

d) =IF(LogicalTest, TrueResult), IF(LogicalTest, 

FalseResult) 

Answer – (a) =IF(LogicalTest, TrueResult, 

FalseResult) 

5. “New Comment” option …………tab में पाया िाता 
ह ै| 

a) insert 

b) Data 

c) review 

d) View 

Answer – (c) review 

6. Current Workbook में New sheet insert करन ेकी 
शॉटणकट की ह ै| 

a) F11 

b) Ctrl + F11 

c) Shift + F11 

d) Alt + F11 

Answer – (c) Shift + F11 

7. आप Excel sheet में Gridlines को कैस ेकदखा या छुपा 
सकत ेह ै| 

a) Tools – Options – View tab में िा के Gridline बॉक्ट्स 
को माकण  या अनमाकण  करके 

b) Forms Toolbar में Gridline tool पर click करके | 

c) अ. और ब. दोनों | 

d) इनमे से कोई नहीं | 

Answer – (c) अ. और ब. दोनों | 

8. Excel में Current cell का address ………….. में 
कदखाई दतेा ह ै| 

a) Formula bar 

b) Status bar 

c) Name Box 

d) Tilte bar 

Answer – (c) Name Box 
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9. Worksheet में Hyperlink add करन ेकी शॉटणकट की ह ै
| 

a) Alt + K 

b) Ctrl + H 

c) Ctrl + K 

d) Shift + Ctrl + K 

Answer – (c) Ctrl + K 

10. इनम ेस ेकौनसा कथन सही नहीं ह ै| 

a) आप Excel sheet में ग्राफ बना सकते ह ै| 

b) Excel sheet का extention .doc होता ह ै| 

c) नयी workbook को book 1 कहते ह ै| 

d) इनमे से कोई नहीं | 

Answer – (b) Excel sheet का extention .doc होता ह ै| 

11. Row और column के उभयक्तनष्ठ लबदं ुको कहत ेह ै| 

a) pixel 

b) cell 

c) 0 

d) Track 

Answer – (b) cell 

12. Spreadsheet को …………… की तरह use कर सकत ेह ै
| 

a) Finance Professionals 

b) Engineers 

c) Stoke Brokers 

d) ये सभी | 

Answer – (d) ये सभी | 

13. cell की range को दशाणन ेके क्तलए excel में …………. का 
use करत ेह ै| 

a) Semicolon 

b) Comma 

c) Colon 

d) Dot 

Answer – (c) Colon 

14. Format cell के डायलॉग बॉक्ट्स को ओपन करन ेके क्तलए 
………… की को दबात ेह ै| 

a) Alt + 1 

b) Ctrl + 1 

c) Ctrl + Shift + 1 

d) इनमे से कोई नहीं 
Answer – (b) Ctrl + 1 

15. वह प्रोग्रालमगं लैंग्विे क्तिसम ेExcel macro कोड को 
Record रखता ह ै| 

a) Java 

b) Visual Basic 

c) Basic 

d) Video Basic 

Answer – (b) Visual Basic 

Part – 27 

 

1. MS-Excel में आप Spreadsheet को …………….क्तवक्तभन्न 
भागो में क्तवभाक्तित कर सकत ेह ै| 

a) Horizontol 

b) Vertically 

c) Freeze 

d) ये सभी | 

Answer – (d) ये सभी | 

2. इनम ेस ेकौनसा मने ूoption एक्ट्सले में text को 
Cut,Copy,Paste,Delete करन ेके क्तलए use ककया िाता ह ै
| 

a) Edit menu 

b) File menu 

c) Tool menu 

d) Format menu 

Answer – (a) Edit menu 

3. Excel फाइल का क्तडफ़ॉल्ट Extention होता ह ै| 

a) .XLS 

b) .XLW 

c) .WK1 

d) .123 

Answer – (a) .XLS 

4. MS Excel में दो Worksheet को एक ही समय पर खोलन े
के क्तलए इस key का use करत ेह ै| 

a) Alt + O + 2 

b) Ctrl + O + 2 
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c) Alt + W + 2 

d) Ctrl + W + 2 

Answer – (c) Alt + W + 2 

5. एक work sheet में अक्तधकतम Row होती ह ै 

a) 256 

b) 1024 

c) 65536 

d) 32000 

Answer – (c) 65536 

6. हर एक Excel File को workbook भी कहत ेह ैक्ट्योंकक  

a) यह डटेा और टेक्ट्स्ट को रख सकती ह ै| 

b) इसे Modify ककया िा सकता ह ै| 

c) यह बहुत सी सीटों िैसे Work sheet और Chart sheet से 
क्तमलकर बनती ह ै| 

d) इसे बनाने में Hard work करना पड़ता ह ै| 

Answer – (c) यह बहुत सी सीटों िैसे Work sheet और 
Chart sheet से क्तमलकर बनती ह ै| 

7. रेंि G2 स ेM12 के क्तलए cell reference होगा | 

a) G2.M12 

b) G2;M12 

c) G2:M12 

d) G2-M12 

Answer – (c) G2:M12 

8. ककसी वकणशीट में क्तडफ़ॉल्ट रूप में Header होता ह ै| 

a) User Name 

b) Date and time 

c) sheet tab name 

d) None 

Answer – (d) None 

9. Select की गयी range में chart बनान ेके क्तलए कीबोडण की 
shortcut की होती ह ै| 

a) F2 

b) F4 

c) F8 

d) F11 

Answer – (d) F11 

10. Status indicators……………में लोकेट होता ह ै| 

a) Vertical Scroll bar 

b) Horizontal Scroll bar 

c) Formula bar 

d) Standerd tool bar 

Answer – (c) Formula bar 

11. एक worksheet स ेक्तसलके्ट्टेड range के डटेा को दसूरी 
worksheet में ड्रैग करन ेके क्तलए …………. key का use 

करत ेह ै 

a) Tab 

b) Alt 

c) Shift 

d) Ctrl 

Answer – (d) Ctrl 

12. Column D व E के बीि में एक और column को 
insert करन ेके क्तलए आप ककस Coulmn को select करेंग े| 

a) select coulmn E 

b) select coulmn D 

c) select coulmn E , F , G 

d) select coulmn D, E , F 

Answer – (a) select coulmn E 

13. Qtr 1, Qtr 2, Qtr 3 is an example of a 

………….. 
a) Formula 

b) Function 

c) Series 

d) Syntax 

Answer – (c) Series 

14. इसमें स ेFormula का Example ह ै| 

a) = A1+A2 

b) = add(A1:A2) 

c) A1+A2 

d) Sum(A1:A2) 

Answer – (a) = A1+A2 

15. इनम ेस ेकौनसा excel में Zoom percentage नहीं ह ै| 

a) 10 

b) 100 

c) 300 
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d) 500 

Answer – (d) 500 

 

1. इनमें स ेकौनसा powerpoint का view नहीं ह ै| 

a) Slide Show view 

b) Slide view 

c) Presentation view 

d) Outline view 

Answer – (d) Outline view 

2. Slide Transition क्ट्या ह ै| 

a) Overhead 

b) letters 

c) एक क्तवशेष प्रभाव िो slide show में slide को 
introdused करने के क्तलए use ककया िाता ह ै

d) slide को delete करने का तरीका | 

Answer – (c) एक क्तवशेष प्रभाव िो slide show में slide को 
introdused करने के क्तलए use ककया िाता ह ै

3. क्तवक्तभन्न slides में motion effect लाग ूकरन ेके क्तलए आप 
पॉवर पॉइंट का कौनसा फीिर use करेंग े| 

a) slide transition 

b) slide Design 

c) Animation object 

d) Animation Scheme 

Answer – (d) Animation Scheme 

4. presentation में ककसी slide के क्तलए custom timing 

सटे करन ेके क्तलए आप इस option का use कर सकत ेह ै|  

a) Slider timings 

b) Slider timer 

c) Rehearsal 

d) Slide Show Setup 

Answer – (c) Rehearsal 

5. आप कैस ेककसी Presentation में chart को रख सकत ेह ै| 

a) Edit – Chart 

b) Insert – Picture – Chart 

c) Insert – Chart 

d) View – Chart 

Answer – (b) Insert – Picture – Chart 

6. Current Presentation में नयी slide insert करन ेकी 
शॉटणकट key ह ै| 

a) Ctrl + O 

b) Ctrl + M 

c) Ctrl + N 

d) Ctrl + F 

Answer – (b) Ctrl + M 

7. Powerpoint Presentation में क्तडफ़ॉल्ट Extention 

होता ह ै| 

a) .PPO 

b) .PPT 

c) .PPP 

d) .PPE 

Answer – (b) .PPT 

8. इनमें स ेकौनसा view पॉवर पॉइंट में slide के क्तलए 
Speaker Notes बनान ेमें ककया िाता ह ै| 

a) Slide Note 

b) Short Notes 

c) Sound Note 

d) Notes View 

Answer – (d) Notes View 

9. क्तनम्न में स ेकौनसा Power point में Shadow, title 

text और boxes का कलर बदलन ेकी सकु्तबधा प्रदान करता ह ै| 

a) Color schemes 

b) Drawing tools 

c) Text tools 

d) Background color 

Answer – (a) Color schemes 

10. आप slide show को कैस ेरोक सकत ेह ै| 

a) Delete बटन को दबाकर | 

b) Esc बटन को दबाकर | 

c) Right arrow को दबाकर | 

d) Left arrow को दबाकर | 

Answer – (b) Esc बटन को दबाकर | 

11. …………….. task pane उस Design को show करती 
ह ैिो वतणमान में presentation में use हो रही होती ह ै| 

a) slide show 

b) slide style 
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c) slide design 

d) slide format 

Answer – (c) slide design 

12. ककसी slide में table को कैस ेinsert करत ेह ै| 

a) table menu – insert table 

b) blank slide के content pane में insert slide पर click 

करते ह ै| 

c) अ. और ब. दोनों | 

d) table को slide में insert नहीं ककया िा सकता | 

Answer – (c) अ. और ब. दोनों | 

13. ‘Hide slide’ option का क्ट्या use ह ै| 

a) Presentation के दौरान select की गयी slide को hide 

करने के क्तलए | 

b) Editing के दौरान select की गयी slide को hide करने के 
क्तलए | 

c) Printing के दौरान select की गयी slide को hide करने के 
क्तलए | 

d) Deleting के दौरान select की गयी slide को hide करने के 
क्तलए | 

Answer – (a) Presentation के दौरान select की गयी 
slide को hide करने के क्तलए | 

14. Hendout Master द्वारा define ककया िाता ह ै| 

a) slide formating 

b) slide transaction 

c) layout of hendout 

d) layout of slide 

Answer – (c) layout of hendout 

15. इनम ेस ेकौनसा slide के background की तरह use 

ककया िा सकता ह ै| 

a) Gradient 

b) Taxture 

c) Picture 

d) ये सभी | 

Answer – (d) ये सभी | 

Part – 28 

 

1.ऑपरेटटंग क्तसस्टम ककस ककस्म का सॉफ्टवेयर ह।ै 

A) एक्त्लकेशन सॉफ्टवेयर 

B) क्तसस्टम सॉफ्टवेयर 

C) इंटरक्तक्ट्टव सॉफ्टवेयर 

D) एक्तक्ट्टव सॉफ्टवेयर 

Correct Answer : B) क्तसस्टम सॉफ्टवेयर 

2.कम्प्यूटर ससंाधनो मेमोरी, प्रोसेसर, फाइल क्तसस्टम और इनपुट / 
आउटपुट क्तडवाइस का प्रभावी प्रबंधन करन ेवाला क्तसस्टम 
सॉफ्टवेयर क्ट्या कहलाता ह।ै 

A) कमांड क्तसस्टम 

B) मैनेिमेंट क्तसस्टम 

C) ऑपरेटटंग क्तसस्टम 

D) कोरपोरेट क्तसस्टम 

Correct Answer : C) ऑपरेटटंग क्तसस्टम 

3.कम्प्यूटर क्तसस्टम को संिाक्तलत करने के क्तलये सबसे ज्यादा िरूरी 
क्ट्या ह।ै 

A) कमांड क्तसस्टम 

B) मैनेिमेंट क्तसस्टम 

C) ऑपरेटटंग क्तसस्टम 

D) कोरपोरेट क्तसस्टम 

Correct Answer : C) ऑपरेटटंग क्तसस्टम 

4.आपरेटटंग क्तसस्टम हाडणवेअर और उपयोक्तगता के बीि ककसका 
काम काम करता ह।ै 

A) ललंक 

B) कनेक्तक्ट्टक्तवटी 



                                     RSIT-RUDRA-SOFTECH INSTITUTE OF TECHNOLOGY UMARIA(KARKELI)                           Page 38 of 62 

 

 

C) इंटरफेस 

D) माडल 

Correct Answer : C) इंटरफेस 

5.ऑपरेटटंग क्तसस्टम का प्राथक्तमक उद्दशे्य क्ट्या ह।ै 

A) कम्प्यूटर को सहि इस्तेमाल लायक बनाना और हाडणवअेर का 
दक्षतापूणण उपयोग 

B) मेमोरी बढाना 

C) फाइल प्रबंधन 

D) संदशे दनेा 

Correct Answer : A) कम्प्यूटर को सहि इस्तेमाल लायक बनाना 
और हाडणवेअर का दक्षतापूणण उपयोग 

6.क्तसस्टम कॉल क्ट्या करता ह।ै 

A) िलते हुए प्रोग्राम और ऑपरेटटंग क्तसस्टम के बीि इंटरफेस का 
काम 

B) क्तसस्टम को बुलाता ह।ै 

C) क्तसस्टम को िलाता ह।ै 

D) इनमे से कोई नही 

Correct Answer : A) िलते हुए प्रोग्राम और ऑपरेटटंग क्तसस्टम के 
बीि इंटरफेस का काम 

7.यूिर प्रोग्राम ककसके द्वारा ऑपरेटटंग क्तसस्टम की सेवाए प्राप्त 
करता ह।ै 

A) कंपाइलर 

B) लोडर 

C) क्तसस्टम कॉल के समूह 

D) इनमे से कोई नही 

Correct Answer : C) क्तसस्टम कॉल के समूह 

8.उपयोिा क्तसस्टम कॉल के अलावा और ककसकी मदद स े
ऑपरेटटंग क्तसस्टम से इंटरएक्ट्ट कर सकता ह।ै 

A) सोसण फाइल 

B) डके्तस्टनेशन फाइल 

C) ऑपरेटटंग क्तसस्टम कमांड 

D) प्रोसेसर 

Correct Answer : C) ऑपरेटटंग क्तसस्टम कमांड 

9.सीररयल प्रोसेलसंग के बारे मे कौन सी बात असत्य ह।ै 

A) एक्तडटर यूिर प्रोग्राम का सोसण कोड बनाता ह।ै 

B) ट्रांसलेटर सोसण कोड को बाइनरी कोड मे बदलता ह।ै 

C) लोडर प्रोग्राम को मेन मेमोरी मे लोड करता ह।ै 

D) यकद क्तसनटैक्ट्स एरर का पता िलता ह ैतो पूरी प्रकक्रया को कफर 
शुरू करन ेकी िरूरत नही पडती ह।ै 

Correct Answer : D) यकद क्तसनटैक्ट्स एरर का पता िलता ह ैतो 
पूरी प्रकक्रया को कफर शुरू करने की िरूरत नही पडती ह।ै 

10.बैि प्रोसेलसंग के बारे मे कौन सी बात असत्य ह।ै 

A) एक समयावक्तध मे डाटा संग्रह ककया िाता ह।ै 

B) यकद अवक्तध घंटे, कदन या महीने मे हो सकती ह।ै 

C) प्राप्त डाटा के संपूणण संग्रह को कम्प्यूटर मे फीड कर कदया िाता 
ह।ै 

D) सारे डाटा को कम्प्यूटर म ेफीड नही ककया िाता ह।ै 

Correct Answer : D) सारे डाटा को कम्प्यूटर मे फीड नही ककया 
िाता ह।ै 

11.बफटरंग और स्पूललंग दोनो ओवरलैलपंग करने की एक प्रणाली 
ह।ै इनमे संबंक्तधत कौन सा तथ्य असत्य ह।ै 
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A) बफटरंग के अंतगणत एक बार मे एक ही काम की प्रोसेलसंग, 

इनपुट या आउटपुट की ओवरलैलपंग संभव ह।ै 

B) स्पूललंग के अंतगणत एक साथ दो काम मुमककन ह।ै स्पूलर एक 
और एक काम के इनपूट को पढता ह।ै तो दसूरी ओर काम के 
आउअपुट को लपं्रट भी करता ह।ै 

C) स्पूललंग का पूणण रूप ह ैसाइमलटेक्तनयस पेररफेरल आपरेशन आन 
लाइन । 

D) स्पूलर स्कैलनंग का काम करने मे सक्षम होता ह।ै 

Correct Answer : D) स्पूलर स्कैलनंग का काम करने मे सक्षम 
होता ह।ै 

12.िब कम्प्यूटर की मेन मेमोरी मे एक स ेअक्तधक प्रोग्राम िलते ह ै
तब इस कक्रया को क्ट्या कहते ह।ै 

A) स्पूललंग 

B) बफटरंग 

C) मल्टी प्रोग्रालमंग 

D) सीररयल प्रोसेलसंग 

Correct Answer : C) मल्टी प्रोग्रालमंग 

13.टास्क क्ट्या ह।ै 

A) प्रोग्राम की िलती हुई क्तस्थक्तत 

B) कम्प्यूटर का सबक 

C) कम्प्यूटर का काम 

D) इनमे से कोई नही 

Correct Answer : A) प्रोग्राम की िलती हुई क्तस्थक्तत 

14.कौन सा ऑपरेटटंग क्तसस्टम एक साथ दो या इससे अक्तधक टास्क 
को संपन्न करन मे मदद करता ह।ै 

A) मल्टी यूिर 

B) रीयल टाइल 

C) मल्टी टालस्कंग 

D) टाईम शेयटरंग 

Correct Answer : C) मल्टी टालस्कंग 

15.ककस ऑपरेटटंग क्तसस्टम के अंतगणत दो या इससे अक्तधक टर्मणनल 
प्रयुि होते ह।ै 

A) मल्टी यूिर 

B) रीयल टाइल 

C) मल्टी टालस्कंग 

D) टाईम शेयटरंग 

Correct Answer : A) मल्टी यूिर 

16.टाईम शेयटरंग क्तसस्टम के बारे मे कोन सी बात सत्य ह।ै 

A) यह नेटवकण  पर आधाररत ह।ै 

B) यह प्राथक्तमकता के आधार पर काम करता ह।ै 

C) प्रत्येक काम को समान टाइम स्लाट कदया िाता ह।ै 

D) इनमे से कोइ नही 

Correct Answer : C) प्रत्येक काम को समान टाइम स्लाट कदया 
िाता ह।ै 

17.रीयल टाईम क्तसस्टम का प्राथक्तमक उद्दशे्य क्ट्या ह।ै 

A) टाईम बताना 

B) समय िाि करना 

C) कक्क ररस्पॉन्स टाईम प्रदान करना 

D) इनमे से कोई नही 

Correct Answer : C) कक्क ररस्पॉन्स टाईम प्रदान करना 
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18.रीयल टाईम क्तसस्टम के बारे मे कौन सी बात सत्य ह।ै 

A) उच्च प्राथक्तमकता वाल ेकाम को पहले संपन्न ककया िात ह।ै 

B) यह प्राथक्तमकता आधाररत नही ह।ै 

C) प्रत्येक काम को समान टाईम स्लाट क्तमलता ह।ै 

D) इनमे से कोई नही 

Correct Answer : A) उच्च प्राथक्तमकता वाले काम को पहले संपन्न 
ककया िाता ह।ै 

19.नेटवकण  आपरेटटंग क्तसस्टम सॉफ्टवेयर और उसस ेिुड ेप्रोटोकॉल 
का एक संग्रह ह।ै इस क्तसस्टम से संबंक्तधत कौन सी बात असत्य ह।ै 

A) हर कम्प्यूटर के पास अपना ऑपरेटटंग क्तसस्टम होता ह।ै 

B) उपयोिा होस्ट के क्तवक्तभन्न संसाधनो तक अपनी पहुि बना 
सकता ह।ै 

C) एक्ट्सेस को क्तनयंक्तत्रत ककया िा सकता ह।ै 

D) एक्ट्सेस को क्तनयंक्तत्रत नही ककया िा सकता ह।ै 

Correct Answer : C) एक्ट्सेस को क्तनयंक्तत्रत ककया िा सकता ह।ै 

क्तडक्तस्ट्रब्यूटेड ऑपरेटटंग क्तसस्टम के बारे मे कौन सी बात सत्य ह।ै 

A) ऑपरेटटंग क्तसस्टम कें रीकृत होता ह।ै 

B) ऑपरेटटंग क्तसस्टम कई होते ह।ै 

C) यह एक प्रोसेसर आधाररत होता ह।ै 

D) इनमे से कोई नही 

Correct Answer : A) ऑपरेटटंग क्तसस्टम कें रीकृत होता ह।ै 

21.C लैंग्वेि मे क्तलखा िाने वाला प्रथम ऑपरेटटंग क्तसस्टम कौन सा 
था। 

A) डॉस 

B) यूक्तनक्ट्स 

C) पास्कल 

D) कोबोल 

Correct Answer : B) यूक्तनक्ट्स 

 

Part – 29 

 

1. कैश ममेोरी (cache memory) —————– पी़िी के 
कम्प ् यटूर में आरंभ की गई थी। 
a) पहली 
b) दसूरी 
c) तीसरी 
d) िौथी 

2. FORTRAN का पूणण रूप ——————- हैं। 
a) फामूणला ट्रांस् लेशन 

b) फॉरवडण ट्रासेक्ट् ट 

c) फॉरवडण ट्रांस् लेट 

d) फॉरवडण ट्रांसफर 

3. एक डसे् कटॉप कम्प ् यटूर को —————– के रूप में भी िाना 
िाता हैं। 
a) पाम टॉप 

b) PC 

c) DC 

d) MC 

4. कम्प ् यटूर CPU के साथ सलंग् न भागों को ————— के रूप 
में भी िाना िाता हैं। 
a) आउटपुट क्तडवाइस 

b) पेरीफेरल् स 

c) शाडण 
d) कंट्रोल यूक्तनट्स 

5. क्तनम्प न में क्तवषम की पहिान करें। 
a) अररथमेरटक लॉक्तलक यूक्तनट 

b) कंट्रोल यूक्तनट 

c) रक्तिस् टर 

d) क्तबन् स 
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6. माउस और —————– भी इनपुट क्तडवाइस के उदाहरण हैं। 
a) लपं्रटर 

b) स् पीकर 

c) मॉक्तनटर 

d) स् कैनर 

7. TFT का क्ट् या अथण होता हैं। 
a) क्तथन कफल् म ्ूब 

b) क्तथन कफल् म टै्रक 

c) क्तथन कफल्म ट्रांक्तिस् टर 

d) क्तथन कफल्म ट्रांसफर 

8. लाइन, डेिी व् हील, लिेर तथा ड्रम —————– के प्रकार हैं। 
a) ् लाटसण 
b) स् कैनर 

c) फोटोकॉपी 
d) लपं्रटर 

9. िब हम एक लिेर लप्रटंर के सदंभण में DPI का उपयोग कर रह े
हैं, हम ककस प्रकार के लप्रटंर की बात कर रह ेहैं। 
a) स् पीड 

b) क्तस्पन 

c) एड्रसे 

d) ररिोल् युशन 

10. यकद आप एक ्लॉटर का उपयोग कर रह ेहैं, तो आप ककसका 
प्रयोग कर रह ेहैं। 
a) इनपुट क्तडवाइस 

b) आउटपुट क्तडवाइस 

c) इनपुट-आउटपुट क्तडवाइस 

d) अल् ट्रा क्तडवाइस 

11. यकद आप क्रमवार, समानातंर, AGP, इंफ्रा रेड की बात कर 
रह ेहैं, तो आप ककसके सदंभण में बता रह ेहैं। 
a) पोट्सण 
b) बस 

c) रक्तिस् टर 

d) RAM 

12. AI (Artificial Intelligence) का प्रयोग ————— 

पी़िी के कम्प ् यटूसण में ककया िाता हैं। 
a) दसूरी 
b) तीसरी 

c) िौथी 
d) पॉिवी 

13. ऑपरेटटंग क्तसस् टम में प्रोससेर के प्रबधंन के क्तलए क्ट् या क्तिम्प मेंदार 
हैं। 
a) टै्रकफक कंट्रोलर 

b) क्तडस् पेिर 

c) प्रोसेसर शेडू्यलर 

d) िॉब शेडू्यलर 

14. प्रस् ततु की गई कई िॉब् स में स ेप्रोससेर के क्तलए कोई एक िॉब 
के ियन के क्तलए क्ट् या उत् तरदायी हैं। 
a) टै्रकफक कंट्रोलर 

b) फाइल क्तसस् टम 

c) िॉब शेडू्यलर 

d) क्तडस् पेिर 

15. क्तनम्प नक्तलक्तखत कायो में स ेकौन सा सीध ेऑपरेटटंग क्तसस् टम 
द्वारा प्रबकं्तधत नहीं हैं। 
a) मैमोरी मैनेिमेंट 

b) वायरस मैनेिमेंट 

c) ए् लीकेशन मैनेिमेंट 

d) फाइल मैनेिमेंट 

16. एक  एम्प बडेडे ऑपरेटटंग कहॉ पाया िा सकता हैं। 
a) डसे् क टॉप पर 

b) सवणर पर 

c) PDA पर 

d) नेटवकण  ककये हुए PC पर 

17. Unix, MS DOS, Linux ककसके उदाहरण हैं। 
a) कम्प ् यूटर 

b) ऑपरेटटंग क्तसस् टम 

c) लपं्रटर 

d) लपं्रटर के िांड 

18. क्तनम्प न में क्तवषम की पहिान करें। 
a) लाइनैक्ट् स 

b) लवंडोि 

c) MAC OS 

d) IOS 
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19. MS लवंडोि क्ट् या हैं। 
a) एक ऑपरेटटंग क्तसस् टम 

b) ऑकफस सूट 

c) एक्त्लकैशन 

d) मॉक्तनटर 

20. लवडंोि ME में, ME का अथण ————– हैं। 
a) क्तमलेक्तनयम एक्तडशन 

b) मैक्तक्ट्समम इफेक्ट् ट्स 

c) मैक्तक्ट्समम इकफक्तशएक्तन्स 

d) क्तमक्तनमम एनिी 

21. यकद आप MS वडण में CTRL + A का उपयोग कर रह ेहैं, तो 
आप क्ट् या करन ेकी कोक्तशश कर रह ेहैं। 
a) फाइल में सभी टेक्ट् स् ट का ियन 

b) फाइल में सभी टेक्ट् स् ट का कॉपी 
c) लवंडोि बंद कर रह ेहैं 
d) टेक्ट् स् ट को पेस् ट कर रह ेहैं 

22. यकद आप Ctrl + Enter का उपयोग कर रह ेहैं, तो आप क्ट् या 
करन ेकोक्तशश कर रह ेहैं। 
a) लाइन िेक बना रह ेहैं 
b) एक नई फाइल बना रह ेहैं 
c) एक नई फाइल खोल रहें हैं 
d) एक फाइल बंद कर रह ेहैं 

23. यकद आप प्रोग्राम का उपयोग या प्रोग्राम का प्रारंभ करन ेकी 
कोक्तशश कर रह ेहैं, तो आप ककसका उपयोग करेंग।े 
a) क्तडफॉल् ट मेन् यु 
b) स् टाटण मेन् यु 
c) फाइल टैब 

d) होम टैब 

24. आप अपन ेकम्प ् यटूर पर उपलब् ध फ्री स् पसे का आकलन करन े
की कोक्तशश कर रह ेहैं (मान लें आपके पास MS लवडंोि ऑपरेटटंग 
क्तसस् टम हैं), तो आप ककसका उपयोग करेंगें। 
a) माई कम्प ् यूटर 

b) माई डॉक्ट् यूमेंट्स 

c) माई क्तपक्ट् िसण 
d) हले् प मेन् यु 

25. एक कम्प ् यटूर पर इंटरललकं/इंटरररलोरटड फाइलों के सगं्रह को 
ककस रूप में िाना िाता हैं। 

a) फाइल 

b) डॉक्ट् यूमेंट्स 

c) डटेाबेस 

d) फोल् डर 

26. यकद आप फोल् डर में सवे की हुई फाइलों को प्रदर्शणत करना 
िाहत ेहैं तो आप। 
a) ररनेम करेंगे 

b) इस पर क्तक्ट्लक करेंगे 

c) फोल् डर पर दाय  डबल क्तक्ट्लक करेंगे 

d) फोल् डर पर बाय  डबल क्तक्ट्लक करेंगे 

27. यकद आप Ctrl + Esc का उपयोग कर रह ेहैं, तो आप। 
a) लवंडोि हले् प को प्रारंभ कर रह ेहैं 
b) माई कम्प ् यूटर खोलते हैं 
c) स् टाटण मेन् यु को प्रारंभ कर रह ेहैं 
d) कंट्रोल पैनल खोलते हैं 

28. एक क्तवभािन लवडंोि मोड (Split Window Mode) में, 
यकद दो में स ेएक टाइटल बार दसूरे स ेगहरे रंग का हैं, तो क्ट् या 
ज्ञात होता हैं। 
a) गहरा टाइटल लवंडोि क्तनक्तष्क्रय (dormant) हैं 
b) गहरा टाइटल लवंडोि उपयोग में नही हैं 
c) गहरा टाइटल लवंडोि बंद हैं 
d) गहरा टाइटल सकक्रय (active) हैं 

29. क्तनम्प नक्तलक्तखत में स ेकौन सा कथन सत् य नहीं हैं। 
a) फाइल का नाम बदला िा सकता हैं 
b) फाइल को क्तडलीट ककया िा सकता हैं 
c) डायरेक्ट् ट्रीि को क्तमटाया िा सकता हैं 
d) डायरेक्ट् ट्रीि के नाम नहीं बदले िा सकत ेहैं 

30. यकद आप लवंडोि ऑपरेटटंग क्तसस् टम का उपयोग कर रह ेहैं और 
Ctrl + D का उपयोग करत ेहैं, तो आप क्ट् या करन ेकी कोक्तशश कर 
रह ेहैं। 
a) लॉग आउट 

b) डसे् क टॉप दखेना 
c) फाइल क्तड लीट करना 
d) लवंडोि डायरेक्ट् टरी में िाना 

31. क्तनम्प न में स ेकौन सा प्रारूप (Format) एक ऑक्तडयो फाइल 
की अक्तधक द वक्तन की गणुवत् ता को खोए क्तबना इसके आकार के मलू 
आकार के दसवें भाग में बदल दतेा हैं। 
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a) PDF 

b) VMEG 

c) MP3 

d) GIF 

32. MS वडण में आपको एक दस् ताविे में स् पलेलगं िकै और 
व् याकरण का उपोग करना हैं, तो आप ककसका उपयोग करेंगें। 
a) Ctrl + F 

b) Ctrl + S 

c) F7 

d) F3 

33. MS वडण एक ——————- हैं। 
a) ऑपरेटटंग क्तसस् टम 

b) ए् लीकेशन सॉफ्टवेयर 

c) प्रोग्रालमंग भाषा 
d) वायरस 

34. यकद आप MS वडण में Ctrl + Shift + P का उपयोग कर रहें 
हैं, तो आप क्ट् या करन ेकी कोक्तशश कर रहें हैं। 
a) फॉण् ट साइि बदलने की 
b) एक दस् तावेि को लपं्रट करने की 
c) डॉक्ट् यूमेंट को प्रीव् यू दखेने की 
d) डॉक्ट् यूमेंट को एक्तडट करने की 

35. MS एक्ट् सले में आप पकं्ति िोड़ना िाहत ेहैं, तो आप क्ट् या 
उपयोग करेंग।े 
a) फाइल मेनू 
b) इन् सटण मेन् यु 
c) एक्तडट मेन् यु 
d) व् य ू(view) मेन् यु 

36. यकद आप MS एक्ट् सले में RAND का उपयोग कर रह ेहैं, तो 
आप क्ट् या करन ेकी कोक्तशश कर रह ेहैं। 
a) रेंडम नम्प बर को उत् पन् न करने की 
b) रैंक उत् पन् न करने की 
c) पंक्तियॉ एकक्तत्रत (merge) करन ेकी 
d) सेल में डटेा को ररपीट करने की 

37. क्तनम्प न में क्तवषम की पहिान करें। 
a) बबल 

b) बार 

c) पाई 

d) रो (row) 

38. यकद आप एक स् लाइड बना रह ेहैं, तो आप। 
a) MS वडण में काम कर रहें हैं 
b) MS एक्ट् सेल में काम कर रह ेहैं 
c) MS पॉवरपॉइंट में काम कर रह ेहैं 
d) सुपर कम्प ् यूटर पर काम कर रह ेह ै

39. यकद आप MS पॉवरपॉइंट में काम कर रहें हैं और F5 का 
उपयोग करत ेहैं तो आप। 
a) पे्रिेंटेशन को प्रारंभ से शरुू कर रहें हैं 
b) पे्रिेंटेशन को वतणमान स् लाइड से शुरू कर रह ेहैं 
c) पे्रिेंटेशन को सेव कर रह ेहैं 
d) पे्रिेंटेशन में एक वीक्तडयो को िोड़ रह ेहैं 

40. DCL का पणूणरूप —————– हैं। 
a) क्तडस् क कंट्रोल लोकेशन 

b) डटेा कंट्रोल लैंग् वेि 

c) क्तडस् क कंट्रोल लैंग् वेि 

d) क्तसफण  कैरेक्ट् टर रीडर 

41. MS Access क्ट् या हैं। 
a) CPU 

b) एक वडण प्रोसेसर की तरह उपयोग ककया िाने वाला सॉफ्टवेयर 

c) डटेाबेस का उदाहरण 

d) एक कम्प ् यूटर 

42. वाई-फाई का अथण ————— हैं। 
a) वायरलेस फंक्ट् शन 

b) वायरलेस फाइनल 

c) वायरलेस कफडके्तलटी 
d) लवंडोि फंक्ट् शन 

43. यकद आप अपन ेकम्प ् यटूर पर ब् लटूूथ का उपयोग कर रह ेहैं, तो 
आप ककस प्रकार के नटेवकण  का उपयोग कर रह ेहैं। 
a) LAN 

b) Wi-Fi 

c) PAN 

d) WAN 

44. डोमने कोड़ ‘.mil’ का ककसके द्वारा इस् तमेाल ककया िा सकता 
हैं। 



                                     RSIT-RUDRA-SOFTECH INSTITUTE OF TECHNOLOGY UMARIA(KARKELI)                           Page 44 of 62 

 

 

a) सेना 
b) दधू सहकारी सक्तमक्ततया ं
c) खनन उद्योग 

d) मल् टीनेशनल 

45. MAN क पूणण रूप —————– हैं। 
a) मेट्रोपोक्तलटन एररया नेटवकण  
b) माकेट एररया नेटवकण  
c) मैन एररया नेटवकण  
d) मेिर एररया नेटवकण  

46. ISP का क्ट् या अथण होता हैं। 
a) इंटरनेट सर्वणस प्रोटोकॉल 

b) इंटरनेट सर्वणस प्रोवाईडर 

c) इंटरनल सर्वणस प्रोटोकॉल 

d) इंटरनेट क्तसस् टम प्रोटोकॉल 

47. फायर वाल् स का प्राथक्तमक उपयोग —————- हैं। 
a) वायरस से सुरक्षा 
b) कम्प ् यूटर की आग से सुरक्षा 
c) अनक्तधकृत पहुिँ की रोक 

d) डटेा क्तसक्ट् यूररटी संभालना 

48. क्तनम्प न में क्तवषम की पहिान करें। 
a) पैकेट – कफल् टटरंग राउटर 

b) ए् लीकेशन – लेवल गेटवेि 

c) सर्कण ट – लेवल गेटवेि 

d) मोबाइल – गेटवेि 

49. क्तनम्प नक्तलक्तखत भाषां  को उनके क्तवकास के काल के अनसुार 
क्रमबद्ध कीक्तिए (परुातन पहले, आधकु्तनक अतं में)। 
FORTRAN, COBOL, PASCAL, JAVA 

Options:- 

a) COBOL, FORTRAN, PASCAL, JAVA 

b) FORTRAN, COBOL, PASCAL, JAVA 

c) PASCAL, FORTRAN, COBOL, JAVA 

d) FORTRAN, COBOL, JAVA, PASCAL 

50. ड्रीम वीवर, फ्लैश और प्रीक्तमयर ककसके उदाहरण हैं। 
a) डटेाबेस मैनेिमेंट प्रोग्राम्प स 

b) वेब िाउिर 

c) मल् टीमीक्तडया ए् लीकेशन 

d) वडण प्रोसेसर 

51. ASCII का क्ट् या अथण होता हैं। 
a) अमेररकन स् टैंडडण कोड फॉर इंटरनेट इंटरफेस 

b) अमेररकन स् टैंडडण कोड फॉर इनफॉमेशन इंटरिेंि 

c) अमेररकन स् टैंडडण कोड फॉर इंटरनेट इंटरिेंि 

d) अमेररकन स् टैंडडण कोड फॉर इनफॉमेशन इंटरफेस 

52. कैश ममेोरी कहॉ कायण करती हैं। 
a) RAM और ROM के बीि 

b) CPU और के RAM बीि 

c) CPU और ROM के बीि 

d) CPU और हाडण क्तडस् क के बीि 

Answer Sheet 

1. कैश ेममेोरी (cache memory) —————– पी़िी के 
कम्प ् यटूर में आरंभ की गई थी। 
answer- c) तीसरी 

2. FORTRAN का पूणण रूप ——————- हैं। 
answer- a) फामूणला ट्रांस्ले-शन 

3. एक डसे्क टॉप कम्प ् यटूर को —————– के रूप में भी िाना 
िाता हैं। 
answer- b) PC 

4. कम्प ् यटूर CPU के साथ सलंि भागों को ————— के रूप में 
भी िाना िाता हैं। 
answer- a) आउटपुट क्तडवाइस 

5. क्तनम्नस में क्तवषम की पहिान करें। 
answer- d) क्तबन्स 

6. माउस और —————– भी इनपुट क्तडवाइस के उदाहरण हैं। 
answer- d) स्कै-नर 

7. TFT का क्ट्या अथण होता हैं। 
answer- c) क्तथन कफल्म ट्राकं्तिस्टर 

8. लाइन, डेिी व्हील, लिेर तथा ड्रम —————– के प्रकार हैं। 
answer- d) लपं्रटर 

9. िब हम एक लिेर लप्रटंर के सदंभण में DPI का उपयोग कर रह े
हैं, हम ककस प्रकार के लप्रटंर की बात का रह ेहैं। 
answer- d) ररिोल्युशन 
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10. यकद आप एक ्लॉटर का उपयोग कर रह ेहैं, तो आप ककसका 
प्रयोग कर रह ेहैं। 
answer- b) आउटपुट क्तडवाइस 

11. यकद आप क्रमवार, समानातंर, AGP, इंफ्रा रेड की बात कर 
रह ेहैं, तो आप ककसके सदंभण में बता रह ेहैं। 
answer- a) पोट्सण 

12. AI (Artificial Intelligence) का प्रयोग ————— 

पी़िी के कमा्  ्  यटूर में ककया िाता हैं। 
answer- d) पॉिवी 

13. ऑपरेटटंग क्तसस्टम में प्रोससेर के प्रबधंन के क्तलए क्ट्या- 
क्तिम्पमेंदार हैं। 
answer- a) टै्रकफक कंट्रोलर 

14. प्रस्ततु की गई कई िॉब्स में स ेप्रोससेर के क्तलए कोई एक िॉब 
के ियन के क्तलए क्ट्याप उत्त रदायी हैं। 
answer- c) िॉब शेडू्यलर 

15. क्तनम्नतक्तलक्तखत कायो में स ेकौन सा सीध ेऑपरेटटंग क्तसस्टम 
द्वारा प्रबकं्तधत नहीं हैं। 
answer- b) वायरस मैनेिमेंट 

16. एक  एम्पबाेडडे ऑपरेटटंग कहॉ पाया िा सकता हैं। 
answer- c) PDA पर 

17. Unix, MS DOS, Linux ककसके उदाहरण हैं। 
answer- b) ऑपरेटटंग क्तसस्टम 

18. क्तनम्न में क्तवषम की पहिान करें। 
answer- d) IOS 

19. MS लवंडोि क्ट्या हैं। 
answer- a) एक ऑपरेटटंग क्तसस्ट म 

20. लवडंोि ME में, ME का अथण ————– हैं। 
answer- a) क्तमलेक्तनयम एक्तडशन 

21. यकद आप MS वडण में CTRL+A का उपयोग कर रह ेहैं, तो 
आप क्ट्या ंकरन ेकी कोक्तशश कर रह ेहैं। 
answer- a) फाइल में सभी टेक्ट्ट का ियन 

22. यकद आप Ctrl+Enter का उपयोग कर रह ेहैं, तो आप क्ट्या 
करन ेकोक्तशश कर रह ेहैं। 
answer- a) लाइन िेक बना रह ेहैं 

23. यकद आप प्रोग्राम का उपयोग या प्रोग्राम का प्रारंभ करन ेकी 
कोक्तशश कर रह ेहैं, तो आप ककसका उपयोग करेंग।े 
answer- b) स्टाटण मेन्यु 

24. आप अपन ेकम्प ् यटूर पर उपलब्ध फ्री स्पसे का आकलन करन े
की कोक्तशश कर रह ेहैं (मान लें आपके पास MS लवडंोि ऑपरेटटंग 
क्तसस्टीम हैं), तो आप ककसका उपयोग करेंगें। 
answer- a) माई कम्प ् यूटर 

25. एक कम्प ् यटूर पर इंटरललकं/इंटरररलोरटड फाइलों के सगं्रह को 
ककस रूप में िाना िाता हैं। 
answer- c) डटेाबेस 

26. यकद आप फोल्डर में सवे की हुई फाइलों को प्रदर्शणत करना 
िाहत ेहैं तो आप। 
answer- d) फोल्डरर पर बाय  डबल क्तक्ट्लक करेंगे 

27. यकद आप Ctrl+Esc का उपयोग कर रह ेहैं, तो आप। 
answer- c) स्टाडटण मेन्युह को प्रारंभ कर रह ेहैं 

28. एक क्तवभािन लवडंोि मोड (Split Window Mode) में, 
यकद दो में स ेएक टाइटल बार दसूरे स ेगहरे रंग का हैं, तो क्ट्या 
ज्ञात होता हैं। 
answer- d) गहरा टाइटल सकक्रय (active) हैं 

29. क्तनम्नगक्तलक्तखत में स ेकौन सा कथन सत्या् नहीं हैं। 
answer- d) डायरेक्ट्ट्रीि के नाम नहीं बदले िा सकते हैं 

30. यकद आप लवंडोि ऑपरेटटंग क्तसस्ट म का उपयोग कर रह ेहैं और 
Ctrl+D का उपयोग करत ेहैं, तो आप क्ट्याा् करन ेकी कोक्तशश कर 
रह ेहैं। 
answer- b) डसे्क टॉप दखेना 

31. क्तनम्न ंमें स ेकौन सा प्रारूप (Format) एक ऑक्तडयो फाइल 
की अक्तधक दवकं्तन की गणुवत्ता को खोए क्तबना इसके आकार के मलू 
आकार के दसवें भाग में बदल दतेा हैं। 
answer- c) MP3 
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32. MS वडण में आपको एक दस्ताविे में स्पलेलगं िकै और 
व्यादकरण का उपोग करना हैं, तो आप ककसका उपयोग करेंगें। 
answer- c) F7 

33. MS वडण एक ——————- हैं। 
answer- b) ए्ली-केशन सॉफ्टवेयर 

34. यकद आप MS वडण में Ctrl+Shift+P का उपयोग कर रहें हैं, 
तो आप क्ट्या करन ेकी कोक्तशश कर रहें हैं। 
answer- a) फॉण्टर साइि बदलने की 

35. MS एक्ट्सले में आप पकं्ति िोड़ना िाहत ेहैं, तो आप क्ट् यो 
उपयोग करेंग।े 
answer- b) इन्सआटण मेन्यु 

36. यकद आप MS एक्ट्सपेल में RAND का उपयोग कर रह ेहैं, तो 
आप क्ट्या करन ेकी कोक्तशश कर रह ेहैं। 
answer- a) रेंडम नम्पबर को उत्पंन्न करने की 

37. क्तनम्प न में क्तवषम की पहिान करें। 
answer- d) रो (row) 

38. यकद आप एक स्लाइड बना रह ेहैं, तो आप। 
answer- c) MS पॉवरपॉइंट में काम कर रह ेहैं 

39. यकद आप MS पॉवरपॉइंट में काम कर रहें हैं और F5 का 
उपयोग करत ेहैं तो आप। 
answer- a) पे्रिेंटेशन को प्रारंभ से शुरू कर रहें हैं 

40. DCL का पणूणरूप —————– हैं।  
answer- b) डटेा कंट्रोल लैंग्वे ि 

41. MS Access क्ट्या हैं। 
answer- c) डटेाबेस का उदाहरण 

42. वाई-फाई का अथण ————— हैं। 
answer- c) वायरलेस कफडके्तलटी 

43. यकद आप अपन ेकम्प ् यटूर पर ब्लटूूथ का उपयोग कर रह ेहैं, तो 
आप ककस प्रकार के नटेवकण  का उपयोग कर रह ेहैं। 
answer- c) PAN 

44. डोमने कोड़ ‘.mil’ का ककसके द्वारा इस्तेमूाल ककया िा सकता 
हैं। 
answer- a) सेना 

45. MAN क पूणण रूप —————– हैं। 
answer- a) मेट्रोपोक्तलटन एररया नेटवकण  

46. ISP का क्ट्या अथण होता हैं। 
answer- b) इंटरनेट सर्वणस प्रोवाईडर 

47. फायरवाल्स का प्राथक्तमक उपयोग —————- हैं। 
answer- c) अनक्तधकृत पहुिँ की रोक 

48. क्तनम्प न में क्तवषम की पहिान करें। 
answer- d) मोबाइल–गेटवेि 

49. क्तनम्प नक्तलक्तखत भाषां  को उनके क्तवकास के काल के अनसुार 
क्रमबद्ध कीक्तिए (परुातन पहले, आधकु्तनक अतं में)। 
answer- b) FORTRAN, COBOL, PASCAL, JAVA 

50. ड्रीमवीवर, फ्लैश और प्रीक्तमयर ककसके उदाहरण हैं। 
answer- c) मल्टीमीक्तडया ए्लीककेशन 

51. ASCII का क्ट्या अथण होता हैं। 
answer- b) अमेररकन स्टैंहडडण कोड फॉर इनफॉमेशन इंटरिेंि 

52. कैश ममेोरी कहॉ कायण करती हैं। 
answer- b) CPU और के RAM बीि 

Part – 30 

RDBMS का पूणण रूप क्ट्या हैं ? 

(A)ररलेशनल डटेाबसे मनेैिमेंट क्तसस्टम 

(B)ररलेशनल डटेाबेस माइक्रो क्तसस्टम 

(C)ररलेशनल डटेाबेस मके्रो क्तसस्टम 

(D)उपरोि में स ेकोई नहीं 

Hide Answers 

(A)ररलेशनल डटेाबसे मनेैिमेंट क्तसस्टम (relational 
database management system) 
  

फॉक्ट्स-प्रो के संस्करण हैं ? 

(A)Fox-pro 2.5 

http://spidernotes.in/fox-pro/
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(B)Fox-pro 2.6 

(C)Dbase+ (Plus) 

(D)उपरोि सभी 

Hide Answers 

(D)उपरोि सभी 

  

फॉक्ट्स-प्रो प्रोग्राम को ककस ्लेटफॉमण पर रन ककया िा 
सकता हैं ? 

(A)डॉस 

(B)लवंडोि 

(C)A और B दोनों 

(D)उपरोि सभी 

Hide Answers 

(C)A और B दोनों 

क्तनम्नक्तलक्तखत में स ेककस ्लेटफॉमण पर फॉक्ट्स-प्रो को रन 
ककया िा सकता हैं ? 

(A)UNIX 

(B)Windows 

(C)Linux 

(D)उपरोि सभी 

Hide Answers 

(D)उपरोि सभी 

डाटाबेस फाइल को बनाने के क्तलए फॉक्ट्स-प्रो में ककस 
कमांड का उपयोग ककया िाता हैं? 

(A)Create 

(B)Use 

(C)Do 

(D)उपरोि में स ेकोई नहीं 

Hide Answers 

(A)Create 

फॉक्ट्स-प्रो में डाटाबेस फाइल का क्तवस्तारक हैं ? 

(A).dbf 

(B).Prg 

(C).cdx 

(D).txt 
Hide Answers 

(A).dbf 

फॉक्ट्स-प्रो में डाटाबेस फाइल को बंद करन ेके क्तलए कमांड 
हैं ? 

(A)Use 

(B)Close database 

(C)Close all 

(D)उपरोि_सभी 
Hide Answers 

(D)उपरोि सभी 

डाटाबेस फाइल को ओपन करन ेके क्तलए सही सेंटेक्ट्स हैं ? 

(A)Use 

(B)Use <database File Name> 

(C)A और B दोनों 

(D)उपरोि में स ेकोई नहीं 

Hide Answers 

(B)Use <database File Name> 

डाटाबेस फाइल में एक नवीन ररकॉडण िोड़ने के क्तलए कौन 
सी कमांड हैं ? 

(A)Append 

(B)List 
(C)Locate 

(D)Seek 

Hide Answers 

(A)Append 

डाटाबेस फाइल में न्यू ररकॉडण िोड़ने के क्तलए कीबोडण 
शॉटणकट की हैं ? 

(A)Ctrl+M 

(B)Ctrl+N 

(C)Ctrl+W 

(D)Ctrl+D 

Hide Answers 

(B)Ctrl+N 

फॉक्ट्स-प्रो को पूणण रूप स ेबंद करन ेके क्तलए कमांड हैं ? 

(A)Exit 
(B)Close 

(C)Quit 

(D)उपरोि सभी 

Hide Answers 

(C)Quit 

क्तनम्नक्तलक्तखत में स ेफॉक्ट्स प्रो में डाटा टाइप का प्रकार हैं ? 

(A)Character type 

(B)Float 
(C)Logical 

http://spidernotes.in/fox-pro/
http://spidernotes.in/fox-pro/
http://spidernotes.in/fox-pro/
http://spidernotes.in/fox-pro/
http://spidernotes.in/fox-pro/
http://spidernotes.in/fox-pro/
http://spidernotes.in/fox-pro/
http://spidernotes.in/fox-pro/
http://spidernotes.in/fox-pro/
http://spidernotes.in/fox-pro/
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(D)उपरोि सभी 

Hide Answers 

(D)उपरोि सभी 

*ककसी डटेाबेस फाइल में अक्तधकतम फील्ड हो सकती हैं ? 

(A)254 

(B)255 

(C)253 

(D)256 

Hide Answers 
      

एक ररकॉडण की अक्तधकतम िौड़ाई ………. कैरेक्ट्टर हो 
सकती हैं ? 

(A)65500 

(B)65600 

(C)256 

(D)16332 

Hide Answers 

(A)65500 

एक फील्ड में अक्तधकतम ………ररकॉडण संग्रक्तहत ककय ेिा 
सकते हैं ? 

(A)1 अरब ररकॉडण 
(B)2 अरब ररकॉडण 
(C)1000 ररकॉडण 
(D)कोई सीमा नहीं हैं 
Hide Answers 

(A)1 अरब ररकॉडण 
मेमों फील्ड में डाटा एक अलग फाइल में स्टोर होता ह ै
क्तिसका क्तवस्तारक नाम क्ट्या हैं ? 

(A).Prg 

(B).FPT 

(C).Idx 

(D).Cdx 

Hide Answers 

(B).FPT 

फॉक्ट्स-प्रो में कैरेक्ट्टर फील्ड की िौड़ाई हो सकती हैं ? 

(A)512 Characters 

(B)128 Characters 

(C)256 Characters 

(D)254 Characters 

Hide Answers 

(D)254 Characters 

डाटाबेस फाइल की सरंिना को बदलने के क्तलए ककस 
कमांड का उपयोग ककया िाता हैं ? 

(A)Modify Command 

(B)Modify Structure 

(C)Edit 
(D)Browse 

Hide Answers 

(B)Modify Structure 

डाटाबेस फाइल की सरंिना में पररवतणन करत ेसमय 
नवीन फील्ड को िोड़ने के क्तलए ककस कीबोडण शॉटणकट की 
का उपयोग ककया िाता हैं ? 

(A)Ctrl+N 

(B)Ctrl+I 

(C)Ctrl+D 

(D)Ctrl+M 

Hide Answers 

(B)Ctrl+I 

डाटाबेस फाइल के क्तसलके्ट्टेड फील्ड को ररमुव करन ेके 
क्तलए कौन सी शॉटणकट की हैं ? 

(A)Ctrl+D 

(B)Ctrl +R 

(C)Ctrl+del 

(D)उपरोि में स ेकोई नहीं 

Hide Answers 

(A)Ctrl+D[/bg_collapse] 

डाटाबेस फाइल में पररवतणन को सुरक्तक्षत करन ेके क्तलए 
कीबोडण शॉटणकट हैं ? 

(A)Ctrl+S 

(B)Ctrl+w 

(C)Shift+S 

(D)ALT+S 

Hide Answers 

(B)Ctrl+w 
  

समस्त प्रकार की फाइल को मॉनीटर स्क्रीन पर दखेने के 
क्तलए कमांड हैं ? 

(A)Dir 

(B)Dir *.* 

(C)Dir*.dbf 
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(D)उपरोि में स ेकोई नहीं 

Hide Answers 

(B)Dir *.* 

इंडके्ट्स फाइल को मॉनीटर स्क्रीन पर दखेने के क्तलए 
…………..कमांड हैं ? 

(A)Dir*.Idx 

(B)Dir*.C 

(C)Dir 

(D)Dir*.I 

Hide Answers 

(A)Dir*.Idx 

फॉक्ट्स प्रो में सॉटेट फाइल का क्तवस्तारक होता हैं ? 

(A).dbf 

(B).idx 

(C).srt 
(D).cdx 

Hide Answers 

(A).dbf 

इंडके्ट्स की गई फाइल का क्तवस्तारक नाम होता हैं ? 

(A).dbf 

(B).idx 

(C).prg 

(D).txt 
Hide Answers 

(B).idx 

डाटाबेस फाइल में ककस कमांड के द्वारा समस्त ररकॉडण को 
पूणणतः क्तडक्तलट करन ेके क्तलए ककया िाता हैं ? 

(A)Zap 

(B)Recall 
(C)Delete all 
(D)Seek 

Hide Answers 

(A)Zap 

Delete Rest कमांड स ेक्ट्या तात्पयण हैं ? 

(A)ररकॉडण पॉइन्टर क्तिस ररकॉडण पर ह ैवह ररकॉडण 
क्तडक्तलट हो िाता ह ै

(B)ररकॉडण पॉइन्टर क्तिस ररकॉडण पर ह ैउसके आगे के 
समस्त ररकॉडण क्तमटाने हतुे क्तिक्तहन्त ककए  िाते हैं 
(C)समस्त ररकॉडण क्तमटाने हतुे क्तिक्तन्हत ककय ेिाते हैं । 

(D)उपरोि_में_स_ेकोई_नहीं 

Hide Answers 

(B) ररकॉडण पॉइन्टर क्तिस ररकॉडण पर ह ैउसके आगे के 
समस्त ररकॉडण क्तमटाने हतुे क्तिक्तहन्त ककए  िाते हैं 
ककस कमांड द्वारा ररकॉडण के प्रारंभ में *(Astrick) का 
क्तसम्पबॉल लग िाता हैं ? (A)Recall 
(B)Zap 

(C)Delete 

(D)Pack 

Hide Answers 

(C)Delete 

डाटाबेस ए्लीकेशन को क्तवकक्तसत करन ेके क्तलए उपयोग 
ककया िाता हैं ? 

(A)एम.एस.वडण 
(B)फॉक्ट्स-प्रो 

(C)आउटलुक 

(D)पॉवरपॉइन्ट 

Hide Answers 

(B)फॉक्ट्स-प्रो 

माइक्रो कम्प्यूटर में सवणप्रथम ककस डटाबेस मैनेिमेंट 
क्तसस्टम (database management system) का उपयोग 
ककया गया था ? 

(A)Dbase 

(B)Visual FoxPro (VFT) 

(C)FoxPro 

(D)FoxBASE 

Hide Answers 

(A)Dbase 

……………. एक ऐसी िानकारी का संग्रह ह ैक्तिसे 
व्यवक्तस्थत ककया िाता ह ैताकक इस ेआसानी स े
एक्ट्सेस,प्रबंक्तधत और अपडटे ककया िा सके । 

(A)फील्ड 

(B)ररकॉडण 
(C)डटेाबेस 

(D)सूिना 

Hide Answers 

(C)डटेाबेस 

डी.बी.एफ. का पूणण रूप क्ट्या हैं ? 

(A)डाटाबेस फाइल 
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(B)डाटाबेस फॉक्ट्स-प्रो 

(C)डी बेस फाइल 

(D)उपरोि में स ेकोई नहीं 

Hide Answers 

(A)डाटाबेस फाइल 

डाटाबेस सॉफ्टवेयर के उदाहरण हैं ? 

(A)Oracle 

(B)Microsoft Access 

(C)File Maker Pro 

(D)उपरोि सभी 

Hide Answers 

(D)उपरोि सभी 

डाटाबेस सॉफ्टवेयर हैं ? 

(A)Microsoft SQL Server 

(B)SAP and MySQL 

(C)Fox Pro 

(D)उपरोि सभी 

Hide Answers 

(D)उपरोि सभी 

………………..को डीबीएमएस कहॉ िाता हैं ? 

(A)ए्लीकेशन सॉफ्टवेयर 

(B)यूटीलीटी प्रोग्राम 

(C)क्तसस्टम सॉफ्टवेयर 

(D)डाटाबेस सॉफ्टवेयर 

Hide Answers 

(D)डाटाबेस सॉफ्टवेयर 

डीबीएमएस का उपयोग ककया िाता हैं ? 

(A)Data store 

(B)Retrieve, add 

(C)Delete and modify data 

(D)उपरोि सभी 

Hide Answers 

(D)उपरोि सभी 

फॉक्ट्स-प्रो के संबंध में क्ट्या सत्य हैं ? 

(A) फॉक्ट्स-प्रो ररलेशनल डटेाबेस प्रकक्रयात्मक 
(Procedural) प्रोग्रालमंग भाषा हैं 
(B) फॉक्ट्स-प्रो को शरुू में फॉक्ट्स सॉफ्टवेयर द्वारा 1984 

में क्तवकक्तसत ककया गया था । 

(C)फॉक्ट्स-प्रो में बनी डाटाबसे फाइल का क्तवस्तारक .dbf 

होता हैं 
(D)उपरोि_सभी 
Hide Answers 

(D)उपरोि सभी 

डाटाबेस फाइल में ररकाडो को ढु़िने के क्तलए कौन सी 
कमांड हैं ? 

(A)Find 

(B) Seek 

(C)A_और_B दोनों 

(D)Search 

Hide Answers 

(C)A और B दोनों 

Find और Seek कमांड प्रयुि होती हैं ? 

(A)Sort 
(B)Index 

(C)उपरोि दोनों में 
(D)Macro 

Hide Answers 

(C) उपरोि दोनों में 
कौन सी कमांड ररकॉडो को सिण करन ेके क्तलए वेररयेबल 
या वं्यिक का उपयोग करती हैं ? 

(A)Find 

(B)Seek 

(C)उपरोि दोनों 

(D)उपरोि_में_स_ेकोई_नहीं 

Hide Answers 

(B)Seek 

डाटाबेस फाइल के ररकॉडों को ब़िते क्रम और घटत ेक्रम 
में व्यवक्तस्थत ककया िाता हैं ? 

(A)Sort command 

(B)Index Command 

(C)A और B दोनों 

(D)उपरोि_में_स_ेकोई_नहीं 

Hide Answers 

(C)A और B दोनों 

सॉटण कमांड का उपयोग ककया िा सकता हैं? 

(A)लसंगल फील्ड 

(B)मल्टी फील्ड 
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(C)A और B दोनों 

(D)उपरोि_में_स_ेकोई_नहीं 

Hide Answers 

(C)A और B दोनों  

इंडलेक्ट्संग के प्रकार हैं ? 

(A)Single simple Index 

(B)Compound Index 

(C)A और B दोनों 

(D)उपरोि_में_स_ेकोई_नहीं 

Hide Answers 

(C)A और B दोनों 

foxpro Computer objective Set 2  

Fox-pro क्ट्या  ? 

(A)Programming Language (B)DBMS(Database 
management system) 

(C)A और B दोनों 

(D)operating system 

Hide Answers 

(C)A और B दोनों 

1.RAM में स्टोर होने वाले डाटा आइटम्पस को क्ट्या कहा 
िाता ह?ै 

(A)Memory Variable   
(B)Memory Item  
(C)Dynamic Data  
(D)Data Memory 
  

2.मेमोरी वेररएबल का नाम ककतने अक्षरों का हो सकता 
ह ै? 

(A)256 करैक्ट्टर 

(B)12 करैक्ट्टर 

(C)10 करैक्ट्टर  

(D)8 करैक्ट्टर  

3.fox pro में यूिर अक्तधकतम ककतने DATA ITEM 

स्टोर या संगृहीत कर सकते ह ै? 

(A)254  
(B)255  
(C)256 

(D)10  

4.मेमोरी वेररएबल के रुल्स के अनुसार क्ट्या सही ह ै? 

(A)Memory का नाम ककसी करैक्ट्टर/अक्षर स ेशरुू होना 
िाक्तहए  

(B)Punctuation symbol और blank Space का 
उपयोग नहीं ककया िाता ह|ै 

(C)ककसी ममेोरी वेररएबल का नाम 10 अक्षरों का हो 
सकता ह ै 

(D)उपरोि सभी  
5.fox-pro में मेमोरी वेररएबल ककस कमांड के द्वारा 
कक्रएट ककय ेिाते ह?ै 

(A)Store Command 

(B)Equal sign (=) Command    

(C)दोनों A और B   
(D)Create command 

6.फॉक्ट्स प्रो में Store command की हले्प स ेMemory 

Variable कक्रएट करन ेके क्तलए सही प्रारूप (syntax) 

होगा ? 

(A)Store<Expression>to <variable1,variable2….> 

(B)Store<variable1,variable2….> 
to <Expression> 

(C)दोनों A और B   
(D)Store =<Expression>to 
<variable1,variable2….> 

7.फॉक्ट्स प्रो में Memory Variable कक्रएट करत े
समय Expression हो सकते ह ै? 

(A)Character 

(B)Numeric 

(C)Date & Logical 

(D)उपरोि सभी  
8.फॉक्ट्स प्रो में “=” command की हले्प स ेMemory 

Variable कक्रएट करन ेके क्तलए सही प्रारूप (syntax) 

होगा ? 

(A)<memory Variable>=<Expression>  
(B)<Expression>=<memory Variable>  
(C)<memory Variable>=<memory Variable>  

(D)उपरोि में स ेकोई नहीं  
9.क्तनम्नक्तलक्तखत में से कौन स ेकथन सही ह ै? 

(A)Store date() dt1,dt2 

(B)store “Indore” to city 

(C)store[Sumit] to name 
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(D)उपरोि सभी  
10.क्तनम्नक्तलक्तखत में स ेकौन स ेकरैक्ट्टर मेमोरी 
वेररएबल के  सही कथन ह ै? 

(A)store bhopal to city 

(B)store “Indore” to city 

(C)store[Sumit] to name 

(D)दोनों B और C  

11.store[Sumit] to name कमांड का सही कायण क्ट्या 
होगा ? 

(A)Name करैक्ट्टर मेमोरी वेररएबल में Sumit को store 

कर दगेी  
(B)Name करैक्ट्टर मेमोरी वेररएबल में Sumit को store 

नहीं करेगी  
(C)sumit को लपं्रट करेगी  
(D)दोनों A और  C  

12.क्तनम्नक्तलक्तखत में स ेकौन स ेन्यूमैररक मेमोरी 
वेररएबल के सही कथन ह ै? 

(A)store 15 to GST  
(B)store 30 to salary    

(C)दोनों A और B 

(D)store “15” to bill 

13.store 15 to GST कमांड  में न्यूमैररक मेमोरी 
वेररएबल ह ै? 

(A)GST 

(B)15 

(C)store 

(D)store “15” to GST 
  

14.store .T. to Choice कमांड में लॉक्तिकल मेमोरी 
वेररएबल ह ै? 

(A)Choice 

(B) .T.  
(C)store 

(D)store .T. to Choice 

15.store .T. to Choice और store .F. to Choice में .T. 

और .F. ककसे इंक्तगत कर रह ेह ै? 

(A)लॉक्तिकल मेमोरी वेररएबल  

(B)न्यूमैररक डाटा टाइप  

(C)लॉक्तिकल डाटा टाइप  

(D)करैक्ट्टर डाटा टाइप  

16.store .T. to Choice और store .F. to Choice में .T. 

और .F. ककसे इंक्तगत कर रह ेह ै? 

(A)लॉक्तिकल मेमोरी वेररएबल  

(B)न्यूमैररक डाटा टाइप  

(C)लॉक्तिकल डाटा टाइप  

(D)करैक्ट्टर डाटा टाइप  

17.लॉक्तिकल मेमोरी वेररएबल के क्तनमाणण में ककस प्राय 
की क्तिन्ह का प्रयोग होता ह ै? 

(A) ? क्तिन्ह  

(B)डॉट (.) 

(C)semicolon 

(D)colon 

18. .T. और .F. का क्ट्या अथण ह ै? 

(A)tabular और format 

(B)Test और fox  

(C)true और False  

(D)उपरोि में स ेकोई नहीं   
  

19.कौन स ेmemory Variable सही Rules को Follow 

करत ेह ै? 

(A)rain_fall 
(B)spider1  
(C)fname 

(D)उपरोि सभी  
20.कौन स ेmemory Variable सही Rules को Follow 

नहीं करत ेह ै? 

(A)rain@fall 
(B)spider notes 

(C)computereducation 

(D)उपरोि सभी  
21.Foxpro में पूवणक्तनर्मणत वेररएबल(Predefined 

Variable ) को क्ट्या कहा ँिाता ह ै? 

(A)मेमोरी वेररएबल 

(B)क्तसस्टम वेररएबल 

(C)इन्टनणल_वेररएबल 
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(D)एक्ट्सटनणल_वेररएबल 

22.क्तसस्टम वेररएबल या पूवणक्तनर्मणत वेररएबल स े
सम्पबंक्तधत सही कथन ह ै? 

(A)यह ऑपरेटटंग क्तसस्टम के टाइ्स ह|ै 

(B)fox-pro में  पूवणक्तनर्मणत स ेही क्तनर्मणत(Predefined 

Variable) होते ह|ै  

(C)इनका मान ककसी अक्षर स ेन होकर अंडर स्कोर स े
होता ह|ै 

(D)दोनों B और C 

23.ब्लैंक करैक्ट्टर वेररएबल का क्तनमाणण ककसका उपयोग 
ककया िाता ह ै? 

(A)space() 

(B)blank() 

(C)blankspace() 

(D)whitespace() 
  

24.ऐरे (Array) के प्रकार ह ै? 

(A)2 

(B)3 

(C)4 

(D)5 

25.ऐरे (Array) के कौन स ेप्रकार ह ै? 

(A) वन डायमेंशनल ऐरे /Single Dimensional Array 

(B) टू –डायमेंशनल ऐरे/Double Dimensional Array 

(C)दोनों A और B 

(D)थ्री-डायमेंशनल ऐरे  

26. foxpro में ऐरे (Array) का क्तनमाणण ककस कमांड के 
द्वारा कर सकते ह ै? 

(A)Dimensional  
(B)Declare  

(C)दोनों A और B 

(D)store=Array 

27. वन डायमेंशनल(One dimensional array) के क्तलए 
सही syntax क्ट्या ह ै? 

(A)dimensional array name(subscript) 

(B)Declare array name(subscript) 

(C)दोनों A_और_B 

(D)(subscript) dimensional array name 

28.टू डायमेंशनल (Two dimensional array) या 
डबल डायमेंशनल ऐरे के क्तलए syntax ह ै? 

(A)dimensional variable name(Rows,columns) 

(B)dimensional variable name(columns,Rows) 

(C)दोनों A_और_B 

(D)Declare array variable name 

29.ककसी array में data enter करन ेके क्तलए कौनसी 
कमांड ह ै? 

(A)Declare 

(B)dimensional 

(C)दोनों A_और_B 

(D)store 

Example :- Store spider to name(1,2) 

30.dimensional Speed (5,2) में कौन स ेकथन एक ऐरे 
के क्तलए सही ह ै? 

(A)Speed array का नाम ह|ै 

(B)5 पंक्ति (rows) को show करेगा 

(C)2 स्तंभ/कॉलम को शो करेगा 

(D)उपरोि सभी 

31.declare salary (10) में 10 क्ट्या दशाणता ह ै? 

(A)ऐरे का साइज़ 

(B)ऐरे का प्रकार 

(C)array_Variable 

(D)लॉक्तिकल वलै्य ू

32.Array स ेसम्पबंक्तधत कौनसे कथन सही ह?ै 

(A)ऐरे एक प्रकार का data type होता ह ैक्तिसम ेdata को 
समूह के रूप में store करत ेह ै|  
(B)fox-pro में यूिर 3600 लम्पबाई तक की ऐरे को 
क्तनधाणररत कर सकते ह ै| 
(C)मेमोरी वेररएबल को ऐरे के द्वारा भी Create कर 
सकते ह|ै  

(D)ऐरे एक्तलमेंट का उपयोग फंक्ट्शन,गणना और कमांड्स 
के रूप में कर सकते ह_ै| 

(E)उपरोि सभी  
33.SCATTER Command स ेसम्पबंक्तधत कौन स ेतथ्य 
सही ह?ै 

(A)Scatter कमांड डाटाबेस स ेडाटा ट्रान्सफर करन ेमें 
सक्षम ह ै| 
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(B)यह कमांड एक ऐरे में एक ही ररकॉडण कॉपी करता ह ै| 
(C)यह GATHRE Command के क्तबल्कुल क्तवपरीत ह|ै 

(D)उपरोि सभी 

34.copy to Array कमांड का कायण ह ै? 

(A)एक ऐरे में multiple Records/बहुत सरे ररकाड्सण की 
कॉपी करन ेके क्तलए | 
(B)एक ऐरे में एक ररकॉडण कॉपी करन ेके क्तलए 

(C)कॉपी ककय ेगय ेररकॉडण को फॉमटे करन ेके क्तलए 

(D)उपरोि में स ेकोई नहीं 

35.GATHER कमांड का कायण ह ै? 

(A)डाटा को ऐरे स ेडटेाबेस में स्थान्तररत /ट्रान्सफर करन े
के क्तलए  

(B)डाटाबेस स ेऐरे में डाटा ट्रांसफ़र करन ेके क्तलए  

(C)data input के क्तलए  

(D)data output के क्तलए  

36.Append from Array कमांड का क्ट्या कायण ह ै?  

(A)ऐरे स ेमल्टीपल ररकाड्सण को data transfer करन ेके 
क्तलए ककया िाता ह ै| 
(B)data को bock करन ेके क्तलए 

(C)मल्टीपल ररकाड्सण को remove करन ेके क्तलए  

(D)ऐरे एक्तलमेंट को िके करन ेके क्तलए  

37. ? कमांड का उपयोग ककसक्तलए ककया िाता ह ै? 

(A)Variable की value  

(B)एक्ट्सप्रेशन का ररिल्ट  

(C)Contents(क्तनक्तित मान) को लपं्रट करता ह ै 

(D)उपरोि सभी  
38. आउटपुट स्टेटमेंट (Output statement) ह ै? 

(A)? 

(B)?? 

(C)??? 

(D)उपरोि_सभी  
39.क्तनम्नक्तलक्तखत में स ेकौन स ेकथन सत्य ह ै? 

(A)? कमांड सूिना(information)को अगली पंक्ति 
(Row) पर क्तडस््ले करती ह|ै 

(B)?? कमांड सूिना को उसी पंक्ति(Row) में आउटपुट 
कदखता ह|ै 

(C)दोनों A और B  

D)??? सूिना को तीन बार लपं्रट करता_ह ै 

40.कौनसी कमांड आउटपुट को printer पर भेिता ह ै? 

(A)?   
(B)??   
(C)??? 

(D)सभी  
41. ? “cyber world”  
?? “Computer Education “ 

का आउटपुट क्ट्या होगा ? 

(A) cyber world Computer Education 

(B) cyber world  
     Computer Education 

(C)Computer Education cyber world  

(D)उपरोि में स ेकोई नहीं  
42.equal sign ” = ” द्वारा कक्रएट ककय ेगय ेवेररएबल 
सही ह ै? 

(A)City=”bhopal”   
(B)city=space(20)   
(C)pass=.F. 

(D)उपरोि सभी  
 

Part – 32 

 
 

1.लवंडोि की क्तडस््ले को बडा करन ेके क्तलए कौन सा बटन यूि 
ककया िाता ह ै

A. स्क्रोल बॉक्ट्स 

B. डाउन साइि 

C. मैक्ट्सीमाइि 

D. क्तमक्तनमाइि 

Correct Answer :C मैक्ट्सीमाइि 

2.ररसाइकल क्तबन आ्शन कहाँ पाया िाता हैं 
A. डसे्कटॉप पर 

B. हाडण ड्राइव पर 

C. शॉटणकट मेनु पर 

D. प्रोपटीि डायलॉग बॉक्ट्स 

Correct Answer :A डसे्कटॉप पर 
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3. लवंडोि 95, लवंडोि 98, और लवंडोि NT क्ट्या हैं? 

A. प्रोसेसर 

B. डोमने नाम 

C. मोडम 

D. ऑपरेटटंग क्तसस्टम 

Correct Answer : D ऑपरेटटंग क्तसस्टम 

 

4. कॉपी कमांड द्वारा सेव की हुई फाइल अस्थायी रूप से कहाँ सेव 
होती हैं 
A. क्तक्ट्लप बोडण 
B. लपं्रटर 

C. पेस्ट 

D. ऑब्िेक्ट्ट 

Correct Answer :A क्तक्ट्लप बोडण 

5. हाडण क्तडस्क से क्तडलीट की गई फाइलें कहां सेव हो िाती हैं ? 

A. रीसाइककल क्तबन 

B. फ्लॉपी क्तडस्क 

C. मदर बोडण 
D. क्तक्ट्लप बोडण 
Correct Answer : A.रीसाइककल क्तबन 

6. क्तवन्डोि डके्ट्सटॉप पर ————- द्वारा क्तवक्तभन्न एक्त्लकेशन 
और डाक्ट्यूमेंट दशाणये िाते हैं ? 

A. फाइल 

B. लेबल 

C. ग्राफ 

D. आइकॉन 

Correct Answer :D. आइकॉन 

7. स्क्रीन के बैकग्राउण्ड को ककस नाम से िाना िाता हैं? 

A. एक्त्लकेशन 

B. लवंडों 
C. डसे्कटॉप 

D. फे्रम 

E. Correct Answer :C. डसे्कटॉप 

8. एम.एस.लवंडोि ककस प्रकार का सॉफ्टवेयर हैं ? 

A. CUI 

B. MUI 

C. LUI 

D. GUI 

Correct Answer :D. GUI 

9. 1 MB में ककतने KB होत ेहैं 
A. 1000 kb 

B. 1020kb 

C. 1024 kb 

D. 1124 kb 

Correct Answer :C. 1024 kb 

10. Storage device के Main Folder को क्ट्या कहा िाता ह ै

A. Root Directory 

B. Interface 

C. Device Driver 

D. My Computer 

Correct Answer :A. Root Directory 

11. Run Dialog Box ओपन करन ेकी शॉटणकट की क्ट्या ह ै

A. Alt + R 

B. Ctrl + R 

C. Window Key + R 

D. Tab + R 

Correct Answer :C. Window Key + R 

12. स्क्रीन पर क्तडस््ले ककये गए क्तपक्ट्सेल की संयया को स्क्रीन ——
—— कहते ह ै

(a) Color Depth 

(b) Viewing Size 

(c) Resolution 

(d) Disk Rate 

Correct Answer :C. Resolution 

13. लवंडोि के ककस विणन में START बटन नहीं होता ह ै

A. WINDOWS 7 

B. WINDOWS 8 

C. WINDOWS VISTA 

D. इनमे से कोई नहीं 
Correct Answer :B. WINDOWS 8 

14. ककसी File या Folder की size को पता करने के क्तलए ककस 
आ्शन का प्रयोग ककया िाता ह ै

A. Rename 
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B. Edit 

C. Properties 

D. Customize 

Correct Answer :C. Properties 

15.ककसी फाइल को रीसायकल क्तबन में भेि ेक्तबना क्तडलीट करने की 
शॉटणकट की क्ट्या ह ै

A. Shift + Delete 

B. Ctrl + Delete 

C. Alt + Delete 

D. Alt + Ctrl + Delete 

Correct Answer :A. Shift + Delete 

16. ककसी window के Title bar के Maximize option पर 
click करने पर Window ————–हो िाएगी 

A. Close 

B. Minimize 

C. Restore 

D. Full Screen 

Correct Answer :C. Restore 

17. Windows ऑपरेटटंग क्तसस्टम ककस कंपनी ने बनाया ह ै

A. IBM 

B. Microsoft 

C. SUN 

D. Google 

Correct Answer :B. Microsoft 

18. स्टाटण बटन ककस bar में होता ह ै

A. Title bar 

B. Taskbar 

C. Task pane 

D. Toolbar 

Correct Answer :B. Taskbar 

19. By default कोई फाइल क्तनम्न में से ककस लोकेशन में िाकर 
सेव होती ह ै

A. My Computer 

B. My picture 

C. My document 

D. Desktop 

Correct Answer :C. My document 

20. ककसी फाइल को रीनेम करने की शॉटणकट की क्ट्या ह ै

A. F1 

B. F3 

C. F2 

D. F5 

Correct Answer : B. F2 

1.M.S.Excel में करेंसी ऑ्शन ककस Bar में होता ह ै

a) Formatting Toolbar 

b) Standard Toolbar 

c) Status Bar 

d) Formula bar 

Correct answer : a) Formatting Toolbar 

2.M.S. EXCEL में Macro ऑ्शन ककस मेनू में होता ह ै

a) Insert 

b) Format 

c) Tools 

d) Data 

Correct answer : c) Tools 

3.M.S. Excel में क्तसफण  date डालने के क्तलए ककस फंक्ट्शन का यूि 
ककया िाता ह?ै 

a) Today 

b) Now 

c) Time 

d) Calendar 

Correct answer : a) Today 

4. MS Excel मेंsa Remainder को calculate करन ेके क्तलए 
ककस Function का उपयोग ककया िाता ह ै? 

a) INT ( ) 

b) FACT ( ) 

c) MOD ( ) 

d) DIV ( ) 

Correct answer : c) MOD ( ) 

5. MS Excel में Fill option ककस Menu में होता ह ै? 

a) View 
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b) Format 

c) Tools 

d) Edit 

Correct answer : d) Edit 

6.एक एक्ट्सेल वकण बुक …………. का संग्रह ह?ै 

a) Workbooks 

b) Worksheets 

c) Charts and Slides 

d) Data 

Correct answer : b) Worksheets 

7.M.S.Excel में इनमें से कौन सा data type नहीं होता ह ै

a) Number 

b) Currency 

c) Label 

d) Date/Time 

Correct answer : c) Label 

8.Excel में Sort Option ककस मेनू में होता हैं 
a) Edit 

b) Format 

c) Tool 

d) Data 

Correct answer : d) Data 

9. इनमें से कौन सा िाटण M.S. Excel में नहीं होता ह ै

a) Scatter 

b) Line 

c) Doughnut 

d) Graph 

Correct answer : d) Graph 

10. MS Excel “CHART WIZARD” में Chart Options में 
इनमे से कौन सा Option नहीं होता ह ै? 

a) Axes 

b) Data Label 

c) Data Series 

d) Data Table 

Correct answer : c) Data Series 

11. MS EXCEL————- पर Based Software ह ै? 

a) WINDOWS 

b) DOS 

c) UNIX 

d) LINUX 

Correct answer : a) WINDOWS 

12. एक स्पे्रडशीट पृष्ठों का संग्रह ह ैक्तिसे ————–कहते हैं। 
a) Workbook 

b) Art book 

c) Worksheet 

d) Documents 

Correct answer : a) Workbook 

13. Ms Excel 2007 मेंsa Excel Workbook का 
Extension क्ट्या ह ै? 

a) .xlx 

b) .xlsx 

c) .xlcx 

d) .xlxx 

Correct answer : b) .xlsx 

14. Chart Wizard के ककस ऑ्शन में Data में Series 

Name, Category और Value का Option होता ह ै? 

a) Legend 

b) Chart area 

c) Data label 

d) Data Titles 

Correct answer : c) Data label 

15. MS Excel में Formula Error होने पर कौन सा Sign 

कदखाई दतेा ह ै

a) $ 

b) * 

c) \ 

d) # 

Correct answer : d) # 
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16.M.S. Excel में कौन सा ऑ्शन Data Menu में नहीं होता 
ह ै? 

a) Validation 

b) Filter 

c) Freeze Pane 

d) Sort 

Correct answer : c) Freeze Pane 

17.Function लगाते समय range दनेे के क्तलए ककस 
Reference operator का यूि ककया िाता ह ै? 

a) ; 

b) & 

c): 

d) = 

Correct answer : c): 

18.M.S. Excel में नंबर को ड्रगै करके सेल्स में इन्सटण करने के 
फीिर को क्ट्या कहते हैं 
a) Auto Correct 

b) Auto Text 

c) AutoFill 

d) Auto Cell 

Correct answer : c) AutoFill 

19.M.S.Excel में Tool Menu में इनमें से कौन सा ऑ्शन 
होता ह ै

a) Formula Auditing 

b) Goal Seek 

c) Scenarios 

d) उपरोि सभी 

Correct answer : d) उपरोि सभी 

20.ककस फंक्ट्शन का उपयोग Rate of Return ,Loan 

,Amount और Future Value को Calculate करने के क्तलए 
ककया िाता ह ै

a) Statistical function 

b) Financial function 

c) Logical function 

d) Mathematical function 

Correct answer : b) Financial function 

1. “apply design templates” से क्ट्या होता ह ै| 

a) slide का content change करता ह ै| 

b) slide की functionality को िोड़ता ह ै| 

c) slide के content में क्तबना कोई पररवतणन ककये slide का 
look change करता ह|ै 

d) इनमें से कोई नहीं | 

Correct Answer : c) slide के content में क्तबना कोई 
पररवतणन ककये slide का look change करता ह ै| 

2. पहले से बनी style क्तिसे पॉवर पॉइंट में presentation के 
क्तलए use ककया िा सकता ह,ै कहलाती हैं | 

a) Auto style 

b) Wizard 

c) Templates 

d) Pre Formatting 

Correct Answer : c) Templates 

3. ककसी presentation में, Animation scheme को ककस 
slide में लागू ककया िा सकता ह ै| 

a) All slides 

b) Selected slide 

c) Current slide 

d) ये सभी 

Correct Answer : d) ये सभी 

4. इनमें से कौनसी key आप spelling check करने के क्तलए 
press करेंगे | 

a) F3 

b) F5 

c) F7 

d) F9 

Correct Answer : c) F7 

5. पॉवर पॉइंट में layout ककतने प्रकार के होत ेहैं | 

a) 4 

b) 5 

c) 6 

d) इनमे से कोई नहीं 
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Correct Answer : a) 4 

6. Slide में ककसी picture को Recolor करन ेकी command 

ह ै| 

a) Insert – Picture – Recolor 

b) Tools – Picture – Recolor 

c) Format – Picture – Recolor 

d) Edit – Picture – Recolor 

Correct Answer : a) Insert – Picture – Recolor 

7. ककसी Slide में क्तनम्न में स ेकौन-कौन से option हो सकते हैं | 

a) Title, Text, graphs 

b) Drawn Object Shapes 

c) Clipart, Drawn art,Visual 

d) इनमें से कोई भी | 

Correct Answer : d) इनमें से कोई भी | 

8. Animation क्ट्या ह ै| 

a) क्तित्र बनाना 
b) क्तस्थर क्तित्रों को गक्तत दनेा 
c) लपं्रट क्तनकालना 
d) ग्राफ में क्तित्रों को बदलना 

Correct Answer : b) क्तस्थर क्तित्रों को गक्तत दनेा 

9. Slide Show करने की शॉटणकट की (Key) क्ट्या ह ै

a) F4 

b) F5 

c) F6 

d) F7 

Correct Answer : b) F5 

10. पॉवर पॉइंट में क्तडफ़ॉल्ट पेि सेटअप में कौनसा ओररएटेंशन सेट 
होता ह ै| 

a) Landscape 

b) Portrait 

c) Vertical 

d) इनमे से कोई नहीं 

Correct Answer : a) Landscape 

11. स्लाइड के Exit और Enter के क्तलए मोशन इफ़ेक्ट्ट अ्लाई 
करने के क्तलए आप कौनसे फीिर का इस्तेमाल करेंगे | 

a) Animation Scheme 

b) Slide Design 

c) Animation Objects 

d) Slide Transition 

Correct Answer : d) Slide Transition 

12. पॉवर पॉइंट शो में कौनसा फाइल फॉमेट िोड़ सकते हैं 
a) WAV 

b) JPG 

c) MPEG 

d) ये सभी 

Correct Answer : d) ये सभी 

13. िब आप पे्रिेंटेशन को ओपन करत ेह ैतब लेफ्टपैनल पर 
कौनसा टैब नहीं होता ह ै

a) Notes 

b) Outline 

c) Slides 

d) सभी उपलब्ध होते हैं 

Correct Answer : a) Notes 

14. स्लाइड लेआउट में कौनसा सेक्ट्शन मौिूद नहीं ह ै

a) Animations 

b) Lists 

c) Titles 

d) Charts 

Correct Answer : a) Animations 

15. स्लाइड के अलग अलग ऑब्िेक्ट्ट के क्तलए मोशन इफ़ेक्ट्ट 
अ्लाई करने के क्तलए आप पॉवर पॉइंट के कौनस ेफीिर का 
इस्तेमाल करेंगे 

a) Animation Scheme 

b) Animation Objects 

c) Slide Design 

d) Slide Transition 

Correct Answer : a) Animation Scheme 
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16. पॉवर पॉइंट में क्तनम्न में से कौनसा एक्ट्शन बटन होता ह ै

a) Home 

b) Help 

c) End 

d) ये सभी 

Correct Answer : d) ये सभी 

17. पॉवर पॉइंट में पे्रिेंटेशन की ररहसणल करन ेके क्तलए ककस 
आ्शन का प्रयोग ककया िाता ह ै

a) Setup time 

b) Timing 

c) Rehearse Timing 

d) ये सभी 

Correct Answer : c) Rehearse Timing 

18. ________ से हम पहले से बने हुए Presentation को ओपन 
कर सकते हैं | 

a) CTRL + A 

b) CTRL + O 

c) CTRL + N 

d) CTRL + L 

Correct Answer : b) CTRL + O 

19. PowerPoint में हर Slide में एक िैसी Formatting करने 
के क्तलए इनमें से ककस आ्शन का उपयोग ककया िाता ह|ै 

a) Slide Transition 

b) Slide Design 

c) Slide Master 

d) उपरोि सभी 

Correct Answer : c) Slide Master 

20. पॉवर पॉइंट में Slide Show को कैसे रोका िा सकता ह ै

a) Press the right arrow 

b) Press Escape 

c) Press Ctrl + A 

d) Press Ctrl + S 

Correct Answer : b) Press Escape 

21. पॉवर पॉइंट में Presentation को बनाने के पेि को _____ 

कहा िाता ह ै| 

a) Sheet 

b) Paper 

c) Slide 

d) Document 

Correct Answer : c) Slide 

22. PowerPoint में presentation में िाटण को ककस तरीके स े
insert ककया िाता ह ै

a) Edit -> Chart 

b) Insert -> Pictures -> Chart 

c) Insert -> Chart 

d) View -> Chart 

Correct Answer : c) Insert -> Chart 

23. PowerPoint में सभी slides में Font को Replace करन े
के क्तलए ककस आ्शन का यज़ू ककया िाता ह ै

a) Tools -> Fonts 

b) Edit -> Fonts 

c) Format -> Replace Fonts 

d) Tools -> Replace Fonts 

Correct Answer : c) Format -> Replace Fonts 

24. इनमें से ककस View से हम सभी Slides को एक साथ दखे 
सकते हैं 
a) Through slide sorter view 

b) Through slide view 

c) Through normal view 

d) through slide show 

Correct Answer : a) Through slide sorter view 

25. MS PowerPoint में Slide Design का आ्शन ककस 
टूलबार में होता ह ै

a) Standard Toolbar 

b) Formatting Toolbar 

c) Drawing Toolbar 

d) इनमें से कोई नहीं 

Correct Answer : b) Formatting Toolbar 
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